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Advanced Standing for College Credit
Computer Fundamentals Course

Academic and Career Entrance (ACE) Program

The computer skills modules of Employment Track Express are based on curriculum from the Computer 
Fundamentals course of the Academic and Career Entrance (ACE) program. ACE is an adult upgrading program 
delivered by Ontario community colleges as a Grade 12 equivalency program for the purposes of entrance to 
apprenticeship, college postsecondary programs and employment. The ACE certificate is issued upon successful 
completion of a communications and mathematics course (mandatory) and two other course completions chosen 
from eight electives. Computer Fundamentals is one of the eight electives.

Students completing the Employment Track Express course may be considered for advanced standing in the 
ACE Computer Fundamentals course. Students who are given advanced standing won’t have to redo completed 
modules; they will only have to finish the rest of the course material to be awarded the course. Employment 
Track Express students wishing to apply for advanced standing at their local college must write the module 
tests without access to the manual. A grade of 80% must be obtained on each test. Students may, however, have 
completed one version of the tests using their manual, and decide to rewrite tests without the manual in order to 
apply for advanced standing. (The second version of tests may also be written by students who did not pass the 
first attempt at the test.)  

The ACE Online Computers and Employment Track Express Tracking and Referral Sheet should be completed, 
signed and dated by the ETE instructor and provided to the student who is seeking advanced standing. The 
student will use this form to apply for advanced standing at their local community college. This indicates to the 
receiving college that the student has successfully completed four of seven modules required to receive one of 
four credits towards the ACE certificate. 

Contact information for the Ontario college academic upgrading program can be found on the College Sector 
Committee for Adult Upgrading website at www.collegeupgradingon.ca.
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Course Overview

Computers are commonly used today at work, in learning and in life. They are also widely used on the job, 
at school and at home. In each of these contexts – work, learning and life – there are also other skills you use 
every day. These skills are known as Essential Skills – and Computer Use is one of them. In this course, you 
will learn computer skills. While learning computer skills, you will also learn about Essential Skills. More 
specifically, you will learn to recognize when and how you apply Essential Skills to everyday tasks. You will 
practice completing a variety of tasks and figure out if you need to develop further Essential Skills to move 
to the next step in your goal path. Essential Skills, including Computer Use, are skills you can use to research 
information on the job market (also known as Labour Market Information or LMI). This course will give you 
opportunities to focus on LMI as you practice newly learned computer skills. You will use Labour Market 
Information to research jobs that fit with your needs, goals, interests and skills. You can also use LMI to figure 
out if you are ready to begin a job search or if you will need further education or training. 

By the end of this course, you will

•    gain valuable computer skills; 

 •    recognize your transferable skills;

•    learn about the local labour market;

•    identify occupational areas that interest you;

•    compare your Essential Skills to your job of choice;

•    plan your next steps to employment. 

The course involves 60 hours of in-class instruction plus some homework assignments. 

Module Overview

Essential Skills support us in completing tasks in every area of our lives. Understanding just what Essential 
Skills are and how we use them helps us to perform tasks better. Essential Skills are the foundation on which 
we build new learning. Technological changes, skills shortages and global competition require us to have strong 
Essential Skills. 

This module will address the following topics: 

1.    What are Essential Skills?

2.    How do we use Essential Skills every day? 
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Learning Objectives

Participants will

 •    understand Essential Skills and the definitions of the nine Essential Skills;

•    identify Essential Skills applications in different tasks;

 •    develop confidence in their abilities. 

Essential Skills are used in every aspect of our lives. Essential Skills

•    are needed for work, learning, and life;

•    underpin, or support, everyday life tasks;

•    are the foundation for learning new skills, participating in lifelong learning and adapting to change;

•    are used in all jobs.

You are facing change in your life and you are learning new skills – a part of lifelong learning. Essential Skills 
will support you in your learning. Knowing what Essential Skills are and how they are applied every day will 
help you identify skill areas that you may want to focus on.

What are the Essential Skills? 
The International Adult Literacy Survey was administered across Canada in 1993, and eventually in 23 
countries around the world. The results of this survey allowed literacy skills to be compared across countries. 
This survey led to the Essential Skills Research Project which identified and defined the nine Essential Skills. 
Employers and workers have been interviewed to describe how these skills are used at work, and Essential 
Skills Profiles are now available for many Canadian jobs. Employers are starting to think about the ways in 
which Essential Skills are important to their employees and businesses, and how to make sure the people they 
hire have the necessary Essential Skills for the job. 

There are nine Essential Skills:

•    Reading Text
•    Document Use
•    Writing
•    Numeracy
•    Oral Communication

•    Thinking Skills
-    Problem Solving
-    Decision Making
-    Critical Thinking
-    Job Task Planning and Organizing
-    Significant Use of Memory
-    Finding Information 
•    Working With Others
•    Computer Use
•    Continuous Learning

The Essential Skill 
Thinking Skills is complex. 
It is made up of six 
separate – but connected 
– skills. Employers value 
this Essential Skill highly 
because it speaks to an 
employee’s ability to 
make decisions and solve 
problems.
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Essential Skills Defined

Knowing the names of the Essential Skills is helpful, but knowing how they are defined will help you recognize 
where and how you use them every day. 

Reading Text: Refers to reading material that is in the form of sentences or paragraphs such as textbooks, 
regulations, newspapers, letters, memos, and reports. 

Document Use: Refers to tasks that involve a variety of information displays, including graphs, lists, forms, 
tables, blueprints, and schematics.

Writing: Pertains to tasks involving the completion of documents such as filling in forms and writing text (with 
pen or pencil and on the computer).

Numeracy: Refers to the use of numbers and includes skills involving money, scheduling or budgeting, 
accounting, measurement and calculation, and estimation.

Oral Communication: Involves the use of speech to give and exchange thoughts and information.

Thinking Skills: Refers to the ability to problem solve, make decisions, think critically, plan and organize job 
tasks, use memory and find information. 

Working With Others: Pertains to the skills needed to work successfully with others to carry out tasks. 

Computer Use: Refers to the use of computers and related equipment to perform tasks. 

Continuous Learning: Pertains to participation in an ongoing process of acquiring skills and knowledge. 

Essential Skills are dormant or “asleep” until we apply them to a task. For instance, we know how to read, 
think, listen, add and subtract. Until we use these skills to “do” something, they are dormant. 
When we balance our bank book and realize we have overspent, we put Essential Skills into action. We subtract 
the total expenses from the total income and we figure out how much we overspent. We might review payments 
to make sure an error wasn’t made on the amount, or we might review withdrawals to make sure amounts have 
not been entered twice. Then we think about and take other steps, such as looking at different costs to see if we 
can reduce expenses. We might also tell our spouse or children that certain activities or luxuries need to be cut 
back this month and explain why. 

You can see from the example above how Essential Skills are applied. You can also see how many different 
Essential Skills get used to do tasks that we probably consider to be everyday tasks. Now that you are familiar 
with the Essential Skills and definitions, look at the diagram on the next page for some examples of how we use 
three of the Essential Skills – Reading Text, Document Use and Numeracy – to complete tasks every day.
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Learning

Life Work

Essential
Skills

ES Everywhere

Reading Text
Life

Reading a hydro rate increase 
letter to understand the financial 
implications

Learning

Reading assignment instructions 
to scan for the due date

Work

Reading a plant holiday closure 
memo to determine the date and 
day of the week

Document Use
Life

Comparing nutrition labels to 
purchase the item with the least 
sugar

Learning

Reviewing class timetables for 
conflicts

Work

Completing a time sheet to 
collect your pay

Numeracy
Life

Calculating a bank balance after 
paying a bill

Learning

Scheduling time for homework to 
meet deadlines

Work

Completing a travel claim for 
reimbursment

All of these tasks in the chart may be completed using a computer. By the end of this course you will have 
learned computer skills that you can transfer to life, to learning and to work. You will also know how to apply 
other transferable skills – Essential Skills. Participating in this course will help you strengthen some of your 
Essential Skills and help you identify skills that you may want to work on. These are skills that research has 
shown employers value because they affect our ability to participate in society, help us work safely, increase our 
income potential and support us in being productive.

Learning

Life Work

ssentEssential
Skillskil
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Applying Essential Skills
(Note: Skills are presented in the order you will come across them in this course.)

Oral Communication 

Definition: 
Oral Communication involves the use of speech to give and exchange thoughts and information.

Examples:
Workplace
Labourers talk with co-workers at shift change to get directions for tasks they need to perform on the next 
shift.

Learning
Students listen to instructions so they can complete tasks introduced by instructors. 

Life
Individuals listen to weather reports so that they dress appropriately.

Can you think of examples of how you’ve used Oral Communication in past jobs you’ve had? List the 
examples below:
_________________________________________________________________________________________
_________________________________________________________________________________________
___________________________________________________________________________________________________
___________________________________________________________________________________________________

Tips and Strategies:
Listening carefully to your instructor will help you understand information and follow instructions. Being able 
to tell the difference between hearing information or hearing instructions is important. Listen to the words to 
determine if what you are hearing is information or if it is an instruction. An example of information is “The 
owners are touring the plant tomorrow.” An instruction would be “Clean your workstations before leaving shift 
today in preparation for the owners’ tour tomorrow.”

Information
1.   Listen carefully to what is being said.
2.   Jot down words or phrases that are important.
3.   Make short notes of things you’re not sure about and for which you need further explanation or   
      clarification.
4.   Ask questions to help the speaker to make the information clear.
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Instruction

1.    Listen for words that identify the order in which to do things – for example, first, second, next, before, at   
       the end, lastly, finally, or then. 

2.    Listen for words that tell you an instruction is conditional - for example, only for some people or under   
       some conditions.

3.    Listen for words that let you know what NOT to do – for example, in the case of, don’t or do not, or only if.

4.    Listen for how many instructions are given, make notes, and number instructions.

5.    If you don’t understand something, ask the speaker to repeat or clarify the instruction. 

6.    A good way to check that you have understood correctly is to state the instructions in your own words. 
       If you are not able to clarify with the speaker, write the instructions in your own words to help you think 
       through the information you received.

7.    Your questions should be specific in order to help the speaker clarify the instruction. 

What other tips and strategies can you think of to strengthen your Oral Communication skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
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Reading Text 

Reading Text refers to reading material that is in the form of sentences or paragraphs such as textbooks, 
regulations, newspapers, letters, memos, and reports.

Examples:
Workplace
Cleaners read the Material Safety Data Sheets (MSDS) for products they are using for the first time to identify 
protective equipment requirements, potential hazardous reactions and emergency procedures.

Learning
Workers read manuals on the job to learn and understand new processes.

Life
Parents read pamphlets that come with prescriptions to understand symptoms and side effects their child may 
experience.

Can you think of examples of how you’ve used Reading Text in past jobs you’ve had? List them below:

__________________________________________________________________________________________________
__________________________________________________________________________________________________
________________________________________________________________________________________________________
_______________________________________________________________________________________________________
__________________________________________________________________________________________________
__________________________________________________________________________________________________

Tips and Strategies:

We are presented with an increasing amount of information in text format – at home and in the workplace, on 
paper and on computer screens. We read for many purposes: to locate information, to understand meaning, to 
learn, and to evaluate the information presented. In our personal and work lives, reading increases our ability to 
find, absorb and use important information and to be efficient, effective and safe in our environments. 

1.   Read strategically – choose the reading method that fits the purpose of your reading, i.e., scanning,    
      skimming, or reading for detail.

2.   When reading to search for or locate information, the first step is to identify the key word(s). Key word(s)   
      are identified from the instruction, task or question. The key word(s) may not be a direct match with the 
      word(s) in the task. Look for words with similar meaning. 
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3.   When reading to learn or understand, you need to

•    remember that opening sentences introduce the subject;
 •    read difficult paragraphs one sentence at a time and reread sentences that are not clear;
 •    pause when reading to think about what you have just finished reading;

•    make notes in your own words or highlight important points;
•    break long sentences into shorter ones and write them down; 

 •    find the meaning of unfamiliar words by working out what they mean from the rest of the sentence,   
     by asking someone or by looking them up in a glossary (if it is included in the document);
•    reread information step-by-step if you are reading instructions that involve hands-on activities;
•    use a glossary, if a document contains one, for technical words rather than a dictionary. If you look a   

      word up in a dictionary, you might find several meanings.

4.   When reading to follow instructions, remember:

•    Written instructions are often numbered or bulleted. Bullets may also be used for lists of points or   
      facts.
•    Numbering may identify the order in which the instructions are to be followed.
•    Instructions may be mixed up with other text such as informative text or information. 
•    Information text provides facts. Instruction text provides direct orders or commands. 
•    Information needs to be read before instructions can be carried out.
•    Instructions use a “command verb” such as find, write, go to, click, or calculate.
•    Instructions often include information about when NOT to do something. 

What other tips and strategies can you think of to strengthen your Reading Text skills? List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
__________________________________________________________________________________________
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Document Use

Definition: 
Document Use refers to tasks that involve a variety of information displays, including graphs, lists, forms, 
tables, blueprints, and schematics.

Examples:

Workplace
Automotive Service Technicians find out about electrical, hydraulic, coolant and other systems by studying 
schematic diagrams.

Learning
Students fill out Ontario Student Assistance Program (OSAP) forms to apply for student loans. 

Life
Homeowners read hydro bills to determine how much they need to pay.

Can you think of examples of how you’ve used Document Use in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
______________________________________________________________________________________________________
______________________________________________________________________________________________________
__________________________________________________________________________________________
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Examples of 
Typographic Elements

•   Bullets

-   Dashes

CAPITAL LETTERS

bold words 

underlined words

What other tips and strategies can you think of to strengthen your Document Use skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
________________________________________________________________________________________________
_______________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

Tips and Strategies:
As more and more information is gathered and used in carrying out work, the number and types of documents 
we are required to use – in work and in life – increases. Being able to successfully use the documents we are 
faced with makes us more successful in carrying out the tasks we need to do.

1.    Recognize the type of document to determine the strategy you will apply to use it.

2.    Preview the document to determine what information it contains, how the information is labelled and    
       organized (format such as headings and sub-headings) and whether any information is presented 
       typographically (icons, colour, different font type or size).

3.    When using documents to search for or locate information, the second step is identifying the key word(s).        
       Key word(s) are identified from the instruction, task or question. The key word(s) may not be a direct 
       match with the word(s) in the task. Look for words with similar meaning. Car, automobile, and motor   
       vehicle are examples of key words.

4.    Scan the document to locate the key words.
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Writing

Definition:
Writing pertains to tasks involving the completion of documents such as filling in forms and writing text. 

Examples:

Workplace 
Stationary Engineers write explanations and descriptions of equipment malfunctions in order to ask for 
equipment repairs.

Learning 
Employees write memos to ask employers to pay for training courses.

Life
Home computer users write emails to Internet Service Providers to ask to upgrade their Internet connections.

Can you think of examples of how you’ve used Writing in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_____________________________________________________________________________________________________
____________________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
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Tips and Strategies:

Writing clearly and concisely saves time and prevents misunderstandings. In today’s society we need to be 
able to write using paper or electronic media (email or word processing documents). The speed of electronic 
information sharing means mistakes can be shared widely before they are corrected. Being able to write clearly 
and accurately is important.

1.   Thinking comes before writing. Think about what you need to write and why before you start writing.

2.   Gather information you need before you start to write.

3.   Keep your message simple.

4.   Choose language that fits the purpose. For instance, in work-related writing, avoid the use of slang. 

What other tips and strategies can you think of to strengthen your Writing skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
______________________________________________________________________________________________________
______________________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

Jargon
Many industries, workplaces, families or other like-minded communities have their own “language.” 
This is known as jargon. Certainly, the field of information technology – which is computer-based – has a 
language all its own. Jargon can have an impact on your ability to apply all Essential Skills, but especially 
Reading Text, Document Use, Writing and Oral Communication. These are the skills which are used to share 
jargon – or context-specific vocabulary. They are also the skills used to understand and clarify jargon. Jargon 
includes abbreviations and acronyms, and words for which different meanings or definitions have been 
developed.

Find out what jargon means:

1. Ask instructors, fellow participants, friends, family or co-workers.

2. Look jargon up in the dictionary.

3. If you are using text materials and there is a glossary, look jargon up in the glossary.



Employment Track Express

23Module One Introduction to Essential Skills

Computer Use

Definition:
Computer Use refers to the use of computers and related equipment to perform tasks. 

Examples:

Work
Retail Associates look up customer names, addresses and product information on the computer.

Learning
Students complete and submit application forms via Internet websites.

Life
Friends correspond by email. 

Can you think of examples of how you’ve used Computer Use in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
________________________________________________________________________________________________
________________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

Tips and Strategies:

Tips and Strategies on Computer Use are provided throughout the manual. Since a good portion of this course is 
about using computers to find job-related information, you’ll have lots of opportunities to read about strategies 
and use computers to apply these strategies to your own search.

What other tips and strategies can you think of to strengthen your Computer Use skills?

__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________________
_________________________________________________________________________________________________



Employment Track Express

24 Module One Introduction to Essential Skills

Numeracy

Definition:
Numeracy refers to the use of numbers and includes skills involving money, scheduling or budgeting, 
accounting, measurement and calculation, and estimation.

Examples:
Work 

Firefighters calculate the water pressure lost between the pump and the end of the water hose to assess the 
amount of pressure they need to fight a fire.

Learning

A retiree interested in cabinet-making learns how to calculate the amount of hardwood lumber required to build 
a coffee table. 

Life

Homemakers estimate how many apples they need to peel to make a pie. 

Can you think of examples of how you’ve used Numeracy in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_____________________________________________________________________________________________________________________________
_____________________________________________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

Tips and Strategies: 
Numeracy or math skills is an area of learning that can make some people feel uncomfortable. Often, people 
feel that their math skills are weak. However, we use math far more frequently 
every day than most people realize. And we will need to use math skills even 
more frequently in the future. Experts say that 97% of all occupations requiring 
high school completion require at least some math. In Ontario, over 50% of 
adults need to upgrade their math skills in order to have the skills required 
to fully participate in a knowledge-based society. Numeracy is required to 
complete a range of tasks, from very basic to very complex (doubling a recipe 
to managing your family investments). 
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Numeracy is divided into four different types of applications (skills):

Money Math - financial transactions, such as handling cash or making payments. 

Scheduling or Budgeting and Accounting Math
 - managing time and money as resources.

Measurement and Calculation Math - measuring and describing the physical world. For example, this 
type of math includes calculating how much carpet to buy for a living room, how many quarts will fit in a 5 L 
container, or how much fertilizer to buy in order to fertilize your front and back lawns. 

Data Analysis Math - analysis of numerical data. For example, this type of 
math involves calculating the average rate of return on your RRSP, comparing 
monthly gas readings to determine if your usage has increased, or comparing 
your annual income to the national average.

Although not considered an application, Numerical Estimation is also included in Numeracy. It includes 
tasks involving any estimation that results in a number. Numerical estimation refers to a judgement or opinion, 
expressed numerically, regarding worth, size, amount, weight, etc. For example, numerical estimation includes 
estimating the weight of a package by feel, or estimating the amount of time to travel to a destination. 
Different jobs require different numeracy applications. For example, Firefighters use all four applications 
as well as Numerical Estimation. Automotive Service Technicians do not use Scheduling or Budgeting and 
Accounting Math. Cooks use Money Math, Data Analysis Math and Numerical Estimation. 
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What other tips and strategies can you think of to strengthen your Numeracy skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
___________________________________________________________________________________________________
___________________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

Thinking Skills
The Essential Skill of Thinking Skills has been divided into six separate but interconnected thinking skills. This 
Essential Skill is also becoming increasingly important as the role(s) of workers change (greater teamwork, 
increased manipulation of information etc.). 

Definition:
Problem Solving involves problems that require solutions. Most problems concern mechanical challenges, 
people or situations. 

Decision Making refers to making a choice among options. Decision making occurs during problem solving, 
but not all decision making is part of problem solving. 

Critical Thinking is the process of evaluating ideas or information, using a rational, logical thought process, 
and referring to objective criteria to reach a rational judgement about value, or to identify strength and 
weakness.

Job Task Planning and Organizing refers to the extent that individuals plan and organize their own tasks. It 
does not include, for example, participating in the planning function of an organization.

Significant Use of Memory includes any significant or unusual use of memory. It does not include normal 
memory use that is a requirement for every occupation.

Finding Information involves using any of a variety of sources including text, people, computerized databases 
or information systems. It therefore may also involve Reading Text, Document Use, Oral Communication and 
Computer Use.

Thinking Skills are the most complex Essential Skill as any number of the six components may be applied 
to particular tasks. An Ambulance Dispatcher will be used as an example to illustrate how the skills are 
interconnected:
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Example:
An Ambulance Dispatcher is responsible for responding to emergency calls and dispatching four ambulances. 
Currently, two are on the way to the hospital with patients. The third ambulance has been dispatched to attend to 
a patient with a possible allergic reaction, and the fourth is on its way to pick up an elderly man who has fallen 
and may have broken his hip. 

The Ambulance Dispatcher receives a call for help from an individual who 
is experiencing all the symptoms of a heart attack. The problem requiring a 
solution is that an individual in a life-threatening situation is in need of an 
ambulance and cannot be responded to because all ambulances have been 
assigned. The critical thinking involves evaluating the impact of recalling an 
ambulance from an assignment in order to assign an ambulance to the heart 
attack victim. Ambulances on the way to the hospital cannot be recalled as 
they already have a patient on board. The potential allergic reaction is also 
life-threatening. The patient that has fallen and may have a broken hip is not 
in a life-threatening situation. A decision has to be made from among three 
options: recall the ambulance on the way to the individual with the potential 
allergic reaction; recall the ambulance assigned to the elderly man who has 
fallen; or wait for one of the two ambulances on the way to the hospital to 
become available. 

The Ambulance Dispatcher uses other related skills in this example – Significant Use of Memory, Job Task 
Planning and Organizing, and Oral Communication. The most important skills in this example are Thinking 
Skills, although many Essential Skills are needed to perform the task. 

Tips and Strategies: 
The example will help you understand the complexity of Thinking Skills - the skills that employers identify 
they most want and need, but they can’t teach. As you work through the course, add your thoughts on Tips and 
Strategies here and share them with your instructor.

What other tips and strategies can you think of to strengthen your Thinking Skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
______________________________________________________________________________________________________
______________________________________________________________________________________________________
_________________________________________________________________________________________
_________________________________________________________________________________________
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Working With Others

Definition:
Working With Others pertains to the skills you need to work successfully with others to carry out tasks. 

Working With Others describes whether tasks require working co-operatively with others. It also describes 
whether self-discipline is required to complete tasks while working alone.

The description of Working With Others is provided in two parts: Description of Work Context (how you work) 
and Supervisory or Leadership Activities (what you do). 

Four Work Contexts have been identified:

•    Work alone.
•    Work independently.
•    Work jointly with a partner or helper.
•    Work as a member of a team.

There are 12 Supervisory or Leadership Activities associated with the workplace:

•    Participate in formal discussions about work processes or product improvement.
•    Have opportunities to make suggestions on improving work processes.
•    Monitor the work performance of others.
•    Inform other workers or demonstrate to them how tasks are to be done.
•    Orient new employees.
•    Make hiring recommendations.
•    Make hiring decisions.
•    Select contractors and suppliers.
•    Assign routine tasks to other workers.
•    Assign new or unusual tasks to other workers.
•    Identify training that is required by, or would be useful for, other workers.
•    Deal with other workers’ grievances or complaints.
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Examples:
Work

An Automotive Service Technician works independently to install a new fan belt. 

Learning

Neighbours participate in a municipal meeting to learn how to work together to keep their neighbourhood safe.

Life

People participate in team sports for exercise and fun. 

Can you think of examples of how you’ve used Working With Others in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_______________________________________________________________________________________________________________
_______________________________________________________________________________________________________________
_________________________________________________________________________________________

Tips and Strategies:

Many occupations require employees to work effectively with other employees, to ensure that work is 
accomplished effectively and efficiently. Increasingly, as the Essential Skill Working With Others shows, 
employers are paying attention to the ways in which employees work with one another to achieve employer 
goals.

What other tips and strategies can you think of to strengthen your Working With Others skills? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_________________________________________________________________________________________________
________________________________________________________________________________________________
_________________________________________________________________________________________
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Continuous Learning

Definition:

Continuous Learning examines the requirement to participate in an ongoing process of acquiring skills and 
knowledge.

Examples:

Continuous Learning describes learning and how learning occurs. Learning includes training in job-related 
health and safety; obtaining and updating credentials; and learning about new equipment, procedures, products 
and services. 

Learning connected to the workplace includes learning

•    from co-workers, as part of a regular work activity; 
•    through training offered in the workplace;
•    through reading or other forms of self-study at work or on the worker’s own time;
•    using materials obtained through a professional association or union;
•    using materials obtained on the worker’s own initiative;
•    through off-site training;

 •    during working hours at no cost to the worker, partially subsidized or with costs paid by the worker.

Can you think of examples of how you’ve used Continuous Learning in past jobs you’ve had? 
List them below:

__________________________________________________________________________________________
__________________________________________________________________________________________
_____________________________________________________________________________________________
____________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
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Tips and Strategies:

Learning can be undertaken formally or informally for many reasons – in the context of work or personal 
interests. Look for opportunities to expand your interests, skills, abilities and knowledge through books, from 
friends, from colleagues, from family and through classes. 

The skill and knowledge requirements of work specifically, and life generally, are on the rise. Technological 
change, a global environment, ongoing research and instant communication mean that employees need more 
and stronger skills. Recognizing and taking advantage of learning opportunities supports your growth and 
abilities. The computer skills and knowledge of the ‘80s is no longer sufficient to support workers or home 
users of computer technology. Thinking critically about new products, new medications, and new applications 
of information can position us to make good, safe and effective choices. Acquiring and applying skills has never 
been so important.

What other tips and strategies can you think of to strengthen your Continuous Learning skills? 
List them below:

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

______________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
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Module Overview 

Technology is evolving constantly. As you read this courseware, you may come to believe that you now know 
the latest technology on the market. Somewhere though, someone is working on technology that is smaller, 
lighter, better, faster, and more efficient. The good news is that many aspects of technology never completely 
change; developers just produce newer versions with added features and abilities. Once you have mastered the 
basics of computer technology, the knowledge will remain with you forever. Keep this fact in mind as you get to 
know the computer you are using to complete this course.

This module will address the following topics: 

1.    What is a computer and how does it work?
2.    The basics about hardware and software
3.    General maintenance of your computer

Oral Communication

You will be listening to new 
information and receiving 
instructions in this module.

•    listen for language that   
     tells you whether you are 
     receiving information or 
     instruction 
•    make notes of questions 
     or items you need more 
     information about
•    ask questions

Reading Text

Information in the manual 
supports the information 
you receive in lectures. 

•   highlight important words 
    or phrases
•   break sentences into 
    shorter ones to help you 
    understand
•   use the glossary to find   
    out what new words 
    mean 

Learning Objectives

During this module, you will

•    read and learn new information and terminology about computer 
     systems; 
•    understand the four basic functions of a computer;
•    be introduced to basic hardware components inside and outside   
     the system unit;
•    be introduced to the different types of software and their use;
•    understand the importance of keeping your computer system in   
     good working order;
•    learn research skills.
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Section Content Due Day Mark value
Section One Lecture What is a Computer 

and How Does It Work?

Section One Self-
evaluation Review

Self-evaluation Review 
of Section One

Section Two Lecture Knowing the Basics 
About Hardware and 
Software

Section Two 
Self-evaluation
Review

Self-evaluation Review 
of Section Two 

Assignment Hardware & Software 
Module Assignment

Section Three Lecture General Maintenance 
of Your Computer

Module Test Module Two Test

Resources Data Measurement 
Table

Document Use

Your instructor may provide dates to complete the chart. 

•    recognize this is a combined list from the instructions; identify “Due Day” as the key word(s)
•    locate headings
•    decide to enter information you’re given by your instructor in “Due Day” column

Overview of Contents 

The following table outlines activities that are part of Module Two. Your instructor may provide due dates for 
you to complete the chart.
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Section One: 
What is a Computer and How Does It Work? 

What is a Computer? 

A computer is a group of electronic devices that are used together to process data into information. 
Computers are capable of receiving data and producing information due to four basic functions: 

1.    Input (information going into your computer)
2.    Processing (done by CPU chip on motherboard)
3.    Output (shown on screen/monitor)
4.    Storage (permanent storage media to hold information)

How Does a Computer Work? 
When you press a key on your keyboard, you are inputting or sending 
8 bits (1 byte) of data directly into random access memory (RAM). The 
data then travels down the data path on the motherboard to the central 
processing unit (CPU) for processing, and finally back to RAM where the 
information is shown on your monitor (output). You need to save your 
work on permanent storage in order to be able to use it at a later date. 

Computers only understand numbers; therefore, all data (numbers, letters, graphics, etc.) is reduced to a form 
the computer can understand via electronic switches that are either on or off. These are represented by 1’s (on) 
and 0’s (off). A bit is the smallest unit of data measurement. 

1
2 3

5

Reading Text

Key words are in bold to 
help you identify what is 
important. Underline or 
highlight other important 
information. Make notes in 
your own words.

4
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The following chart shows how bits are used to send instructions to computers. 

If you press this letter on your 
keyboard

Your computer recognizes these 
eight-digit numbers (codes)

D 01100100
E 01100001
F 01000110
6 00110110
# 00100011
+ 00101011

There are enough 1 Byte (8 bits) combinations to represent all of the characters on a keyboard.

Document Use

Combined list

Unit of Data Basic Description Actual # of Bytes
Bit smallest unit of data recognized either 1 (on) or 0 (off)
Byte (B) 8 bits equal a byte 1 byte (1 character of data)
Kilobyte (KB) approximately 1000 bytes equal 

a kilobyte
1,024 bytes

Megabyte (MB) approximately 1000 kilobytes 
equal a megabyte

1,048,576 bytes

Gigabyte (GB) approximately 1000 megabytes 
equal a gigabyte

1,073,741,824 bytes

Terabyte (TB) approximately 1000 gigabytes 
equal a terabyte

1,099,511,627,776 bytes

Petabyte (PB) approximately 1000 terabytes 
equal a petabyte

1,125,899,906,842,624 bytes

This knowledge of data will help you begin to understand how to save your results on permanent storage. 
Random access memory (RAM) is volatile memory. This means that it is not permanent and information on the 
screen will disappear when the system is shut down. Remember to save your work often.

To further understand data units, please see the Data Measurement 
Table below.

This table can be used to gauge the storage size of your Hard Drive or the 
capabilities of the RAM (Random Access Memory) installed in your system. 
Any time you are unsure of your data capabilities regarding bits and bytes, you 
can refer to this table.

What kind of document is 
this? What do the headings 
tell me?
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After you have reviewed the contents of Section One, complete the following review. Your instructor may 
choose to have you complete the review individually or as a group or class activity. This review will help you 
become more familiar with computer concepts and jargon. 

Module Two 
Section One Review: 
What is a Computer and How Does It Work?

Your spouse, teenager or co-worker is interested in knowing what you are learning about computers in class. 
Fill in the blanks below so you can use them as notes when you tell them what you’ve learned.

Computers receive data and produce information due to four basic functions:

1.
2.
3.
4.

The keyboard is used for ____________ data into _____________ (RAM). The data is processed by the central 
processing unit (__.__.__.). Once the data is processed, it is then considered information that is sent back to 
__.__.__. and is displayed on the __________. 

Computers only understand numbers. Each keystroke on the keyboard is __ bits of data, and 8 bits are equal to a 
byte. There are names for the various sizes of the units of data. In order of size from smallest to largest, the units 
of data are bit, ______, kilobyte, megabyte, ___________, terabyte and ______________.

Are there any key words I 
can use to look up answers 
in the text?
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Section Two: 
Knowing the Basics About Hardware and Software

Hardware Basics 

Hardware refers to the physical components that make up the computer system. These components include, but 
are not limited to, what is inside the system unit. Computer systems vary and therefore the hardware may differ 
from one computer system to another. However, certain components are necessary for all systems.

The main unit/system unit is also referred to as the console, box, or tower. The main unit/system unit houses 
essential components such as those listed below:

•    The power supply supplies power and runs a fan to help keep the       
      inside of the main unit cool. This component actually converts and 
      reduces electricity to a voltage your computer can handle. 

•    The motherboard is also called the system board or main circuit board. 
     All components connect to the main circuit board. 

•    The central processing unit (CPU) chip is the brain of the computer. 
     Its power to process data is known as clock speed. Clock speed is measured in megahertz (MHz) or           
     gigahertz (GHz), depending on the age of the CPU. The chip has two main parts: The control unit (CU),
     which obtains instructions from memory, interprets them, and then executes them and the arithmetic logic   
     unit (ALU), which performs all the arithmetic and logic functions. The CPU performs mathematical or 
     logical operations to process data it receives from memory (RAM).

•    The Read-Only Memory (ROM) chip holds essential programmed instructions, which are started when you      
     turn your computer on (cold boot). Its final job is to load the operating system (OS), which is the heart of 
     the computer. This type of memory is called non-volatile memory because it retains its contents even when   
     the computer is off (so you don’t lose it).

•  Memory slots are used to hold random access memory (RAM) chips. RAM is short-term memory because 
     it only holds data temporarily. This memory is volatile memory because it is erased when the computer 
     is  turned off. RAM is measured in megabytes (MB) or, on newer systems, in gigabytes (GB). More RAM 
     is used as you increase the number of tasks being performed at the same time. A rule of thumb is you can 
     never have too much RAM.

This is new information. I 
need to read it sentence by 
sentence and stop to reflect 
after each paragraph.
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Hardware Basics 

Hard disk - also called the hard drive - is typically a permanent storage device housed inside the system unit. It 
is usually known as the C: drive. Note that letters are assigned to storage devices.

Expansion slots hold expansion cards such as sound cards, network cards, graphic cards, and internal modems.
Media drives such as the CD-ROM, CD-RW, DVD-R, or DVD-RW are included. Media drives are used to store 
various types of data such as movies, music, or text files. There may also be a combination drive that combines 
the function of all four drives. Media drives are usually known as D: drives. The floppy disk drive is a small, 
thin storage device that holds a very small amount of information. It is known as the A: drive. You may notice 
additional drives if you are on a network, have a removable drive inserted in the USB port, or have a hard disk 
drive that is partitioned.

Outside the main unit you will notice ports and insertion slots that are used to attach or insert other hardware 
or peripheral devices to your computer. Computer manufacturers have made it a lot easier for users to know 
where to connect which device by the use of colour coding or specific instructions on the main unit. 

The Monitor 

A monitor is an essential component of the computer system. The monitor is an output device where you can 
see a soft copy (screen copy) of your work. Monitors come in many makes, models, and sizes. You can choose 
to use a CRT monitor or an LCD monitor. The CRT monitor is named after the cathode-ray tube it uses to 
produce the picture on the screen. This monitor is made of glass and can be curved or flat. LCD (liquid crystal 
display) or Flat panel monitors are much thinner and lighter than CRT monitors. They are also more expensive. 
A monitor’s display is made up of millions of dots known as pixels. The monitor’s resolution is based on the 
number of pixels on the screen (like a television set). The more pixels there are, the sharper and clearer the 
resolution. The speed at which the pixels are re-illuminated is known as the refresh rate. This is measured in 
cycles per second, and expressed as Hz (Hertz). Notebook computers use LCD screens. 

CRT Monitor
LCD Monitor
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Hardware Basics

The Mouse 

With the introduction of graphical user interfaces (GUI), the mouse has become an essential input device.
The mouse is a pointing device that responds to gentle hand movements. Traditional mice have two buttons 
and a scroll wheel, but there are many types on the market. A mouse can also be used with a portable computer 
but most portable computers use an alternative pointing device called a trackball, touchpad, or trackpoint that 
moves the insertion point on the screen. Use gentle movements with your mouse and make sure your pointer 
onscreen is where you wish it to be before clicking the left mouse button (either to select or to place the 
insertion point/cursor). By default, the left mouse button is considered the primary button to use when you wish 
to click - press gently once. You have to press the left mouse button twice quickly in order to double-click
an item. Usually you double-click to open or activate an icon, a program, or a file. The click and drag action
is accomplished by holding down the left mouse button while dragging (moving) the mouse over a selected 
(highlighted) object or text. Pressing the right mouse button is called a right-click action and will activate a 
context-sensitive menu related to what you have selected (highlighted). You then make a choice from the menu 
by clicking the left mouse button once. A scroll wheel can be used to quickly move through large documents. 
Remember to use gentle movements. 

The Keyboard 

The keyboard is still considered the primary input device and the QWERTY 
keyboard (where the letters are found in the same places you would find them on 
an original typewriter) is still the style most people are familiar with. It contains 
the standard alphanumeric keys, plus additional function keys. However, other 
keyboards are available and may accommodate your personal needs better. 
Keyboards can be wired or wireless, just like the mouse. The keyboard layout 
and size on a laptop can differ slightly from a standard desktop keyboard.

Oral Communication

Your instructor presented this information orally. It is also 
available in text format to help you understand how to use 
a mouse. When trying the mouse for the first time, return 
to this section and follow the instructions throughout the 
paragraph. The instructions are not numbered or bulleted, 
and are mixed in with other text. Remember that instructions 
contain a “command” verb. Try highlighting or underlining the 
instructions.
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Peripheral devices may or may not come with your system and include printers, scanners and fax machines.

Printers

Printers are used to produce a hard copy of your information and are therefore output devices. The two 
categories are impact and non-impact printers.

•   Impact printers strike an ink ribbon against the paper producing a character image of the key   
     pressed. This type of printer is rarely used.

• Non-impact printers use other methods to deliver content to the paper. The most common types of   
     non-impact printers are inkjet and laser printers.

Helpful Hints: Buying a Printer 

Consider the print speed, resolution, and replacement cost of ink 
when buying a printer. Speed is expressed as pages per minute 
(ppm). Resolution is expressed as dots per inch (dpi), and the 
higher the dpi, the better the print quality should be. It can be 
cost-effective to choose a printer that has separate cartridges because you only replace the colour(s) that you 
need.

A scanner is an input device used to input a hard copy into memory so that the information from the hard copy 
can be used by the system.

Fax machines are considered to be both an input and an output device because they can both send and receive 
information.

There are many other peripheral devices on the market that can be used with your system. They include devices 
such as multi-function office machines, multimedia projectors, digital cameras, webcams, microphones, 
joysticks, external modems, and countless others. All of these devices are used as input devices, output 
devices, or multi-functional devices. Multi-functional devices can perform input and output capabilities.

Inkjet printers - use ink cartridges and a special nozzle to spray ink onto the 
surface of the paper and are relatively inexpensive when producing colour 
copies.

Laser printers - use a drum, dry ink (toner), and a laser to produce hard 
copies. Black and white laser printers are usually more expensive than 
inkjets, but they are still reasonably priced. However, you will pay much 
more for a laser printer that can produce colour copies.
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Hardware Basics 

New Storage Media 

We depend on storage media to protect our data and important information 
so finding smaller ways to store large amounts of data is important. Over the 
years, we have seen the evolution of portable storage mediums including 
floppy disks, zip disks, tape drives, CDs, and DVDs, with the goal of 
protecting larger amounts of information quickly and easily. 

The portable flash drive, also known as a travel drive, a thumb drive, a jump 
drive, and a universal serial bus (USB) drive, has quickly become the storage 
method of choice. It is extremely durable and fits in your pocket. There 
are many makes and models on the market that hold different amounts of 
information.
How do you use a portable flash drive?

1.    Plug it in to any USB port on a computer. The drive will be    
       recognized by the system as a new device and given a drive letter. 

2.    You can use your little drive as an input or an output device so it       
       is actually a multi-functional device. Files can be copied from the 
       flash drive to the computer or copied from the computer to the 
       flash drive. The process of copying files will be discussed later in the   
       course. 

3.    Make sure that you remove the flash drive safely by clicking the icon   
       in the lower right-hand side of your desktop window that says 

“Safely Remove Hardware” when you hold the mouse pointer over it.

Reading Text

Opening sentences 
introduce the subject.
Paragraph 1 
Subject: storage media
Paragraph 2
Subject: flash drives
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Software Basics

Software 
Software is programming instructions used by the computer to perform a variety of tasks. Programmers can use 
different programming languages when designing software. 

This section of Module Two introduces the two major types of software: System Software and Application 
Software.

System Software 
System software includes the operating system (OS), which is considered the 
heart of the system, and utility programs. Utility programs, such as system tools, 
are used for routine maintenance of the computer. Routine computer maintenance 
will be discussed later in the course.

The OS is necessary on all computers because it enables hardware to 
communicate with application software. Without an operating system, a computer 
does not work. The OS has control from the time it is loaded from the read-
only memory (ROM) chip, until the time the computer is shut down. The OS 
provides the graphical user interface (GUI) so that you can interact with the 
computer. Most current operating systems use the point and click format known 
as the GUI. GUI operating systems use rectangular boxes called windows to 
display information on the monitor. There are many different operating systems on the market for use including 
Microsoft Windows, Macintosh OS, and Linux. However, Microsoft Windows is the most popular. 
Windows and Macintosh operating systems are proprietary system software, which means how the software 
works is and will remain a trade secret. You can only run the Mac OS on Apple’s Macintosh Computers. It will 
not run on a PC. Alternatively, Windows can only run on a PC and not on a Mac.

Application Software is very different from system software. Programs that need to accomplish specific tasks 
are considered application software. Most application software falls into six categories:

•    Education and Reference
•    Productivity
•    Financial and Business
•    Graphics and Multimedia
•    Entertainment
•    Communication

What have I heard 
or what do I know 
about software? 
Do I have prior 
knowledge that will 
help me understand 
“Application
Software”?
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Application Software

Most software companies offer consumers a group of applications called a suite at a cost lower than purchasing 
each individual software application. You can choose which applications you need, depending on what you want 
to accomplish. 

Bookkeepers or accountants may wish to purchase an accounting package such as 
QuickBooks. A graphic designer may need a product such as Adobe Illustrator. 

There are also many free programs which are bundled 
with your system software. You have access to simple text 
editing applications on your system, which enable you to 
write many styles of documents. In the Windows XP OS, 
these programs are accessible by clicking the Start Menu 
on the desktop, then choosing All Programs, Accessories, 
and clicking on WordPad or Notepad. These applications do not have the capabilities of 
more sophisticated word processing applications, but you can use them until you install 
more advanced application software.

After you have reviewed the contents of Section Two, complete the following review. Your instructor may ask 
you complete the review individually or as a group or class activity. This review will help you become more 
familiar with computer concepts and jargon. 
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Module Two
Section Two Review: 
Knowing the Basics About Hardware and Software

You have stopped in to see some of your colleagues at the Action Centre, and they’re interested in hearing 
about your course. As you are bringing them up to date on what you’re doing in the course, Joe is very curious 
about the words you are using. He interrupts to ask you what the words mean, because in the context he is 
familiar with them, they mean something else.  He doesn’t understand the acronyms, either. Explain these 
terms to Joe.

Hardware
__________________________________________________________________
_________________________________________________________________
_____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________

CPU
__________________________________________________________________
_________________________________________________________________
_____________________________________________________________________
____________________________________________________________________
____________________________________________________________________________________________

CPU chip contains 2 main parts – CU and ALU 
_________________________________________________________________________________________
_________________________________________________________________________________________
___________________________________________________________________________________________
___________________________________________________________________________________________

Mouse
_________________________________________________________________________________________
_________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

The text 
preceding the 
Review provides 
information to help 
you complete it. 
Refer to previous 
sections to find the 
answers. Reread 
sections that you 
are having difficulty 
with.
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Section Three: 
General Maintenance of Your Computer

Routine Maintenance
Another important task is performing regular routine maintenance on your 
computer to keep it working at its best. You should know how to keep your 
system in good working order by getting rid of clutter that accumulates over 
time. You will need to delete unnecessary items to free up disk space. Consider 
deleting old files and folders (that you created), old programs that are no longer 
in use, or troublesome programs we call SPAM that get downloaded from the 
Internet when you surf the World Wide Web (WWW). 

Deleting Files
Items you select with the mouse and then delete are moved from one place to another on the hard drive, but 
will still be physically located in the Recycle Bin on your desktop until you empty it. This safety feature lets 
you recover an item in case you delete it by accident. Once a file is in the bin, you still have the opportunity to 
select and restore it to its original location. 

You can access the Recycle Bin from your desktop. Once you are sure that you wish 
to delete all items in the Recycle Bin, you can either right-click on the Recycle Bin
icon to display the Shortcut Menu, and then choose the Empty Recycle Bin option, or 
double-click on the Recycle Bin directly, click on the File Menu, and choose the Empty
Recycle Bin option from there. Now the selected files, folders, and programs are deleted 
completely from your disk. 

When you delete a file completely from the disk, space is left where the old item used to 
be and is reused at the discretion of the file system. This process of organizing disk space for files eventually 
slows down the system. To correct this problem, you need to defragment your drive regularly, depending on 
how much activity you’ve initiated. Defragmenting a drive eliminates scattered portions of files and rearranges 
empty spaces left during deletions. Try to go through a defragmenting process at least once per month or when 
your computer is operating more slowly than usual. 

Backing Up Information 
Computer users learn how to back up, maintain, and protect their important 
information. The importance of backing up your information in case of a hard 
disk crash where information is lost cannot be stressed enough. The best way 
to protect your work is to make a copy of important files and keep them in a 
location away from your computer. 

Reading Text

When you encounter a 
new word, use words 
and sentences from 
text surrounding the 
new word to help you 
identify its meaning.

Backing Up 
Information, back 
up – make a copy of 
important files 

les a
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Using System Tools 

System Tools is a section of the Windows operating system that has a list of 
commonly used utilities to help maintain the computer. To go there, just click 
the Start menu in the lower left-hand corner of your desktop, then hold your 
mouse pointer over All Programs. Another drop-down menu will open. Click 
on Accessories, which opens another menu. Click on System Tools, and click 
to choose the tool you wish to use. 

You may also have a backup system tool available. Double-click on the My
Computer icon and then choose View System Information from System
Tasks on the left side of the screen. There is always more than one way to 
accomplish a task when working with Windows. 

The System Tools section of Windows includes

Character Map – Selects special characters and copies them to your document.

Disk Cleanup – Scans the hard drive and enables you to clear the disk of 
unnecessary files. These files include those in the Recycle Bin, temporary Internet files, and other temporary 
files created by other programs.

Disk Defragmenter – Defragments your hard drive so that your computer runs faster and more efficiently. It 
repositions files so that they fit better on the hard drive and speeds up response time.

Jargon

(or context-specific 
vocabulary)
Remember that 
words have different 
meanings in 
different contexts or 
communities.
Examples from 
“Using System Tools” 
– tools, accessories, 
backup, map, screen 
saver, wizard, menu, 
desktop
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When defragmenting your hard drive for the very first time, there are two items to consider:

1.    It will be time consuming. Perform this maintenance procedure when you will not need to use the   
       computer for a long period of time. 

2.    Screen savers can interrupt the defragmentation process. Be sure to take off any screen saver while   
       performing this task. 

Operating Systems come equipped with a screen saver. If the screen saver has been activated, it will appear 
when the computer has remained idle for a period of time to protect your screen. To stop the screen saver, move 
the cursor to any empty spot on your desktop, right-click, and choose Properties. Under the Screen Saver tab,
choose None in the drop-down box and then click OK.

Files and Settings Transfer Wizard – Moves files and settings from one computer to another.

Using System Tools 

Scheduled Tasks – runs scheduled tasks automatically. This tool gives you the opportunity to run tasks at times 
and dates that are convenient for you.

Security Center – view your current security status and access important settings 
to protect your personal computer.

System Information – displays current system information. 

System Restore – restores your system to a chosen restore point. System Restore 
allows you the benefit of choosing a restore point, which records the settings for 
your system at a specific time. If you have installed a program and it has caused 
problems, you can go back to an earlier restore point when the system was 
working correctly. This function acts like an Undo button that will be discussed 
in a later part of this course. The system restore function only affects your system 
files and will not change the data files you created. 

Internet Explorer (No Add-ons*) – Starts the Internet browser without any additional programs that help it 
function.

*No Add-ons means without the addition of toolbars, programs such as ActiveX controls, etc. Some web pages 
may not display correctly when using Internet Explorer (No Add-ons). 

Note - when clicking on Internet Explorer using System Tools, it shows Internet Explorer (No Add-ons).

Understanding these 
terms is important to 
Oral Communication, 
Reading Text and 
Document Use.
Add any terms that 
aren’t included in the 
glossary.
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Be aware that your System Tools may differ depending on which OS (operating system) you are using, 
but know that all OS come packaged with helpful System Utility programs. 

Helpful Hints: My Computer is Frozen! 

How Do You Fix the “Frozen Screen?” 

Never shut down your machine when this happens. End programs and tasks by pressing the Ctrl+Alt+Del keys 
in sequence on your keyboard. These actions will bring up a Windows Task Manager dialog box and allow 
you to cycle through and stop processes that are taking up too much memory. 

Protecting Information

Protecting your computer from viruses, worms, Trojan horses, spyware, and hackers has become increasingly 
important. In addition to being careful when surfing the Internet, you need to make sure that your OS has the 
latest virus updates. No computer should be without Antivirus software, Antispyware software and a Firewall. 
You need to purchase and install these software programs on your computer.

Be careful about giving out personal information over the Internet. You need to be sure your information 
is going to a secure website. Make sure that you check all emails for viruses before opening them. We will 
discuss this further in future modules.

You have completed Module Two: What Every Worker Should Know About Computers. Before beginning 
Module Three: Basic Learning Environment and Tools for New Users, please complete the module test. Your 
instructor will provide the module test. 

At some point while using a computer, you will face a “frozen screen.” 
This happens when you send too much information to the system RAM or through a 
faulty program. You might feel like a frozen computer if lots of people asked you to do too 
many things at once. In the end, you might just give up and stand there. Every computer 
system is different, but they all have a maximum amount of work they can accomplish at 
any given time.

Remember to use the strategies and 
tips you’ve learned in this module when 
completing your test.





Module Three
Basic Learning Environment 

and Tools for
New Users
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Module Overview

This module will introduce you to topics and skills you need to work with any computer system. You will learn 
about the Windows environment, file management, and basic email skills.

This module will address the following topics:

1.    The basic learning environment and tools for new users
2.    The importance of file management
3.    Email application software

Learning Objectives

During this module, you will

•    be introduced to the graphical user interface (GUI) using Microsoft Windows XP;
•    become familiar with programs included with the operating system (OS);
•    understand file management and why it is used;

•    be introduced to email software programs and learn to create an email, use email tools, locate and attach   
     files, and send files;

•   demonstrate the Essential Skills to use GUIs, file management, and email.

Oral Communication

You will be listening to new 
information and receiving 
instructions in this module.

If you don’t understand 
something, ask the speaker 
to repeat or clarify the 
question.
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Overview of Contents
The following table outlines all the activities that you are expected to complete for Module Three of this course. 
Your instructor will provide due dates for you to complete the chart.

Section One: 
Basic Learning Environment and Tools for New Users
The Windows Environment
Now that you are feeling more comfortable with a computer, you are ready to become familiar with the basic 
learning environment and tools necessary to begin using a computer.

Microsoft Windows XP Home Edition is used as the model for teaching the Windows environment. The basic 
concepts of a graphical user interface (GUI) are the same, no matter which operating system (OS) you are using. 
Keep in mind though that your screen may differ and some procedures may work a little differently than the 
examples shown here. 

When you start your computer, you might have to put in a password depending on your personal setup. It is 
standard for users to have to use a username and password in a public environment because public computers 
are usually part of a network. However, all users end up looking at the standard desktop window with a few 
different variations, depending on which OS you are using. You may have heard people use the term 
multi-tasking when they are talking about their operating system. Multi-tasking is the ability to perform more 
than one task at a time.

Section Content Due 
Day 

Point 
Value 

Section One 
Lecture 

Basic Learning 
Environment and Tools 
for New Users  

Section One 
Self-evaluation 
Quiz

Self-evaluation Quiz for 
Section One 

Section Two 
Lecture 

The Importance of File 
Management 

Section Two 
Self-evaluation 
Review 

Self-evaluation Review 
of Section Two  

Section Three 
Lecture 

Email Application 
Software 

Tools for 
New Users 
Assignment 

Tools for New Users 
Module Assignment  

Module Test Module Three Test 

Resources 

Document Use

Combined List



Employment Track Express

           Module Three Basic Learning Environment and Tools for New Users 57

Common elements such as windows, menus, toolbars, and icons are used in a GUI environment. Years ago, 
users interacted with the OS by using a text-based interface and had to type in commands to accomplish tasks. 
Software companies have come a long way to ensure that their products 
are as user-friendly as possible. The following information will help you 
learn information about Windows.

The Windows Desktop

To view the Windows Desktop, you must first turn on your computer 
and your monitor (and log on to the network environment, if 
necessary).

The Windows Desktop will appear.

Tip: A simple way to practice using the mouse is to play solitaire.

Explore the image on the next page that identifies the most common 
features of the Windows Desktop. Your desktop may look different 
depending on the OS, but the essential features of most Windows 
environments are present.

Oral Communication

Listen carefully to the 
instructions. Make notes 
if you need to. Ask for 
help if you have difficulty 
turning the computer on or 
operating the mouse

The following Windows XP Desktop, including the background design, icons, and shortcuts, 
has been customized to suit one person’s specific needs. You can customize your desktop 
to suit your needs. Screentips appear when you place your mouse pointer over each item on 
your desktop. Try pointing to different icons on your desktop to see the screentips.
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To view the Windows Desktop at any time if you have programs open, click on the Minimize button (minus 
sign) in the upper right-hand corner of each open program window to shrink it down to the Taskbar at the 
bottom of your screen. Remember, you have not closed the programs; therefore, you can click on any of the 
buttons on your taskbar to make that particular program or document the active window on your screen. We will 
talk more about this later in the module.

Windows
Desktop

Shortcut Icon to My Computer 
program indicated by right arrow 
at the bottom of Icon

Recycle Bin

ttttthhhhh

Various Program and 
Shortcut Icons.
Note: Yours are probably 
different.

Start
Menuu

Quick
Launch
Toolbar

Open
Minimized
Program Taskbar

Notification
Area

on
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Item Description
Windows Desktop The main screen, which consists of the Start 

Button, the Taskbar, the Quick Launch Toolbar, 
the Notification Area, Program Icons, and 
Shortcut Icons to programs, folders, and files.

Start Button This button is used to locate and start programs, 
change system settings, shut down, restart, log 
off the computer, and find help if necessary. It is 
found at the bottom-left corner of your Windows 
desktop.

Taskbar The long, horizontal bar found at the bottom of 
the Windows desktop. It is used to display the 
Start button, the Quick Launch Toolbar, and 
names of any open documents.

Quick Launch 
Toolbar

Located to the right of the Start button and may 
display commonly used program icons.

Notification Area Located on the far-right side of the taskbar. 
Notifications appear here regarding background 
processes, such as network connections, 
antivirus checking, the system clock, and many 
more. Some of these notifications only appear 
temporarily, while others remain in permanent 
view.

Icon A graphical object (picture) that can represent a 
disk drive, program, folder, or file.

Recycle Bin Icon A temporary storage area for deleted files. You 
can permanently delete or you can recover items 
from here.

My Computer Icon 
(shortcut)

Representation of the computer you are working 
on. It provides access to the drives, folders, and 
files on your computer.

Internet Explorer 
Icon (shortcut)

Quick access to the Microsoft Internet web 
browser.

Outlook Express 
Icon (shortcut)

Quick access to one of the most commonly used 
email programs for Windows.

Sympatico 
Connection Icon 
(shortcut)

Quick access to a specific Internet Service 
Provider (ISP) using a dial-up line.

Other Icons 
(programs and 
shortcuts)

Various other items based on the specific 
personal computer.

Review the following table that describes each desktop item.

Document
Use

Combined List
Notice that items 
in the left-hand 
column are 
related to the 
information in 
the right-hand 
column.
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How do these items and icons end up on your desktop? Some are installed with the OS but many are placed on 
the desktop with your permission when you install additional programs. In Windows, you can create your own 
shortcut to any program, folder, or file and put it on the desktop to customize the desktop for your personal use. 
Using shortcuts is faster than using menus or other methods. You can recognize a shortcut icon by the 
upward right-pointing arrow in the lower-left corner of the icon itself. This shortcut icon, however, is not 
the actual program and can be modified without worrying about deleting or losing the program on the hard disk.

Look at your desktop as a convenient place to put necessary items that you need to use on a regular basis.

Context-Sensitive Menus

By pressing the right mouse button only once on any of the previously mentioned items, you will open a 
context-sensitive menu. This menu will give you options based on that specific element or item. Please 
remember that context-sensitive menus were not in Windows operating systems prior to Windows 98.

To gain confidence and experience in a new environment, you need to experiment. Make sure that your desktop 
screen is accessible to you, and follow these steps:

Activity 1: Context-Sensitive Menus

1.    Right-click anywhere in the Desktop area (make sure that you are not on a   
      specific icon) and notice the context-sensitive menu that appears.

2.    Right-click directly on the Start button to activate the context-sensitive menu. 
       To close this menu, just click on any clear area of the screen.

3.    Right-click anywhere on the Taskbar (make sure you are not on a minimized  
       program) to activate a context-sensitive menu.

4.    Right-click on the Quick Launch Toolbar to activate a context-sensitive menu.

5.    Right-click on the Notification Area to activate a context-sensitive menu.

6.    Right-click on the various icons on your specific desktop to activate context-sensitive menus.

The context-
sensitive menu 
that appears is a 
simple list.
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During the previous activity, you should have noticed the options that are available in each context menu. Some 
of these menu items have submenus associated with them (indicated by a right-pointing arrow) that you can see 
if you hold the mouse pointer over the specific option. The menus and submenus are part of the hierarchy of file 
management that we will be discussing later in this module. You may also have seen check marks indicating 
which options are currently in use. You can activate or deactivate these options by clicking on the left side of the 
specific option. When the options appear faded, it means that they are not available for use.

Customizing the Desktop
At this point, you are ready to experiment by changing a few settings and customizing your desktop.

Activity 2: Customizing the Desktop

1.    Move your onscreen pointer into an empty area of the desktop.

2. Right-click anywhere in the desktop window.

3.    Click the Properties option in the context menu.

4.    Notice the tabs across the top of the Dialog box, which include the Screen Saver tab that was introduced   
       when you learned about defragmenting your drive in Module Two.

5.  Click on the tabs to see what options you can customize.

6.   Click the Desktop tab. Once you are in the desktop settings, click one of the Background icons that you   
       are comfortable with by clicking on the up or down arrows or by clicking on the Scroll box in the Scroll 

   bar and dragging it up or down.

A preview is presented for you as you click on the different image options.

You can also browse for a specific image for the desktop by choosing the Browse 
button. The computer will show the file system that is on your hard drive and allow 
you to navigate to the specific area of your hard drive to find the image.

You can change the position or colour of the background graphic by clicking on the 
corresponding down arrow and selecting the appropriate option.

Please view the following example of the Display Properties Dialog Window and its 
many features.

Reading Text
Instruction

Reading Text
Instruction
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In the same desktop window, you can also choose the Customize button. This button will bring up a dialog box 
called Desktop Items that will have additional tabs, buttons, check boxes, and a scroll bar containing a scroll 
box and scroll arrows. Note: check boxes are activated or deactivated by clicking in them. 

Document Use

Image (Screen Shot)

Desktop Tab 
Title Bar 

Browse Sample 
Selected 

Help 
and 
Close
Button

Selected 
Background 

Choice 

Color Down 
Arrow 
(options 
available) 

Position 
Down Arrow 

(options 
available) 

Customize 
Desktop 
Button 

(options 
available) 

OK, 
Cancel 

 & Apply 
Buttons 
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Customizing the Desktop (Activity 2 cont…)

7.    Once you have made your decision, and changed any additional settings you wish, click the Apply button   
       or OK button to make the changes to the desktop.

If you click the OK button, your desktop will change and the dialog box will close automatically.

If you click the Apply button, your desktop will change and the dialog box will remain open until you close it 
or click the OK button.

Helpful Hints:

The quickest way to close any dialog box, program, open file, or folder, is to click on the X button located in the 
upper right-hand corner of the window.

When you have finished this activity, you will be more comfortable with terms used in the Windows 
environment. You will also know how to customize the Desktop window background to reflect your own style.
Try changing the settings on a few of the other tabs available in the Display Properties dialog box, such as 
Themes (changes the desktop, windows, and menus), Screen Saver (shows an animated video when the 
computer remains inactive for a period of time), and Appearance (changes colours, shapes, and styles of 
windows), to further reflect your personal style.

Be cautious when making any changes on the Settings tab as it is based on the graphics card installed for your 
monitor.

Helpful Hints: 

Anything you have done can be undone. Just go back into the Desktop Properties via the context-sensitive 
menu that you access by right-clicking in the Desktop window again.

Never be afraid to click, open (double-click), or bring up a context-sensitive menu (right-click) on any icon, 
program, folder or file and have a look around. You can always close any open windows or reverse what you 
have done. Feel comfortable selecting (clicking an item) and trying out different options available via menus 
or toolbars. Practice makes perfect. This old saying applies to working with computers, system software, and 
application software.
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What Is a Window?

When you open a program or activate a dialog box, you are actually opening up a window. A window is a 
rectangular box that displays programs or information. You will find a good example of a window by double-
clicking My Computer on your desktop.

Activity 3: What Is a Window?

1.    Make sure that your Windows Desktop is accessible by minimizing (clicking the minus sign in upper 
       right-hand corner) open programs. When you minimize programs, you move them to your Taskbar 
       and free up your screen.

2.    Double-click on the My Computer icon on your desktop to open the program, or locate the My Computer 
icon on the Start menu and click it.

3.    Compare your screen to the example shown and note any differences.

Remember that your screen may be a bit different depending on which options are chosen and which operating 
system you are using.

Helpful Hints:

Toolbars, Rulers, Task Panes, and Address Bars are often missing. Any of these missing items can be found and 
activated via the View menu at the top of the open program window.
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Document
Use
Image (Screen 
Shot)
Notice headings 
are followed by 
simple lists.
For example, 
System Tasks 
is followed by 
a list of three 
items; Devices 
with Removable 
Storage is 
followed by a list. 

Basic Parts of a Window
To see the basic elements of a Windows XP window, explore the following image. Your window may look 
slightly different depending on the version of your OS, but the essential features of Windows environments are 
present.
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Document Use

Combined List

Notice that items 
in the left-hand 
column are 
related to the 
information in 
the right-hand 
column.

Now review the following table that describes the basic parts of a window.
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Now review the following table that describes the basic parts of a window. 

Screen Element Description 
Title Bar The bar across the top of the open window. Contains 

the icon for the program, the name of the program or 
file, the Minimize, Restore Down/Maximize (changes 
depending on whether the window is maximized or 
not), and the Close button.

Menu Bar The default location is below the Title Bar and 
contains the names of the menus such as File, Edit,
View, Tools, Help, and more. Each of these menu 
commands can contain submenus. 

Address Bar An important toolbar that shows the active address 
path - the window’s location within the file system 
hierarchy. 

Standard Buttons 
Toolbar 

A toolbar containing commonly used navigation and 
settings buttons. 

Left Task Pane A pane at the left of the main window displaying 
information and commonly used tools in My
Computer.

Main Window Contains a list of folders and drives found in My 
Computer.

Status Bar Horizontal bar at the bottom of the window that 
provides information about what you are viewing in 
the main window. 

Taskbar Remains at the bottom of the screen when you open 
any window. Allows easy navigation between open 
windows by clicking the desired tab.  

Active Window Indicated by the dark colour of the title bar. This 
means that any typing or task being performed will 
be done in this window.

Minimize Button Used to shrink the program down onto your taskbar 
at the bottom of your screen. The program or 
document is still open and can be clicked on at any 
time to make it the active window onscreen.  

Maximize Button Used to make the window the full size of the screen, 
so the window uses the maximum surface of your 
monitor. The Maximize button changes to a Restore 
Down button when the window is maximized to the 
full size of the screen. The Restore Down button will 
restore the window to the size it was before being 
maximized. 

Close Button Used to close any open window, whether it is a 
program, document, or dialog box. A dialog box may 
pop up to ask you if you want to save if you are 
closing an open document.  
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Standard Window Operations

You have learned a lot about the structure of a window so far. Now you will be experimenting with the different 
functions of a window using an open My Computer window.

A refresher on the Minimize, Maximize/Restore Down and Close buttons, which are located on the Title Bar,
is necessary before we move forward.

The Minimize button (minus sign) is used to shrink the program down onto your 
Taskbar at the bottom of the screen. The program or document is still open and can 
be clicked on at any time to make it the active window onscreen.

The Maximize button (window icon) makes the window the full size of the screen. 
This button is used to create maximum working space. The Maximize button 
changes to a Restore Down button when the window is maximized to the full size 
of the screen. The Restore Down button will restore the window to the size it was 
before it was maximized.

The Close button (red icon with X on it) closes any open window, whether it is a 
program, a document (file), or a dialog box. A dialog box may pop up at this point to ask you if you want to 
save if you are closing an open document.

Please remember to note where you are saving your documents. The Save In: address bar in the Save As:
dialog box will indicate the location to which the document is being saved.

Moving and Resizing Windows

When dealing with the Windows environment, you should be aware that windows can be moved and resized 
as necessary. Also, you are able to open up more than one window on the screen at a time, and then resize the 
windows in order to have them up onscreen at once. This feature is useful for using the drag and drop method to 
copy and paste data from one document to another.

Windows usually open on your screen the same size and shape they were when they were last used. If 
information that is contained in the window is larger than the window itself, scroll bars will display. You may 
end up with a vertical scroll bar, a horizontal scroll bar, or both. You can move up and down or left and right 
by using the scroll box or scroll arrows.

We covered this 
earlier. Is there 
new information? 
Should I highlight 
new or different 
points? Would 
notes be helpful to 
me later?
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Activity 4: Standard Window Operations

   3.   Click and drag the active My Computer window to different points on your 
         screen. 

Note: You actually have to click and drag on the Title Bar to accomplish this 
        task.

  4.    Use the sizing pointers (double-ended pointing arrows) that appear on the 
         border of the active window as you move your mouse pointer around it. 

  5.    Once you have completed the above exercises and are feeling comfortable when it comes to the Windows   
         environment, please close the My Computer window. Remember: The quickest way to do this is by 
         clicking the Close button (X) in the upper-right hand corner of the window.

Note: Make sure that you have clicked the Restore Down button before attempting this task because it is 
easier to resize the window if it is not maximized. You resize a window by clicking when you are directly 
over your choice of sizing pointer and then dragging away from the window or towards the inside of the 
window to resize the window.

Reading Text

Highlight or underline 
only the instructions 
to make them easier 
to follow. Review the 
information portion 
after completing 
each step. 
Instruction 1 and 2 
have been shaded 
as examples.
Notice that the first 
instruction contains 
three instructions.

Windows Programs

As indicated in Module Two, most OS come with programs that help you with basic productivity. In this section 
of the course, you will explore some of these programs.

For Windows-based computers, let’s start at the beginning by clicking on the Start menu button in the 
lower-left corner of your Taskbar. Start menus usually show

•    shortcuts to installed programs;
•    recently used programs;
•    My Documents, My Recent Documents, My Pictures, My Music, My Computer, My Network Places,   
     Control Panel, Set Program Access and Defaults, and more;
•    all programs and buttons to Log Off or Shut Down the computer.

Remember: Arrows indicate that submenus are available.

Now try the following activity.

1.   Click the Minimize, Maximize, and Restore Down buttons on the Title 
      Bar in the My Computer window to familiarize yourself with what they  
      do.

2.   Move your mouse pointer over different objects in the My Computer   
window to see the various screentips.
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Activity 5: How Do I Find My Programs?

1. Click on the Start menu button.

2. Click “All Programs” or “Programs.” The menu commands and programs will depend on your OS.

3.    Take some time to view the programs available to you and note the Screentips that appear. Also, view the   
 submenus, or even the sub-submenus, of your programs.

4.    Locate and click the Accessories submenu, which as you recall from Module Two has a submenu called   
  System Tools. Also, Accessories has additional programs that come with your OS that you can use to 

       perform basic tasks even before you install more powerful software application programs.

Let’s examine a few of these programs that are available with Windows XP:

• Text Editors are useful for basic typing tasks such as writing a letter or drafting simple documents.

•    Notepad is the older of these two programs and has fewer capabilities than WordPad, but both can be   
     used to create basic text, to edit, and to print. 

•    The Paint program creates and edits drawings and can display and edit   
     scanned items.

•    Another program is Calculator, which can be used in Standard or Scientific  
     mode (modes can be changed from the View menu). The * represents   

      multiplication and the / represents division. You can use either your mouse  
     or your keyboard to work the calculator.

Activity 6: My Programs
Open each of the programs mentioned above to look around. Click on their different menus to see their options. 
Once you are familiar with the programs, make sure that you close all of the programs you opened, except 
WordPad.

(Note: If Word is on your computer, it is unlikely you would choose to use 
these features. However, if you review these programs, you will be able to 
see the differences between older text editors that come with your OS and 
current word processors such as Word.

The names 
of these 
programs give 
me clues about 
what they are 
used for.

Helpful Hints: Additionally, WordPad comes with a Wrap to 
Window option that is usually turned on via the Options submenu 
in the View menu. This option enables you to keep typing without 
pressing the Enter Key at the end of a paragraph.
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Activity 7: Using WordPad

WordPad is a text editor. The following directions will help you to learn how to use it.

1.    Click in WordPad to make sure that it is the active window—the title bar should be darker.

2.    Make sure that your cursor (flashing vertical line) is at the top of the page by clicking in the location you   
       wish to start typing at.

3.    Using the keyboard, type your first and last name.

4.    Press the Enter key twice on your keyboard to leave a blank line between your name and the starting point   
       of your paragraph. Your cursor should be at the beginning of the line.

5. Type a paragraph of text - your choice of topic. Note the menus, toolbars, and ruler. If any of these are   
       missing, just click on the View menu and choose the options you wish to have available to you.

6.    Next, select (highlight) your name in the WordPad window by moving the mouse pointer to the beginning   
       of your name, then clicking and slowly dragging across the name and releasing the mouse button when 
       you are past the end of your name.

7. While your name is selected (highlighted), move your mouse pointer over the 
       options on the formatting toolbar to show the screentips for the 
       various buttons, then watch what happens when you complete the   
       following steps:

•   Click on the Center icon on the Formatting toolbar, but be sure to leave 
     your text selected.
•    Click on the pull-down menu beside the font box and choose a different 
     font.
•  Click on the Down arrow beside the font size box and change the font to a 

      different size.
•  Click on the Bold button.

      Try additional formatting options until you are satisfied with the look of  
     your document.

Instructions
tell you the 
steps you 
need to follow 
to complete a 
task. Complete 
each instruction 
or “step” in 
the order it is 
presented or 
numbered.
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8.  Save the file by following the steps below:

•    Select File from the menu bar.

•  Select the Save As: option. When you select this, the Save As: dialog box appears with the file name  
     already selected. Note that the default location to save in is the My Documents folder. 
     See the example of the Save As: dialog box for WordPad.

•    Using the keyboard, type “My First WordPad Document” in the file name box. Note: As long as   
     the text in this area is highlighted, you can change the existing text by just typing in the
     new name.

•    Finally, click on the Save button in the lower right-hand corner of the dialog box. The dialog box will 
     disappear.
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Document Use

Lists
Drop-down menus 
and dialog boxes are 
presented as lists.

Please view the following example of the Save As: Dialog Window and its many features.

Note: Save in:, File name:, and Save as type: text boxes have 
down arrows to the right of the text box so you are able to choose 
alternative options.
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Helpful Hints: Remember to note where you are saving your documents. Look in your address bar to make 
sure you know where you are saving your files. The address bar will tell you exactly which part of your file 
system the document is located in. The Save As: window will indicate the location it is being saved. A common 
place to save files is the Desktop where you can decide at a later date where you want the file to go, such as the 
folder in My Documents.

You have now created your first document, and you have saved it on a permanent storage media (your hard 
disk).

After you have reviewed the contents of Section One, complete the following short self-evaluation quiz. Your 
instructor may ask you to complete the quiz individually or as a group or class activity. This quiz will help you 
become more familiar with computer concepts and jargon. 
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Module Three
Section One Quiz: 
Basic Learning Environment and Tools for New Users

1.    A graphical object that represents a disk, program, folder, file, etc. is called a (an):
A) mouse pointer
B) window
C) graphical user interface
D) icon

2.    Which Desktop item would you use if you wished to log off the computer?
A) quick launch toolbar
B) computer
C) start button

 D) notification area

3.    Which of the following elements is not a basic part of a window?
A) menu bar
B) title bar
C) status bar
D) storage bar

4.    The minimize, maximize/restore down, and close buttons can be located on:
A) the address bar
B) the taskbar
C) the menu bar
D) the title bar

5.    Which program uses the method of pointing and clicking to enter numbers?
A) Paint
B) Notepad
C) Calculator
D) none of the above

You are now ready to learn about File Management.
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Section Two: The Importance of File Management

File management - knowing what you are saving and where you are saving it - is an important computer skill.

The best way to learn file management is to get to know the hierarchical file system used by your OS. Please 
open My Computer by either double-clicking the icon on your desktop or clicking the Start menu and finding 
the icon from there.

You will see the folders and drives that are available on your computer. A 
screentip appears as you move your mouse pointer over each of these items 
and gives information regarding the folder or drive. If you click any of these 
icons, you will see additional information in the details section of the Task 
Pane on the left.

You can also create folders to hold your files on any permanent storage media 
(local disk or removable storage media). The key to creating folders and files 
is to name them logically. Any person looking at your file system should be 
able to know what a folder contains at a quick glance. 

Folders

Folders contain files and subfolders that relate to each other. You might create a folder for each person that uses 
your computer who, in turn, can create subfolders, which suit their needs.

You organize your files by saving them in the appropriate folder or subfolders specifically named to hold them. 
By using a system like this, you won’t have to use the search feature available on the Standard Buttons 
toolbar in My Computer, although this feature can help you find a file more readily than looking through 
hundreds or thousands of files.

There are many ways to create a new folder on permanent storage media. The next activity will show you 
different ways to create folders. Open the My Computer window (or click the My Computer button on your 
Taskbar) to make sure it is the active window.

Reminder: you can 
click on the Minimize 
button (minus sign) at 
any time to go back 
and forth between the 
programs you have 
open.
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Activity 8: Creating a Folder

1.    Select the Up button (the folder with an upward pointing arrow) on the
       Standard Buttons toolbar to move up a level in the file system hierarchy.

Note: The Address Bar location now shows the desktop 
       as your address location. This is where you will create your first new  
       folder.

2.    Select the File menu.

3.    Hold your mouse pointer over the option New, or click on New.

4.    Select Folder. A new folder will be created with the default name of New 
       Folder. You can begin typing your folder name on the keyboard.

5.   Type (Your Name) as the folder name and then click anywhere in the white area of the window to    
       complete the action.

You have now created a folder on your desktop that you can access quickly and easily.

Helpful Hints: If you create additional folders at this point without changing the name, they will be called 
Folder 2, Folder 3, and so on. To delete these, just select the folder or folders, press the delete key on your 
keyboard, and then click the Yes button on the dialog box that appears. The additional folder will be deleted and 
the dialog box will close automatically.

Subfolders
Subfolders have to be created inside existing folders. You are just creating a new folder within another folder.

Oral 
Communication
Ask for information 
or instructions to be 
repeated or clarified if 
you do not understand 
what the speaker 
means.
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Activity 9: Creating a Subfolder

1.  Open the new folder you created on your desktop. You are now inside the folder (Your Name). Take note   
       of the Address Bar, which tells you where you are in the file system hierarchy.

2. Select Make a new folder under the heading File and Folder Tasks in the Task Pane on the left side of the 
       open window. A new folder is created ready for you to name.

3.    Name the subfolder “Course Assignments” and then click anywhere in 
       the white area of the window to complete the action. You now have a 
       subfolder called “Course Assignments” inside a folder called 
       (Your Name) on your desktop.

4.    Select the Up button on the Standard Buttons toolbar to go back up a 
       level to the Desktop again.

5.    Try creating additional folders and subfolders. You can also create a folder 
       by right-clicking in the white area of the window and then choosing New, 
       Folder.

Renaming a Folder

You can rename a folder using the Shortcut menu by right-clicking on the folder. You can click once on the 
folder to select it, and then click where the name is again to rename the folder. You can also use the Rename
option in the File and Folder Tasks on the Task Pane. Reminder: You need to select a file first in order to 
modify it in any way.

Don’t forget to delete any unnecessary folders you have created when you are finished. Shrink the program 
down to the Taskbar by clicking the – sign in the upper-right corner of the window.

WARNING: Be careful not to delete existing desktop icons and folders.

Important Note to Students: You will need to use the “Course Assignments” subfolder to save assignments 
you create and need to send to your Instructor throughout the rest of this course.

Reading Text
Remember that 
instructions and 
information may be 
mixed together.
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Jargon
or context-specific 
vocabulary needs 
to be learned and 
understood. If you are 
unsure of the meaning 
of words, look them up 
in the glossary or ask 
what the words mean.

Windows Explorer
In addition to My Computer, another program called Windows Explorer can be used for File Management.
You can access this program from the Accessories submenu by clicking on the Start menu, or by right-clicking 
on the Start menu to bring up the context-sensitive menu and then clicking Explore (directly under the Open
option). The program window will look very similar to the My Computer window with the Folders button 
clicked. You can choose which one – My Computer or Windows Explorer - you are more comfortable using.

Selecting Text
It is possible to select more than one icon, folder, file, object, or selection of text at a time and then do 
something that will affect all of them at once. You can do this by using the
Ctrl and Shift keys on your keyboard.

The Ctrl key is used to select multiple items. These items are not in a 
continuous order from start to finish and can be chosen randomly by selecting 
the first item you wish to use, and then pressing the Ctrl key (and leaving it 
pressed) while selecting additional items. Release the Ctrl key after you have 
selected all the necessary items.

The Shift key is used to select continuous pieces of information (items that 
are all in a row). Items can be selected from start to finish by selecting the 
first item, then pressing and holding the Shift key while selecting the last 
item in the continuous string. Finally, you release the Shift key when you 
have selected all your items. Try it by completing Activity 10.
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Activity 10: Selecting Text

1.    Make sure that My Computer is the active window on your screen by clicking its tab on the Taskbar or   
       double-clicking the icon if necessary.

2.    Select one of the drives or folders available to you.

3.    Press down the Ctrl key on your keyboard and leave your finger on it while you select any additional   
       noncontiguous (not in a row) drives or folders you wish.

4.    Release the Ctrl key.

5.    Do the same procedure as steps 1 through 3 using the Shift key instead for contiguous items (items in a   
       row).

6.    Shrink the My Computer window down to the Taskbar again by clicking the – sign.

In all computers, you can organize files and folders by copying and pasting, cutting and pasting, and dragging 
and dropping. By using these commands, it’s easier to manipulate and manage files. These features can also be 
used within application programs to accomplish the same tasks with text and objects as they do with files and 
folders.

Copy and Paste
Copying files and folders from one place to another is a standard data management task. When you do this, you 
leave the original file where it was and create a copy that is then put elsewhere. Essentially, you create a backup. 
In addition to the Copy command, you have to use the Paste command in order to complete the procedure. 
Otherwise, the file or folder remains on the Clipboard (temporary memory).

Cut and Paste
Cutting and pasting is moving a file or folder from one place to another. When you select and then use the Cut 
command, the file or folder is temporarily removed from its location until you complete the procedure by using 
the Paste command in another location. If you paste the selection in the same document, in another document, 
or in an entirely different location, the original data disappears from the 
original location. You can, however, paste the data back into its original 
location because it is stored in RAM until another command is entered. The 
destination can be on the same storage device or on any media device that can 
be written to.

An example would be to cut (move) a file from your recently created folder 
and then paste it to an open folder on your travel drive.

Copy and Paste, Cut 
and Paste, Drag and 
Drop…these are new 
terms to me. I should 
see if they are in the 
glossary and add 
them if they are not..
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Drag and Drop

The drag and drop method is convenient when you wish to copy a file from one drive to another quickly. This 
method only works well if you can see both the source file and the destination folder or drive at the same time. 
There is a technique to using the drag and drop method. You can accomplish this by highlighting (selecting) 
the source file and, once it is selected, slowly dragging the file over to the destination folder or drive. You 
should always check the destination to make sure that the file actually ended up where you wanted it to go.
You created a document using the WordPad program earlier in this module and saved the file on the local drive 
(C:) in a folder called My Documents (which is the default location when you save a file for the first time, if 
you do not specify otherwise).

You will now use this file in order to practice the above-mentioned procedures.

Activity 11: Using the Drag and Drop Method

1.    Open the My Computer window either through the desktop or through the Start menu.

2.    Click the Folders button on the Standard Buttons toolbar so that you can see all the drives and folders 
       that are available.

3.    Click on any – signs to collapse them in the left pane window.

4.    On the Standard Buttons toolbar, click Up to go up a level in the file system hierarchy.

5.    Locate and open the folder called My Documents.

6.    You should now be able to view the file called My First WordPad Document that you saved in this folder  
       in the main right pane window. You should also be able to see the folder you created called (Your Name)  
       in the left pane window.

To Copy and Paste the file using the Drag and Drop method

Select the file in the left pane window, and press the Ctrl key down on your keyboard, making sure that you 
continue to hold the mouse button down while dragging the file slowly over to the folder called (Your Name) 
which should highlight as you hover above it. Once the folder is selected (highlighted), release the left mouse 
button to drop the file into the folder. You should now have a copy of your file in the folder you created on the 
Desktop.

To Cut and Paste (move) a file using the Drag and Drop method

Click (select) the file in the left pane window, making sure that you continue 
to hold the mouse button down while dragging the file slowly over to the 
folder called (Your Name) which should highlight as you hover above it. 
Once the folder is selected (highlighted), release the left mouse button to drop 
the file into the folder. You should no longer have the file in the original 
location as you have moved it to a new location.

“Click”, “select” and 
“highlight” have similar 
meanings when 
performing some 
computer tasks.
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Additional File Management Options

There are other methods of using these commands with files and folders. You should still have the My 
Documents window available to you, so make sure that it is the active window.

Activity 12: Using the Cut, Copy, and Paste Commands

1.    Click on the folder (Your Name) in the left pane window. Notice that the right pane window holds the        
       subfolder called Course Assignments that you created earlier in this module, along with the file called 
       My First WordPad Document that was previously in the My Documents folder.

2.     Select the document, and then do one of the following procedures to copy and paste it into the Course 
        Assignments folder:

Click on the Edit menu and choose the Copy command. Then, double-click on the Course Assignments 
folder to open it. Click the Edit menu again, but this time click the Paste command.

Click on the Folder toggle switch on the Standard Buttons toolbar to turn it off, and then use the Task Pane 
option to Copy this file under the File and Folder Tasks heading. A dialog box will appear to help you 
with the procedure. You will have to choose where the file will be copied to by clicking on the appropriate 
folder called Course Assignments, and then click on the Copy button.

Many of the activities in this course contain several steps. They will be demonstrated on the 
projector screen. You will have the opportunity to try the activities one step at a time while they 
are demonstrated. You will also receive the instructions step by step as they are used in new 
activities. The instructions are also in the manual to refresh your memory when using a computer 
outside of class. Each time you complete these tasks, they will become more comfortable and 
familiar.

3.    Right-click on the file to bring up a context-sensitive menu. Choose the Copy command. Then, open the   
Course Assignments folder and right-click anywhere in the white space to bring up the context-sensitive   

       menu, and click the Paste command.

4.    Delete the copy of the file in the Course Assignments folder before performing the next procedure.
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5.    Select the document and then do one of the following to cut and paste it into the Course Assignments   
       folder:

Click on the Edit menu, and then choose the Cut command. Double-click on the Course Assignments   
folder to open it, and then click the Edit menu. Then, click the Paste command.

Use the Task Pane option Move this file under the File and Folder Tasks heading. A dialog box will   
 appear to help you through the procedure. You will have to choose where you wish the file to be 

moved to by clicking on the appropriate folder called Course Assignments, and finally clicking the 
Move button.

 Right-click on the file to bring up a context-sensitive menu, choose the Cut command, then open the   
Course Assignments folder and right-click anywhere in the white space to bring up the context-   
sensitive menu and click the Paste command.

There are many ways to complete similar computing tasks. With practice, you will find that certain commands 
work better for you than others. Once you understand the basics of computers, you will have learned many 
skills that you can transfer to other computer settings and applications.

After you have reviewed the contents of Section Two, complete the following short self-evaluation review. Your 
instructor may ask you to complete the review individually or as a group or class activity. 
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Module Three
Section Two Review: The Importance of 
File Management

Cathy, a new employee you are mentoring, often calls you in a panic. She 
was hired without computer skills but was told she would be trained and it 
isn’t happening as fast as she needs it. Your training is a step or two ahead 
of hers, so she often calls for help. Here are some of the questions she has 
asked.

“I’ve been asked to identify the name, size and type of files I will be sending to Marketing to be included on the 
website. Where do I find that information?”
__________________________________________________________________________________________
__________________________________________________________________________________________

“I’ve created a folder for a project that I will need to file many documents in. I think I forgot to give it a name 
when I filed a document in it that took me a very long time to create. How can I find the folder I forgot to give a 
name to?” 
__________________________________________________________________________________________
__________________________________________________________________________________________

Cathy says that someone from Marketing said she should get the information she needs to send to them by using 
Windows Explorer. How does she access Explorer? 
__________________________________________________________________________________________
__________________________________________________________________________________________

Cathy finally finds the folder and file she needs. She asks you how to rename the folder so she can find it easily 
next time she needs it. Give her the instructions.
__________________________________________________________________________________________
__________________________________________________________________________________________

Cathy decides to ask you one last question. She has a folder she would like to remove. Give Cathy instructions 
so she can delete the folder.
__________________________________________________________________________________________
__________________________________________________________________________________________

In the next section you will learn about email application software so that you are able to communicate with 
your instructor and send finished assignments as attachments.

Identify key word(s) to 
look for before returning 
to the text in the module 
to find the correct 
answers. Remember that 
headings will help you find 
information.
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Section Three: Email Application Software

You have many options for creating emails and communicating with other people. Some email programs are 
only for email and address books, while others include calendars and schedulers for managing daily tasks.

What is Email?

Software companies originally developed electronic mail (email) programs 
to provide a way to send and save messages more quickly than standard 
letter mail. Additionally, they created email to be assured that the recipient 
received their messages. Email was first used internally to send agendas 
and notices to several co-workers at one time, which resulted in quicker 
response times and large savings on office supplies.

However, it was not very long before companies recognized the value of 
email being used externally. The growth of the Internet enabled companies 
to send information to each other via the Internet. In fact, messages could 
be sent anywhere electronically.

What Do I Need to Get Started?

1.    A connection to the Internet through an Internet Service Provider   
(ISP) is required to send email externally. 

      Note: Computers usually come with modems and/or network cards   
      installed.

2.    An email address from a valid email account.

ISPs usually provide any additional internal/external hardware and technical support to accommodate you 
when you pay for their specific service. This connection could be through a regular telephone line, a 
high-speed telephone line, a dedicated line, a cable, or a satellite. There are many companies that provide 
this service with varying costs and capabilities. Common ISPs include communication companies such as 
Bell or Rogers, and smaller Internet providers for rural areas.

Most ISPs provide email addresses that can be used through Internet browsing programs or standard email 
applications. There are also a number of free and commercial email providers that devote most of their 
resources to email traffic.

Reading Text

More than two pages 
of information text 
are presented here. 
Remember to use reading 
strategies.

Read difficult paragraphs 
one sentence at a time;
stop reading to think about 
what you have read;
make notes or highlight 
important phrases;
look up definitions of 
unfamiliar words or ask 
your instructor. 
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How Does Email Work?

Email service providers use email servers that can handle high traffic and store massive amounts of data. These 
servers use Simple Mail Transfer Protocol (SMTP) to ship messages from one address to another. A protocol 
is a set of rules and both communicating systems (sending and receiving) have to be using the same protocol.

Email makes sharing files quick and easy. You can attach files to a message and send them much faster than 
using old file transfer software. However, file transfer protocol (FTP) sites are still in existence and are useful 
for larger files.

Helpful Hints: You will need to contact your ISP if you wish to use a separate program or your Internet 
browser to send email, as there are specific settings that need to be addressed by the company. However, if you 
wish to use an email program that is found on the Internet, creating an account is quite simple.

Two common email services used on the Internet are Hotmail and Yahoo Mail. You can go to 
www.hotmail.com or www.yahoo.com and create an email account for free. Once you have this account, it can 
be used from any computer where you have access to the Internet.

Some people have free accounts that are tied to their place of work, school, or special group. Even people who 
do not have a computer at home can create an email account and then use any computer available to send and 
receive emails.

What Does an Email Look Like?

The email address has three components:

1.    The email ID (username).
2.    The (@) symbol.
3.    The Domain name (xxxxx.com/ca) of the email server.

A typical email address could be: jok.carr@sympatico.ca

A further breakdown would be as follows:

The username—jok.carr—is the email ID that identifies who is sending or receiving the message.

The @ (at symbol) separates the ID from the domain name of the email server.

Sympatico.ca is the domain name of the email server that is often the same as the recipient’s ISP.

Although there are many email application programs available, they have many items in common. They may 
have slightly different looks, but the basic information necessary to send a message to someone is the same. 
Common folders such as Inbox and Outbox are found in these email applications, along with many other 
capabilities and tools.

Note: You will need an email program for the following activities. Complete the following procedures to create 
a free email account via Hotmail.
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Activity 13: Creating an Email Account

1.    Make sure that you are connected to the Internet.

2.    Open up your browser (for example, Internet Explorer, Firefox, or   
       Netscape).

3.    Locate your address bar at the top of the browser and type www.  
       hotmail.com, or click on the link provided to take you to the Hotmail   
       home page.

4.  Click on the Sign up button on the left side of the browser window. 

5.  Click on the Get It button in the centre under the heading called   
 Windows Live Hotmail.

6.    Read the instructions and fill in all required fields indicated by an asterisk (*) by clicking in the text boxes   
       and typing the required information. Click on the down arrows to see any additional options. 
       Use the scroll bars provided to make sure that you complete the full form. Once you are finished, click the 

   I accept button at the bottom of the web page. Don’t worry if you make a mistake because an error 
       message will pop up and you will be required to fix it before moving on.

Helpful Hints: Be sure to record any usernames or passwords you create so that you can get to your emails once 
you open your email account.

Your new Windows Live Hotmail account should now be in view. In the far left pane, you will see email 
related links to folders. Please click on the one called Mail (it looks like a letter) to view your mail program. A 
screentip appears that says Go to your email, as you move your mouse over it.

Congratulations. You now have a working email account that will allow you to send and receive information 
over the Internet. You can go to the website and login to your mail at any time.

Common Email Functions:

Most email programs have similar functions that allow the user to accomplish the same tasks. All programs 
have address books to hold multiple contacts, folders to hold emails of a common nature, and programs to allow 
for spell-checking, formatting text, printing, searching, prioritizing, requesting receipts from recipients, and 
many other items. Both Macs and PCs have functions to help you read, delete, create, and attach files to emails.

Oral Communication

If you do not understand 
what is being said or 
need further information 
to help you understand, 
tell the speaker. If you 
are still unsure, state 
what you heard in your 
own words and ask for 
confirmation.
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How Do I Read My Mail?

Activity 14: Reading Your Email

1.    Open the email program you will be using for this course.

2.    Make sure that the Inbox is activated by clicking or double-clicking it, because this is where your   
       incoming mail is stored until you do something with it.

3. Click or double-click on the actual message in order to see what it says.

4.    If you choose to reply to the email immediately, click the Reply button on the toolbar, type your response 
       in the message area above the original message, then click the Send button in the open dialog box. This 
       option will automatically fill in the required email address so that the message is sent back to the original  
       sender.

How Do I Delete Email Messages?

Activity 15: Deleting Email Messages

1.   Click on the message to be deleted (or click in the check box beside the message).

2.    Click the Delete button on the toolbar or press the Delete button on your keyboard. You may be asked to  
       confirm the deletion.

Helpful Hints: Be aware that your sent messages may be going to your Sent folder (if you have one) and 
deleted messages may go to your Deleted folder (if you have one). Most email programs do not delete 
messages permanently until you clear them (delete them) from those folders as well. These messages can end 
up taking up a lot of space on your disk if you do not clear them.
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How Do I Create a New Mail Message?

Activity 16: Creating a New Message

1.    Click on the New Message button on your email program’s toolbar to   
       bring up a new email dialog box. The name of this button could vary   
       depending on what email program you are using and may include   
       names such as Create New Message, or New Email.

2.    Fill in the appropriate information by clicking in the text boxes   
       available:

A)    Click in the box to the right of To: and type in the recipient’s   
        email address.

B)    Click in the box to the right of Cc: and type in an additional   
        address if you want to send a copy of the email to someone   
        else.

C)    Click in the box to the right of Subject: and type in the subject 
        of your email. This is important because many recipients will   
        not open an email if it does not have a subject line.

D)    Click in the Message box and type in your actual message.

E)    Click the Send button on the dialog box toolbar. Your message  
        has been sent.

How Do I Attach a File to a Message?

To attach a file, you create or reply to a message as we have already discussed, but before sending the actual 
message, you would add the steps in Activity 17.

  Writing

Many occupations require 
the writing of emails. Use 
these writing strategies:

•   Think about what you     
    need to write

•   Gather the information   
    you need before writing 

•   Keep the message   
    simple



Employment Track Express

           Module Three Basic Learning Environment and Tools for New Users 89

Activity 17: Attaching a File to a Message

1.    Most programs have a paper clip icon to indicate the button used to attach a file. Click the Attach button   
       on the toolbar (Outlook Express) or the Attach button with the pull-down arrow on the toolbar (Hotmail).   
       Most email programs give you the option to attach a file or a picture with your text.

2.    Click on the Browse button to locate the file that you wish to attach within the hierarchy of the file system.   
       This is why it is very important to know where and how your files are stored.

3.    Either double-click the required file OR click the file, and then click the Attach button to achieve the same   
       result. Note that the outgoing email should have the attachment file name displayed somewhere in 
       the window. You can attach additional files to the email in the same way if you wish to.

4.    Click the Send button on your toolbar once you are satisfied that the attachment has been attached.

Try sending emails with attachments to friends and family for practice. The best way to become familiar with a 
program is by exploring its options through its menus and toolbars.

You will now complete the Assignment called Tools for New Users Module 
Three Assignment that will be provided by your Instructor.

You have completed Module Three: Basic Learning Environment and Tools for 
New Users. Before beginning Module Four – Computer Use: Using the Internet, 
please complete the module test. Your instructor will provide the module test.

Remember to use 
the strategies and 
tips you’ve learned 
in this module when 
completing your test.





 

Module Four
Computer Use: Using the 

Internet
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Module Overview

Online communication has become part of everyday life. This module will introduce topics to communicate 
effectively with others over the Internet, find useful information and apply that information to career research, 
goal setting and decision making. 

This module will address the following topics:

1.    Online communication
2.    The Internet
3.    Other communication services
4.    Using your service provider

Learning Objectives 

During this module, you will

•    gain knowledge about the history of the Internet and the use of protocols;
•    become familiar with using a Web Browser such as Internet Explorer;
•    learn about search engines to use the Internet;

 •    become comfortable surfing the Web;
•    understand the difference between a website and a web page;
•    understand the communication tools available on the World Wide Web;
•    become acquainted with an Internet Service Provider and its services;

 •    apply research skills to find and use information.
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Overview of Contents

The following table outlines the activities that students are expected to complete for Module Four of this course. 
Your instructor will provide due dates for you to complete the chart. 

Section Content Due Day Point Value
Section One Lecture Online Communication

Section One Self-
evaluation Review

Self-evaluation Review 
of Section One

Section Two Lecture The Internet

Section Two 
Self-evaluation
Review

Self-evaluation Review 
of Section Two

Section Three Lecture Other Communication 
Services

Section Four Lecture Using Your Internet 
Service Provider (ISP)

Online
Communication
Assignment

Online Communication
Module Assignment

Module Test Module Four Test
Resources

Document Use

This table, which combines lists, is included in each module. The 
relationship between the items in the columns is established by the 
headings (Section, Content, Due Day, Point Value). 
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Section One: Online Communication

File Attributes 

All files and folders contain attributes which are criteria that define how 
they are used in the file system. If you right-click a file or folder and 
select Properties from the context-sensitive menu, you will see 
read-only as one of the attributes that can be applied to protect a file from 
being modified. This means someone else created a document and they do 
not want it changed.

Another attribute that may be used on a file or folder is the hidden
attribute. Once applied, that particular file or folder would be hidden from 
view until the attribute was taken off. Once you have hidden a file or 
folder, you must then click on the Tools menu in My Computer, choose 
Folder Options (this opens the Folder Options dialog box), then choose 
the View tab. On the view tab, click Show hidden files and folders, under the Hidden files and folders heading. 
Reverse this procedure if you wish to hide the rest of the files or folders from view. This procedure will show all 
hidden files and folders.

Attributes can be applied or removed by right-clicking on the actual file or folder, choosing Properties from 
the context-sensitive shortcut menu, choosing the General tab, and then choosing the check box beside the 
attribute you wish to apply or remove. 

You might choose to use this feature if you are using a shared computer and want to ensure your work isn’t 
altered or deleted by mistake. At home, this feature would prevent changes inadvertently being made to 
operating system or software files. 

Jargon
(or context-specific 
vocabulary)
Highlight the definition 
of “attributes.” Write the 
definition in your own 
words.
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Editing a Document 

Changes to an attachment you receive can usually be made once the 
document has been opened. Difficulties making changes to an attached 
document received via an email may be due to different issues: the file 
could have a read-only attribute on it; you may not have the program 
available on your system to edit the specific file; or the owner has protected 
it by some other method to avoid changes being made. Often changes 
can be made by saving the document with a different file name or by 
removing the read-only attribute on the file itself. Make sure that you have 
the permission from the owner of the file before you make any changes to 
the document. Using or making changes to documents without permission 
could create an ethical or even a legal situation.

Screen Capturing

It is possible to save and share a screen image. This is referred to as screen capturing. Press the Print Screen 
(Prnt Scrn) key on your keyboard located at the top right of your keyboard above the numeric keypad. This 
results in a copy of your screen being placed on the Clipboard (in RAM). Open any document and choose 
the Paste option to input the snapshot into the document. Remember to choose an insertion point before you 
complete this action as the image will be pasted exactly where the insertion point is located. It is wise to press 
the Enter key a few times in order to type a title or heading preceding the image. Finally, you can save the 
document to a specified location in your file system to retrieve it at a later date. Try it.

Keyboard Shortcuts 

Even with a mouse or pointing device on your system, the keyboard remains a very useful tool to simplify 
and shorten tasks that would normally take a lot of time. Learning keyboard shortcuts to accomplish tasks is 
also important in case your pointing device fails while you are in the middle of completing a document or an 
important task. 

Notice that the menus always have a particular letter underlined. Pressing the Alt key + the letter indicated for 
the menu will allow you to open a document-specific context menu. Press the specific letter on the keyboard for 
the option you wish to open. In dialog boxes, press the Alt + letter key to access this process. The arrow keys
beside the numeric keypad can be used to move up, down, left, and right along the context menu. 

If I have permission to make 
changes, will it be ethical 
and legal? Do I need to ask 
questions to understand 
this?
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Certain keys save time when undoing a command or maneuvering through a document. 
Keys you may choose to use on a regular basis are

•    Esc (escape) key, to quickly minimize an application you are working with 

•    Insert key to change modes in windows (overtype or edit)

•    Home (moves to the beginning of the document) 

•    End (moves to the end of the document)

•    Page Up and Page Down keys which move a full page in either direction of a document. 

Open a document and try the shortcuts to gain experience with the keys on the keyboard. 
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shortcuts to accomplish tasks is also important in case your pointing device fails while you 
are in the middle of completing a document or an important task.  

Notice that the menus always have a particular letter underlined. Pressing the Alt key + the
letter indicated for the menu will allow you to open a document-specific context menu. 
Press the specific letter on the keyboard for the option you wish to open. In dialog boxes, 
press the Alt + letter key to access this process. The arrow keys beside the numeric keypad 
can be used to move up, down, left, and right along the context menu.  

Certain keys save time when undoing a command or maneuvering through a document. 
Keys you may choose to use on a regular basis are: 

Esc (escape) key, to quickly minimize an application 
you are working with 

Insert key to change modes in windows (overtype or 
edit)

Home (moves to the beginning of the document) 

End (moves to the end of the document)

Page Up and Page Down keys which move a full page in either direction 
of a document. 

Open a document and try the shortcuts to gain experience with the keys on the 
keyboard. Could the table below be on a page by itself, nothing on the back, so 
students can remove it to use by their computer? 

General Keyboard Shortcuts 

Keyboard Shortcut Action 
CTRL+C Copy 
CTRL+X Cut 
CTRL+V  Paste 
CTRL+Z Undo 
DELETE Delete 
SHIFT+DELETE Delete the selected item permanently without 

placing the item in the Recycle Bin 
CTRL while dragging an 
item 

Copy the selected item 

F2 key Rename the selected item 
CTRL+SHIFT with any of 
the arrow keys 

Highlight a block of text 

SHIFT with any of the 
arrow keys 

Select more than one item in a window or on the 
desktop, or select text in a document 

CTRL+A Select all 

Document 
Use
Table based on 
combined lists. 
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F3 key Search for a file or a folder 
ALT+ENTER View the properties for the selected item 
ALT+F4 Close the active item, or quit the active program 
ALT+ENTER Display the properties of the selected object 
ALT+SPACEBAR Open the shortcut menu for the active window 
ALT+TAB Switch between the open items 
F6 key Cycle through the screen elements in a window or 

on the desktop 
F4 key Display the Address bar list in My Computer or 

Windows Explorer 
ALT+Underlined letter in a 
menu name 

Display the corresponding menu 

F10 key Activate the menu bar in the active program 
ESC Cancel the current task 
CTRL+ESC Display the Start menu 

Dialog Box Keyboard Shortcuts

Keyboard Shortcut Action 
CTRL+TAB Move forward through the tabs 
CTRL+SHIFT+TAB Move backward through the tabs 
TAB Move forward through the options 
SHIFT+TAB Move backward through the 

options
ALT+Underlined letter Perform the corresponding 

command or select the 
corresponding option 

ENTER Perform the command for the 
active option or button 

SPACEBAR Select or clear the check box if 
the active option is a check box 

Arrow keys Select a button if the active option 
is a group of option buttons 

F1 key Display Help 
F4 key Display the items in the active list 
BACKSPACE Open a folder one level up if a 

folder is selected in the Save As 
or Open dialog box 

Forward and Backward Slashes 

Notice the Address bar in My Computer shows the drive letter 
followed by a colon and a backslash. Folders are also separated by 
backslashes, which indicate your location in the file system 
hierarchy. An example of a typical address would be: 

Oral 
Communication
-listen for 

Reading Text 
-locate

Command verbs tell 
you to expect an 
instruction. 
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F3 key Search for a file or a folder 
ALT+ENTER View the properties for the selected item 
ALT+F4 Close the active item, or quit the active program 
ALT+ENTER Display the properties of the selected object 
ALT+SPACEBAR Open the shortcut menu for the active window 
ALT+TAB Switch between the open items 
F6 key Cycle through the screen elements in a window or 

on the desktop 
F4 key Display the Address bar list in My Computer or 

Windows Explorer 
ALT+Underlined letter in a 
menu name 

Display the corresponding menu 

F10 key Activate the menu bar in the active program 
ESC Cancel the current task 
CTRL+ESC Display the Start menu 

Dialog Box Keyboard Shortcuts

Keyboard Shortcut Action 
CTRL+TAB Move forward through the tabs 
CTRL+SHIFT+TAB Move backward through the tabs 
TAB Move forward through the options 
SHIFT+TAB Move backward through the 

options
ALT+Underlined letter Perform the corresponding 

command or select the 
corresponding option 

ENTER Perform the command for the 
active option or button 

SPACEBAR Select or clear the check box if 
the active option is a check box 

Arrow keys Select a button if the active option 
is a group of option buttons 

F1 key Display Help 
F4 key Display the items in the active list 
BACKSPACE Open a folder one level up if a 

folder is selected in the Save As 
or Open dialog box 

Forward and Backward Slashes 

Notice the Address bar in My Computer shows the drive letter 
followed by a colon and a backslash. Folders are also separated by 
backslashes, which indicate your location in the file system 
hierarchy. An example of a typical address would be: 

Oral 
Communication
-listen for 

Reading Text 
-locate

Command verbs tell 
you to expect an 
instruction. 

General Keyboard Shortcuts

Dialog Box Keyboard Shortcuts
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Forward and Backward Slashes

Notice the Address bar in My Computer shows the drive letter followed by 
a colon and a backslash. Folders are also separated by backslashes, which 
indicate your location in the file system hierarchy. An example of a typical 
address would be C:\Program Files. This indicates the computer is using the 
C: drive (local hard disk), in a folder called Program Files, and the window 
on the screen will contain the folders named after programs on the computer 
system hard drive. The files for each of the programs can be viewed by 
opening folders.

The Address bar in an Internet browser such as Internet Explorer uses 
forward slashes to separate addresses. This is done so that the addressing on 
the Internet is unique to the Internet. A typical address would be 
http://sympatico.msn.ca/. Note that http is the protocol (set of rules) used 
by the Internet for web pages. It stands for hypertext transfer protocol. This is 
addressed later in this module.

Complete the following brief review. Your instructor may ask you to complete 
the review individually or as a group or class activity. 

Oral Communication
-listen for

Reading Text
-locate
Command verbs tell 
you to expect an 
instruction.
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Module Four
Section One Review: Online Communication

Nathan works 7:00 am to 3:00 pm and the employee who works 3:00 pm to 11:00 pm shares a computer with 
him. Files that Nathan was working on have been accidentally deleted by his computer mate and not discovered 
before the Recycle Bin had been emptied. Nathan now hides his folders and files that don’t need to be 
accessed by his computer mate so they are not inadvertently deleted. Nathan creates and keeps documents with 
instructions to complete various tasks in his Instructions folder. He needs to read the instructions he created to 
order more office supplies. Outline the process Nathan will use to access the file.
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

You have received an email asking you to read the attachment and make revisions (change, add or delete 
information) that you think will make the instructions easier to follow. Once the attachment is open, you 
discover it is read only and the author is away until tomorrow. Provide the steps you will take to read and revise 
the attachment.
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________

As part of this module, you used some keyboard shortcuts to try them out. Identify three shortcuts you think 
will be the most useful to you. Include the keys used and the actions that resulted.
__________________________________________________________________________________________
__________________________________________________________________________________________
__________________________________________________________________________________________
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Section Two: The Internet

The History of the Internet

The Internet is considered the largest wide area network (WAN) in the world. 
It is also called the network of networks because it connects computers 
around the world. Since no patent was ever applied for, everyone can use the 
Internet.

It grew out of a United States Department of Defense experimental project 
that began in 1969. The project was designed to test the feasibility of a 
wide area (long distance) computer network over which scientists and 
military personnel could share messages and data. The network had to work 
regardless of where the users were or the type of computer they were using. 
It also needed to be able to function even if one or more computers in the 
network were disabled due to partial power outages or in times of a national 
emergency. The proposed solution was to create a network with no central 
authority. 

It was not long before the network originally known as ARPANET expanded rapidly to encompass not only 
government agencies, but also universities and other institutions. From there, single users started to jump on 
board and thus the explosion of the Internet as we know it today.

You can get further data regarding the history of the Internet by doing a search on the Internet itself once you 
have developed the necessary skills.

How Do Computers Communicate?

All computers on the Internet use the same protocols (sets of rules). These 
protocols include specifications that identify and exchange data between 
computers. All computers need to be able to talk to each other and this is 
accomplished by using the Internet protocol called the Transmission Control 
Protocol/Internet Protocol or TCP/IP on each and every computer on the Internet. 
Most computers are not directly connected to the Internet but are connected 
to smaller networks that are then connected through gateways to the Internet 
backbone.

Reading Text

Opening sentences 
introduce the subject.

Paragraph 1 Subject:
Internet intro
Paragraph 2 Subject: 
Internet history
Paragraph 3 Subject: 
Internet users

When searching text, 
scan for keywords in the 
opening sentence.
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The World Wide Web

The World Wide Web (WWW) is not the same thing as the Internet; the 
Internet is hardware-based and the WWW is software-based. 

A web browser is required to connect to and navigate the WWW. The most 
well known web browsers used to “surf” the Web are Internet Explorer,
Firefox, and Netscape Navigator. Web browsers read and translate 
HyperText Markup Language (HTML) code into an understandable 
language that can be read in the browser window. Browsers, unlike other 
programs on Windows, can only understand the HTML programming 
language.

Designing a website (a group of related web pages) is accomplished by using 
various software applications that save HTML and upload it to the web via your ISP. The individual web pages 
are documents on the WWW that display images, associated links (hyperlinks), frames, graphs, and other 
available visual or auditory media. Websites are usually created to interact (link) with each other, in addition to 
containing hyperlinks to outside sources. A website address is known as a Uniform Resource Locator (URL).
Websites can be uploaded to your ISP if you have adequate space available to you. Important note: If you wish 
to make changes to a web page that you created, you must edit it via the program that you created it in, and then 
resave it as a web page with the changes, before uploading to your ISP. When you go to a link (hypertext link, 
hyperlink), you are downloading that page to your system. 

Helpful Hints: Difficulty locating specific web pages may be due to the web page having been updated or 
relocated, the web page server being down (try later to confirm), or the web page being under construction. 

Search Engines

Searching for specific information on the web requires the use of a search 
engine. There are many search engines available. Popular search engines 
include Google, Yahoo!, MSN, and AOL. Some search engines use subject
guides that help you browse general topics. Yahoo! is one of the best search 
engines for searching by subject. Finally, there are metasearch engines or
metacrawlers that send information requests to several search engines at 
once. If you cannot find what you are looking for with a subject guide or a 
search engine, try using a metasearch engine instead to find out if that topic 
is available at all on the Web.These types of search engines are best used to 
find items that are obscure or hard to find. You may also choose to use them 
for detailed searches. Some of the most popular are Mamma, Dogpile, and 
Vivisimo.  

Before reading the 
introductory topics to 
The Internet, revisit the 
Tips and Strategies for 
Reading Text. 
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The Internet Web Browser

The web browser is one of the most important components in accessing the Internet. The following activity 
introduces the basic features of Microsoft Internet Explorer 7, the most commonly used browser in most homes, 
and many businesses.

The instructor told 
us about different 
documents. This 
screen has several 
– an input document 
(search bars), 
simple lists, icons, 
pictures…..
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Internet Explorer Features
  Employment Track Express 

Module Four Online Communication 
80

Item Description 

Title Bar Identifies the program and displays the name of the 
active web page. 

Address Bar Displays address of active web page. 
Menu Bar Displays menu names.  
Home Page The user can change the home page by going to the 

Menu bar and choosing Tools, then Options, and then 
filling in the website address. The default is usually the 
home page of your browser company. The home page is 
sometimes used as a starting point to other web pages, 
known as a portal. 

Standard Toolbar Contains buttons for common commands in Internet 
Explorer. 

Back Button Navigation button used to go back to previous web 
page(s), if you have followed a link(s). 

Forward Button Navigation button used to go forward to previously 
viewed links if back button has been used. 

Tabs Available options. 
Refresh Button Used to refresh a web page. Handy if you are viewing 

statistics that change regularly as it brings in new items 
added since the page was last viewed. 

Stop Button Used to stop downloading a web page if you change 
your mind. 

Minimize, Maximum, 
Close Buttons 

Minimizes screen view, Maximizes screen view, or 
Closes Internet Explorer screen. 

Search Button/Arrow Various other items based on personal choices. 
Links Links (hyperlinks) when clicked will take you to other 

locations on the web. They can take you to documents, 
email addresses, pictures, sound clips, or other media 
clips. You know something is a link when your mouse 
pointer turns into a hand when it hovers over it. 

Status Bar Provides information about site security and about a 
link’s destination as you go over a link. 

Categories Categories of information that link you to other main 
pages in the website. This varies from site to site. 

Horizontal Scroll Bar Allows horizontal navigation of web page via scroll bar 
and scroll arrows. 

Vertical Scroll Bar Allows vertical navigation of web page via scroll bar and 
scroll arrows. 
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Activity 1: Exploring Your Web Browser 

From the Start menu, connect to the Internet. Once connected, open Internet Explorer (Large E) on your 
desktop by double-clicking the icon. Alternatively, you can click on the Start menu on your Task Pane and 
locate Internet Explorer from the shortcuts or from the All Programs menu.

Reminder: You can shrink windows down to the Taskbar and then click the button on the Taskbar to make the 
window active again at any time. Also, you can move your mouse pointer over any icon so that a screentip 
appears to identify the program.

Various toolbars are available for Internet Explorer, via the View menu. To view them, first make sure that 
Internet Explorer is the active window by either double-clicking its icon or clicking its tab on the Taskbar. Then 
follow these steps:

1.    Look at the Title bar at the top of the screen and note the location of the Minimize, Maximize, and Close   
       buttons in the right-hand corner.

2.    Look at the address bar and note the address of the active web page.

3.    Click on the address box down arrow to view a list of recently accessed websites (if there are any). 
   Note: if you click any of these addresses, you will be taken to another site and you will have to 

       click the Back button or Home button to return to your home page.

The web address starts with http, which is the abbreviation for Hypertext Transfer Protocol. A protocol is a 
set of rules for transferring files over the Internet.

Next are the characters :// used for separating the protocol from the rest of the web address. These characters 
were chosen because they had not been used together before in computer applications. 

Finally, there is the domain name (which may or may not include www). The domain name includes: 

•    the organization (the example shows sympatico.msn as the organization); and 

•    the Domain Type (the example shows .ca as the domain type). Top-level domain types include .gov      
     (government), .com (commercial), .net (network), .mil (military), and .edu (education). Most countries 
     have their own domain type such as .ca (Canada), .us (United States), .uk (United Kingdom), 
     and .fr (France).

Some example websites: 

Essential Skills at http://srv108.services.gc.ca
Yahoo at www.yahoo.com
Canadian labour market information at www.labourmarketinformation.ca
Canadian Broadcasting Corporation at www.cbc.ca
Wikipedia at www.wikipedia.org
British Broadcasting Company at www.bbc.co.uk
Imageshack at www.imageshack.us
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Activity 2: Exploring Your Web Browser

1.    Click on the various menus on the Menu bar to see the drop-down menu options available. Move your   
       mouse pointer over the right-pointing arrows that indicate submenu items and view those as well. 
       Identify which options are activated (have a check mark beside them). Also, note the keyboard    
       combinations that can be used for specific commands. Become familiar with available menu items, 
       submenus, options, and commands you can use to explore each item.

2.    Move your mouse pointer over each of the Standard toolbar buttons so that a screentip
       identifies them. Click any arrows available to see additional items for the toolbar.

3.    Move your mouse pointer slowly over the links on the home page and note the various link destinations in   
       the Status Bar. Notice that the mouse pointer changes to a hand with a pointing upward  index finger 
       any time the pointer moves over a link. Clicking any of these links will take you to the location 
       indicated. Remember to click the Back button or Home button to return to the home page.

4.    Click one of the links (your choice) on the home page, and then click on another link on the new web page   
       that appears. The Forward and Back buttons should now become available for use on the Address bar. 
       Try navigating back and forth with these until you have a good understanding of what they are capable of. 

Note: The Back and Forward buttons are grey in colour when they are not available. You can always use the 
Home button to go back to your specific home page.

5.    Once you feel comfortable, click the Home button to return to your home page.

6.    Click the Minimize button in the upper-right corner of the Internet Explorer screen window to shrink the   
       program down to the Taskbar.

Locating a Website

Locating, saving, and printing web pages is introduced in this section. Locating a website on the Internet is 
an easy procedure if you know the actual URL (Uniform Resource Locator). If you do not know the address, 
websites can be located by using a search.
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Activity 3: Locating a Website

To locate a website such as http://www.yahoo.com, type the address in the Address box on the Address bar in 
order to get there via Internet Explorer. 

1.    Make sure that the Internet Explorer program is the active window and that   
       you have your specific home page displayed before proceeding.

2.    Double-click anywhere in the Address box on the Address bar to initiate edit 
       mode and select the existing address.

3.    Type www.yahoo.com (Notice that the http:// is automatically put in by the   
       program).

4.    Press the Enter key on your keyboard to finish the command. This will take you to the Yahoo! home page   
       for the website. Notice the web search box available in Yahoo! that can be used to locate a specific topic. 

5.    Click inside the web search box and type a subject (your choice) to search for. Keep the search subject as   
       specific as possible. Observe the results. Follow the various links by clicking on them. Don’t forget about 
       the Forward and Back buttons that are available on the Address bar.

6.    Once you have explored some of the links, click the Home button on the Standard toolbar in Internet   
       Explorer to return to your specific home page.

Customizing Internet Explorer

Internet Explorer can be customized to individual needs.

Other options and information regarding Internet Explorer can be found in the Internet Options dialog box. 
These options can be accessed by right-clicking on the Internet Explorer icon on your Desktop and then 
choosing Properties, resulting in the Internet Options dialog box appearing. Or access them from within 
the Internet Explorer program by clicking on the Tools menu on the Menu bar, and then choosing Internet
Options which will result in the dialog box appearing. 

Notice there is less 
information text in 
these instructions.
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Following is an example of the Internet Options dialog box.

.

Activity 4: Customizing Internet Explorer

1.    Click the Internet Explorer button on your Taskbar to make sure that it is the active window onscreen.

2.    Click the Tools menu on the Menu bar.

3. Choose the Properties option so that the Internet Options dialog box 
appears with the General tab as the default active tab.

       Note: If the General tab is not the active tab at this point, make it so by  
             clicking on it.

Document Use

The dialog box is a 
document. Note that 
instruction # 4 identifies 
the key words you need to 
locate. Remember to scan 
the document to locate 
them.

4.    Notice the topic headings and the buttons and options available for each 
       topic.

Under the Home Page heading, a new Home Page address can be set 
       by typing in the URL for the site. An example would be
       http://yahoo.com if Yahoo! is the desired home page. If an address is   
       already selected (highlighted), you can replace it by typing at this point. 
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Once you are finished deleting files, click the Close button in the Temporary Internet Files dialog box, then 
click the Close button in the Temporary Internet Files and History Settings dialog box. This will return you 
to the General tab in the Internet Options dialog box.

Click on each of the buttons under the remaining headings of Search, Tabs, and Appearance to see each of the 
dialog boxes and options available. Remember to click on the Close button for each one as you finish perusing 
it until you end up back at the Internet Options dialog box. 

5.    At this point, you should click on each of the additional tabs in the Internet Options dialog box and   
       investigate all dialog boxes and options available, paying particular attention to the Security and 

 Privacy tabs. Again, close any dialog boxes once you are finished with them.

The heading Browsing history provides the opportunity to view settings or delete temporary files, history, 
cookies, saved passwords, and web form information. Click on the Settings button under this heading to bring 
up the Temporary Internet Files and History Settings dialog box. From here you can change settings in 
regards to how these files and settings are handled. 

Click on the View files button to see how many files are there. Select a specific file to delete it individually, use 
the shift or ctrl keys to select multiple files to delete, or just select the Delete all… button at the bottom of the 
Delete Browsing History dialog box. 

Warning: Selecting the Delete all… command will also delete existing saved passwords. 
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Take a look at the following Security and Privacy examples and then complete the last two steps of this activity.

Customizing Internet Explorer 
(Activity 4 cont…)

6.    To complete any changes made on a specific tab, you must click the Apply button; otherwise you can 
       make multiple changes on various tabs and then click the OK button once you are finished with the   
       Internet Options dialog box. The dialog box will close automatically once the OK button is clicked.

7.    Click the Minimize button to shrink the Internet Explorer window down to the Taskbar.

The default settings in browsers are usually set to meet the needs of most users. However, all users should be 
aware of the settings available in order make informed choices to safeguard their systems, themselves, and 
their children from undesired sources. 

Note: Various program commands and options use American spelling. Otherwise, the spelling and language 
throughout this course will adhere to Canadian standards. 
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Browser History and Favorites

Browser History

There are differences between the History list and Favorites list features 
of Internet Explorer. Every time you begin surfing the web, the program is 
automatically tracking where you have been and placing those addresses 
in the History list. You can access a list of recently typed web addresses by 
clicking on the down arrow to the right of the Address box in the Address 
Bar. To get a more detailed list of each website you visited but may have 
not typed in your Address Bar, just follow the steps in Activity 5.

Review the example of the History list in Internet Explorer below and then 
try the next activity.

Title 
Bar 

Address 
Bar History  

Activated 

Home 
Page Menu  

Bar 

Standard 
Toolbar 

Favorites 
Center 

Activated 

Reading Text

Introductory sentence 
identifies differences 
between History and 
Favorites. Set up History 
and Favorites as labels 
on a combined list. Make 
your notes in point form 
underneath the appropriate 
label.
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Activity 5: Browser History

1.    Make your Internet Explorer program the active window.

2.    Click the Favorites Center button (yellow star on the far left). You may also activate it by pressing Alt+C.   
       This will present a new frame window within Internet Explorer. 

3.    In the drop-down menu, make sure History is in view. You can do this by pressing the History icon   
      (green arrow around a small clock). Once pressed, you should see a list of days or weeks you can review,   
      depending on your chosen settings. 

4.    Click the green left pointing arrow to integrate the Favorites Center into your browser window. Observe   
       what happens. You should now have a Close button icon available to you.

5.    In the drop-down menu showing History, click the arrow to show each of the options available.    
       Experiment with each of them to manage your viewing history.

6.    Be sure to return to the By Date option before proceeding to the next step.

7.    Click on each of the icons representing days or weeks to view websites visited during that time frame. You   
       can open or close any of these by clicking on them again because they act just like toggle switches. 
       You are expanding or collapsing the list.

8.    Click one of the website icons to view an actual web page you have viewed on that specific site. Then click  
       on one of web page icons (visually looks like a big E) to go quickly to that particular web page. 
       Notice that the Favorites Center stays active during this procedure because you pinned it.

9.    Click the Back button on the Address toolbar or the Home button on the Standard toolbar to return to your   
       specific home page.

10. Right-click on the actual web page icon that you previously went to in the Favorites Center to bring up   
       the context-sensitive shortcut menu and then choose delete from the available options. This will activate a 
       dialog box asking you to confirm the deletion of the web page. Click the Yes button to confirm the 
       deletion. This will delete that specific web page in your History list.

11.  Next, move your mouse pointer up to the Close button and click on it to close the Favorites Center. You   
       should now be seeing only your specific home page in front of you. The next time you open the Favorites   

Center, it will be the same as you left it—expanded to show the specific web page that you just viewed.

12.  Finally, click the Minimize button on Internet Explorer to shrink in down to the Taskbar again.
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Bookmarking

The bookmarking tool in web browsers is a feature intended for user convenience. This enables you to 
intentionally save website addresses in a list so you can visit them with a click of a button. There are many 
ways to add addresses to Favorites and delete them. Folders can also be created to organize favorite sites 
to make them more manageable. This takes us back to a refresher on the last module, which contained File
Management.

Imagine you have searched the web for a specific topic and finally find the perfect site or page and you wish to 
view it on a regular basis, but you do not wish to save it on your hard drive. This address can be added to your 
Favorites list via Internet Explorer.

Activity 6: Bookmarking

1.    Make sure that Internet Explorer is the active window.

2.    Click on the Favorites tab at the top-center of your browser window. This will bring a drop-down menu of   
       all the websites your browser automatically saved.

3.    Notice that some have the icon of the website already saved to make   
       the link more attractive.

4.    Click on any of the pre-selected favorites and you will see that it goes   
       directly to a specific web page. 

5.    Type a website that you want to go to in the address bar. When you   
       are there, click the Favorites tab on your browser at the top-center 
       and then select Add to Favorites. You have now saved a link 
       to this specific page and it will always remain in your browser for   
       safekeeping. 

6.    You can now type any address you wish and add the web page to your  
       list of Favorites.

Organizing Your Bookmarks

When you have a number of favourites that you would like to either delete or 
put in a specific folder, you can organize them using the Organize Bookmarks function in Internet Explorer. 
A similar function should be available in all browsers. In the next activity, you will explore the easy steps to 
organizing your bookmarks.

Note
1. Instruction “to do.”
2. Instruction “to do,”      
    followed by information 
    “to learn.”
3. Instruction “to learn.” 
4. Instruction “to do,” 
    followed by instruction 
    “to learn.”
5. First three instructions 
   “to do,” followed by   
    information “to learn.”
6. Information “to learn.”
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Activity 7: Organizing Your Bookmarks

1.    Select Favorites from the pull-down menu in Internet Explorer.   
       Choose the Organize Favorites option from the list. 
       This will bring up the Organize Favorites dialog box. Notice the   
       information and various buttons available for use here.

Note: you have to use the Select and Do method to accomplish tasks here. 
Any procedure that you wish to perform with the move, rename and delete 
commands will be done on the selected (highlighted) folder or file. 

2.    Click the New Folder button and type in a name that will identify a        
       group of bookmarks according to a theme. Reminder: The folder is in   
       edit mode when it appears with the default name highlighted - you can
       just start typing.

3.    After you have made a folder, you can begin dragging and dropping website addresses into the folder or   
       you can make a subdirectory of folders by dragging and dropping a folder into another folder. 
       Make sure that your new folder is selected by clicking on it in the list and dragging it with your mouse. 
       This is excellent practice for the drag and drop method of moving folders.

4.    You can also rename a folder very easily. Just click a folder and select the Rename command. You can   
       begin typing in the folder immediately. Don’t forget to click outside in a blank area to complete 
       the command and get out of edit mode.

5.    You can also delete a web page that is in your Favorites list. In the Organize  
Favorites menu, select a web page Favorite to delete and press the Delete

       button in the dialog box. Notice that a Confirm File Delete dialog box  
       appears. Click the Yes button in the dialog box to complete the deletion 
       and watch how the file disappears and the dialog box closes automatically.

6.    Click the Close button in the Organize Favorites dialog box to close it. 
       You should now only see your home page in front of you.

Reading Text

Underline or highlight 
information text. If you have 
difficulty understanding it, 
write it in your own words. 
Check your version with the 
instructor to confirm your 
understanding.
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Saving a Web Page

A web page can be saved in various ways but it is important to know where you are saving it to in the file 
system hierarchy. The next activity will help you to learn the basics around saving a web page. 

Activity 8: Saving a Web Page

1.    Do another search on your own now to locate a page of your choice.

2.    Make sure that the correct web page is in view (website to be saved) and then click on the File menu in the   
Menu bar so the drop-down menu is activated.

3.    Click on the Save As: option, which will then bring up the Save Webpage dialog box.
       This dialog box will look very much like the Save As: dialog box did when you saved a file in the last   
       module.

4.    Click on the down arrow next to the Save In: box to navigate to the subfolder you created within 
       (Your Name) folder on the desktop. Notice how the file system hierarchy always comes into play. Once   
       you are inside the correct folder, continue with the next step.

5.    Click in the File Name: box to select (highlight) the existing text.

6.    Type My First Search Results as the name.

7.    Note the Save as type and Encoding box choices by clicking on the down arrows beside each of them. Do   
      not make any changes here.

8.    Click the Save button to save the page in the desired location and close the dialog box automatically.

9.    Click the Home button on the Standard toolbar to go back to your 
   Home Page.

You have now saved your first web page to a specific location on your hard 
disk so that you can access it whenever you wish.

Reading Text
Two formats for instruction 
and information text.

1. Paragraph containing 
both instruction and 
information.

2. Numbered instructions 
containing information. 
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Activity 9: Printing a Web Page 

Printing a web page can be done quickly and easily just by clicking the print button on the Standard toolbar. 
However, if you wish to choose additional print options, click on the File menu in the Menu bar, then choose 
the Print option, and choose options. Try the Page Setup and Print Preview options available here. To print 
your home page, follow these steps:

1.    Make sure that your Internet Explorer window is active by clicking its button on the Taskbar.

2.    Click the Print button on the Standard toolbar. Your web page will print as long as you have a printer  
       attached to your system as a peripheral device.

3.    Click the Close button in the upper-right corner of the Internet Explorer window to close the program.
       Investigate all of the Internet options and practice using the various communications services and tools 
       that it offers. There is so much to learn by exploring. 

After you have reviewed the contents of Section Two, complete the following review. Your instructor may ask 
you to complete the review individually or as a group or class activity. 
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Module Four
Section Two Review: The Internet

At coffee break, Cathy and Nathan are talking about the Internet. Cathy is quite excited about being able to get 
an answer to a question any time one occurs to her. Complete the conversation below.

Cathy: Where does all this information come from?

Nathan: The Internet connects and collects information from computers around the world. It’s known as the 
largest ______ _______ ______ in the world.

Cathy: Sometimes I have difficulty finding the information I’m looking for when I type in the subject. The 
choice of sites is related to what I want, but it doesn’t provide the full answer. Have you had that happen?

Nathan: Yes, I usually use Yahoo! to search, but sometimes I switch to another search engine or I choose a __
______________ engine that requests information from several search engines at once. When you have trouble 
finding what you’re looking for, try Mamma, Dogpile or Vivisimo.

Cathy: I’m glad the http:// is automatically entered for me in the address bar. It saves a lot of typing. Do you 
know why “http” is used and what it stands for?

Nathan: A browser is used to connect and navigate the World Wide Web, and browsers read and understand 
only one programming language – HyperText Markup Language (__ ___ ___ ___).  __ __ __ __ stands for 
Hypertext Transfer Protocol which is a set of rules for transferring files over the Internet. It tells the computer 
what language to use. It would be similar to someone asking you to do something in a foreign language you 
don’t understand. 

Cathy: I’ve been to some websites and I’ve tried to go back to them but I couldn’t find them. I need to 
remember to write down the addresses of websites I want to keep.

Nathan: You don’t need to do that – just add them to your “Favorites.” When you have a web page you want 
to refer to again, click on “Favorites” on the ________  _______. On the drop-down menu, click on ________ 
_____ ___________ then click “Add.” That way, the website address will always be on the drop-down menu 
when you click on “Favorites.”
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Section Three: Other Communication Services

What else is available on the web? Some other communication services include

•     Chat programs
•     Bulletin boards
•     Video conferencing
•     Interactive games
•     Online banking
•     Online shopping

The capability for communication over the Internet is vast and forever escalating. In everyday life, we strive to 
find quicker and easier ways of accomplishing our desired outcomes. We now live in a world where everything 
is at our fingertips, so to speak. We no longer have to make physical trips to the bank, shopping malls, video or 
game stores, because everything is available to us with just a mouse click, touch, or keystroke, if we desire it. 
Most of the services we will be discussing are able to overlap each other. For example, a chat room can have 
video conferencing capabilities, or a game room can have chat capabilities. This is where the Internet research 
skills that you have gained in this module will definitely come in handy.

It is important to remember safety when using online services. For more information regarding online safety, 
visit http://www.safecanada.ca. 

Chat Programs

One of the most important innovations on the Internet is Chat programs. They are available through various 
services and programs and enable people to communicate in real-time as opposed to through emails that remain 
on the server until the recipient downloads or reads them. 

There are many different types of chat programs. Most allow people to converse back and forth in private, and 
many have options to create or join a private chat room that has many people talking in it. The key to this, of 
course, is the fact that all participants in the chat room are sitting at their computers at the same time, using the 
same communication service. Common chat programs available include MSN Messenger, Yahoo, Messenger, 
ICQ, and AOL. 

Chat rooms usually contain choices regarding the rooms, a current users list that tells you who is in the room, 
a conversation text box where you see the ongoing conversation, and a message text box to type your message 
in. No matter which one you end up using, the basics are the same. You can try downloading a chat program of 
your choice by searching the Internet for one of the programs mentioned above. 
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Bulletin Boards

Bulletin boards are places on the Internet that are used to post information for groups of users with similar 
interests. Bulletin boards are also known as message forums and discussion boards. You have an opportunity 
to join in discussions, and get answers to questions because there are options for you to reply to the postings. 
You usually have to register a username and password to get started. Just start posting questions, joining in 
on discussions, or replying with your own knowledge where you are able. One of the most common users of 
bulletin boards are educational facilities. They use them in order to address many students at once. Try locating 
a bulletin board and have a look around. One of the best ways to find a bulletin board for your interests is 
through a search engine.

Video Conferencing

Video conferencing is a communication tool used by computer users around the 
world to communicate via a video capture device in real-time. While it began 
as a conferencing technique to save money and travel time for business and 
educational facilities, it has quickly become affordable and accessible to all 
users. Using a webcam and microphone, video conferencing allows individuals to 
actually see people who are speaking onscreen and to hear their conversation in 
real-time. With faster Internet connections, live communication has become more 
natural and personal. In the business world, it has enabled people to hold meetings 
with the participants being physically located in different places, but connected by 
audio and video links.

If you have a webcam and a microphone attached to your system, and are using 
a high-speed Internet connection, explore your chat program to see if you can try 
this communication tool. MSN Messenger, Yahoo! Messenger, and AOL all have conferencing abilities. 

Interactive Games

Games of all types are available online that allow users to play and communicate with other people all over 
the world. Many participants become regular users of specific games via their favourite websites. The Yahoo! 
website is noted for many simple, easy to play games and remains quite popular. To see what is available, search 
for Yahoo Games. It’s great practice for new users. 
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Online Banking 

Online banking is available to you from your banking institution so that you can complete transactions over 
the web. You can even manage your bank accounts and pay bills safely and easily. Talk to your bank if you are 
interested in using online banking.

Online Shopping

Online shopping is easy and quick. Online shopping is available all over the world due to the capabilities of the 
Internet. For new users, it’s also a great way to become familiar with your browser and to learn how to make 
online transactions. Go to a major retail store that has an online website. The Bay, Sears, Canadian Tire, The 
Brick, and Walmart all have Canadian websites that you can shop on. Also, stores like Amazon and Chapters are 
successful at delivering products to online consumers. 

Warning: While most of the major retail stores have “secure” sites, meaning your credit card information 
is safe, you should always be very careful when providing personal or credit information over the web. Try 
contacting the retail store through its contact numbers available on its home page and ask about its protection 
procedures.  

Helpful Hints: Most educational facilities have services in place for students to use many of the previously 
mentioned communication tools. The tools are mostly used to help instructors and students converse via email, 
chat rooms, and bulletin boards, and to use online academic and grading services. 
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Section Four: Using Your Internet Service Provider (ISP)

Your Internet service provider can be used for more than just an Internet connection. ISPs usually offer a 
number of services for the price you pay. Most offer email services and web space for you to use so that you 
can upload a web page if you wish. Additionally, they offer self-serve capabilities if you wish to make changes 
to your account with them, and any technical support and service you may require via email or chat. Go to 
the website address of your particular ISP and do a little research on the services that are available to you. Be 
informed and don’t be afraid to ask questions. If you are not satisfied with your particular service, change to a 
service provider who will meet your specific needs.

Exploring Your Email Program

Further exploration regarding your particular email program is encouraged here. Remember that the basics are 
the same for emails as they were for creating and managing favourites or dealing with the file system hierarchy 
- organization and experimentation are key. 

Make sure that you investigate the email options available within your program thoroughly at this point by 
creating new contacts, and then creating groups to put them in. Additionally, you should be able to organize 
your emails to your own specifications by creating any folders you may need.

If you have any problems, you can use the Help menu from your specific program to receive information on the 
specific task you are trying to complete. Help is always available to you in any program by clicking the Help 
menu on the Menu bar. Note that the instructions may vary slightly depending on which email program you are 
using.

You will now be required to complete the module Assignment called Online Communication Assignment. 
As this module concludes, you should be comfortable using a web browser 
and the Internet as a research tool. You are encouraged to try new things and 
experiment until you are completely comfortable using the Internet and its 
capabilities.

You have completed Module Four - Computer Use: Using the Internet. Before 
beginning Module Five, please complete the module test. Your instructor will 
provide the module test. 

Remember to use 
the strategies and 
tips you’ve learned 
in this module when 
completing your test.





Module Five
Computer Use: 

Finding Information
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Module Overview
There are lots of Labour Market Information (LMI) and Essential Skills tools to help you with career research 
and goal setting. These tools will also help you learn about occupations, compare your existing skills to the 
skills you need for specific occupations, and prepare for training or a job search. In this module, you will apply 
computer skills to locate and use Labour Market Information and Essential Skills tools to determine and support 
your goal.

This module will address the following topics:

1.    Labour Market Information (LMI)
2.    Essential Skills Profiles

Learning Objectives
During this module, you will

•    understand the purpose and value of Labour Market Information;
•    locate LMI using a variety of sources;
•    become familiar with Essential Skills (ES) Profiles;
•    search ES Profiles to compare and contrast occupations;
•    integrate ES and LMI information to set an employment goal;
•    identify next steps in your goal path.

A Definition
Labour Market Information (LMI) is information about conditions in, or the operation of, the labour market. 
This information may be statistical or narrative. LMI may talk about the past, the present, or the future state of 
the labour market. 

Particular types of labour market information include data on

•    employment and unemployment;
•    job vacancies;
•    qualifications;
•    compensation and working conditions.

Conclusions can be drawn about what type of work is actually available in different industries in a particular 
location at a particular point in time.

                -from “Making Career Sense of Labour Market Information,” 
Canadian Career Development Foundation
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Labour Market Information is important to job seekers because it provides information about job opportunities, 
skill level requirements, working conditions, and current wage rates. For individuals considering career choices 
– those who have been laid off, those who want to improve their long-term employment prospects or those 
making choices to prepare for entering the labour market for the first time – LMI will include occupational 
options, training and educational opportunities, the current labour market environment, and future trends.

There are many sources of LMI available on the World Wide Web. Both the federal and provincial governments 
maintain Labour Market Information websites, and there are many non-governmental sources of LMI. A 
number of websites are included in this section to introduce you to LMI and to help you gather information that 
will aid you in making decisions about your next steps to finding employment.

National Occupational Classification 

It is important to know that occupations in Canada are classified using the National Occupational Classification 
(NOC), developed by Human Resources Development Canada. 

Occupations are classified using Skill Types and Skill Levels. The Skill Types 
are:

0 Management Occupations
1 Business, Finance and Administration Occupations
2 Natural and Applied Sciences and Related Occupations
3 Health Occupations
4 Occupations in Social Science, Education, Government    

Service and Religion
5 Occupations in Art, Culture, Recreation and Sport
6 Sales and Service Occupations
7 Trades, Transport, and Equipment Operators and Related Occupations
8 Occupations Unique to Primary Industry
9 Occupations Unique to Processing, Manufacturing and Utilities

Skill Types and Levels help to locate specific NOC descriptions. All occupations 
are identified by a NOC code – a four-digit number. The first digit identifies the 
type of skill as listed in the first table above (0 – 9). The second digit identifies the skill level, using the numbers 
that correspond to the Levels. A = 1, B = 2 or 3, C = 4 or 5 and D = 6.

Document Use

Both of these lists 
provide information 
about the National 
Occupational
Classification. They 
describe distinct – but 
different – aspects 
of the NOC, but they 
are connected. When 
presented as a visual 
display, it is easier 
to understand. Your 
instructor will show 
you examples.
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The Skill Levels are:
Skill Level A  1  University education
Skill Level B  2 or 3  College-level education, including apprenticeship
Skill Level C  4 or 5  Secondary school and/or occupation-specific training
Skill Level D  6  On-the-job training usually provided

The NOC code for Machining Tool Operators is 9511. The 9 tells you this occupation belongs to the Skill Type 
Occupations Unique to Processing, Manufacturing and Utilities and the 5 tells you it is Skill Level C which is 
Secondary school and/or occupation-specific training.

The National Occupational Classification is one source of LMI. Its website provides Occupational Descriptions 
that include Example Titles for the occupation, Main Duties, Employment Requirements and Additional
Information. Some of the LMI sources included in this section identify occupations, using NOC codes.

Activity 1: 
Finding National Occupational Classification Descriptions

1.    Type http://www23.hrdc-drhc.gc.ca into the browser address bar and go to the National    
       Occupational Classification website. Click on “English.”

2.    Next, click on the book cover identifying “Occupational Descriptions.”

3.    In the left-hand sidebar, click on “Occupational Descriptions.” Find the 
       occupational description for your most recent job.

You will see the listing of Skill Types identified above. Click on the underlined 
description that describes the occupational group or “sector” you were employed 
in. This takes you to a listing of the major groups of occupations within that 
category. Note that the first number in the listing of NOC codes is the same 
as the number preceding the Skill Type. The second number identifies the 
Skill Level as identified in the Skill Level table presented above. Using this 
information, scroll down the page to find the occupational title of your previous 
job.

Read the information in the description. There may be differences between 
this information and your experience in the job. These descriptions are general 
descriptions - a summary of information about the occupation from across 
Canada. Print and add the occupational description to your manual. You will 
return to this site in the Essential Skills Profile section of this module. ES Profiles 
are catalogued using this classification system.

Labour Market Information is available about the job you had and other jobs 
you may be interested in knowing about. By visiting LMI websites, you will find 
information to determine what you need or want to do as “next steps.” Bookmark 
these websites, as you will be using them again.

Reading Text

Remember
– information and 
instructions are often 
mixed together.

Document Use

Sidebars are usually 
lists describing the 
contents of other pages 
on the website. They 
may be presented 
in various formats 
– bullets, numbered, 
“click” buttons, etc. 
Often the description is 
a hyperlink to the page.
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Activity 2: 
Exploring the Federal Government Labour Market Information 
Website

1.   Type http://www.labourmarketinformation.ca in the browser search bar, and click on “English” when the   
      page opens.

2.   Read the selections in the left-hand sidebar and choose sections to explore, based on the descriptions below.   
      Be aware that information is not available for all occupations or NOC codes. Be sure to choose the 
      geographical area that describes where you live or want to work.

Newsflash – will return a result only if there have been recent events affecting the labour market.

Build Your Occupational Profile – available for some occupations. Provides lots of information, including 
employment prospects and wages/salaries.

Job Descriptions – Available job descriptions are based on information from the National Occupational 
Classification.

Job and Skill Requirements – Information is from the NOC.

Employment Prospects – Not all occupational titles or NOC codes will return information. Try NOC 9511. 
Try the occupational title Cook. The returned information for Cook is detailed and includes links to additional 
information.

Wages & Salaries – These pages provide wage information on selected occupations in local communities.

Numeracy

This is a measurement 
and calculation task. 
You are not “moving” 
money. You are 
calculating how much 
money you need 
to cover your living 
expenses.

Do you know what salary or hourly wage you need to cover 
your living expenses? Total your monthly expenses for 
mortgage/rent, taxes, utilities, food, childcare, transportation, 
etc. Add 30% (average) for federal and provincial taxes. This 
is the monthly salary you require. Multiply by 12 to determine 
the annual salary you require. To determine the hourly wage 
divide the annual amount by 52 wks. Divide this amount by 
40 hrs.

Often the date of the last update is included at the bottom of web pages. Take note of this date as many web sites 
are updated over a 1 to 5 year cycle. (The National Occupational Classification System is updated every 
10 years or so.) You will need to think about events you are aware of since the last update that may impact 
the information on the web page. For example, if you were searching for labour market information about 
manufacturing in 2008 and a website hadn’t been updated since 2006, you would need to use Critical Thinking 
skills to evaluate the information to identify strengths and weaknesses and make a judgement about the value or 
applicability of the information.
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Potential Employers – This section provides a listing of potential employers in your area who have agreed to 
provide information. The results will depend on the occupational area you are seeking information about.

Where to Get Training – Information returned depends on the occupation you ask about. It will show where 
you can go locally to get training.

Compare Occupations –This feature is available for a limited number of occupations and requires that you 
have located the NOC code or occupational title prior to reaching this page.

About the Local Labour Market – Clicking on this option provides three choices of information – Labour 
Market Bulletins (usually quarterly), Annual Labour Market Perspectives (if available) and Community 
Information. Some areas will include the Labour Market Bulletin only.  

http://www.jobfutures.ca – This website provides information about 265 occupational groups. On the left-
hand sidebar, occupations can be searched alphabetically, by interest, by NOC code and by work prospects. If 
you’re not sure what occupation you are interested in, you can complete a quiz and get a list of occupations that 
match your results. 

In 2007, Human Resources Development and Social Development Canada (HRSD) published a report titled 
“Looking-Ahead: A 10-Year Outlook for the Canadian Labour Market (2006-2015)”.  

Activity 3: Comparing Areas of Employment Growth

1. Type http://www.hrsdc.gc.ca/en/publications_resources/research/categories/labour_  
      market_e/sp_615_10_06/pageoo.shtml into the address bar.  This is a long and complicated address  
       and must be entered accurately.  Alternatively, type “Looking –Ahead: A 10-Year Outlook” into the 
       search bar, and click on the name of the publication that appears as a hyperlink..  This will take you 
       to the contents page.

2.    Click on “Ten-Year Outlook for the Canadian Labour Market (2006-2015).”  This section of the report   
       provides information about areas of the labour market that are expected to experience growth.

3.    Compare the information about Employment Growth by Industry and Occupation and Labour Force by        
       Education and Skill Level to your own circumstance. Are employment growth areas of interest to you?  
       Do you have education or skill background associated with these types of industries or occupations?
       Are there employment opportunities in these areas in your community? Are you interested in training or   
       education to prepare for these kinds of occupations? Skim the contents page to find other sections of this 
       report that may be of interest to you.

 More information about some of these occupational areas will be helpful to deciding your employment goals.

http://www.hrsdc.gc.ca/en/publications_resources/research/categories/labour_market_e/sp_615_10_06/pageoo.shtml
http://www.hrsdc.gc.ca/en/publications_resources/research/categories/labour_market_e/sp_615_10_06/pageoo.shtml
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Activity 4: Exploring Job Futures

1.   Type http://www.jobfutures.ca into the browser address bar and go to the 
      Job Futures website. Click on “English.”

2.   Use the NOC code from the occupational profile of your last job to conduct   
      a search. Click on the tab “I want to be” and then click on “NOC Code.”

3.   Under “Browse Occupations by National Occupational Code,” click on “By 
      NOC Code.” 

4.   Scroll down the page until you find the first three to four digits of the NOC  
      code you are looking for and click on it.

The first page identifies “Occupation Title At a Glance” and provides basic 
information on earnings, employment outlook and average unemployment. 
You will also see information about the impact retirement will have on 
occupational opportunities. Move your cursor over the page to see all of the 
information you can read about the occupation. Spend some time exploring the 
information about your previous occupation. Recognize that this information is 
available for all occupations listed on the website. Once you’ve finished reading 
the information about your previous occupation, use the sidebar to find an 
occupation you have an interest in or have wondered about.

Document Use

This website uses 
many different types 
of documents – lists; 
circle, bar and line 
graphs; and symbols 
and icons.

Reading Text

Text is used throughout 
the website to provide 
information that is not 
easily displayed in 
another way.
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The first two websites you visited were developed and are maintained by the federal government. The Ontario 
government also maintains an Ontario Job Futures website in partnership with the federal government.

Activity 5: Ontario Job Futures Website 

1.    Go to http://www.ontariojobfutures.ca and click on “English.”

2.    Enter the occupational title from the NOC Profile of your previous job and click enter, OR click on    
      “Occupational Job Family.” Scan the page to locate the occupational family you are looking for and choose   
       it. Then scan the page to find the appropriate NOC code and choose it. Scroll down the page, making note   
       of the additional information that is available. Be sure you have bookmarked this site. You will need to 
       return to it later.

3.    Return to the top of the page and click on “Employment Trends.” 
       This page provides valuable information to help you understand 
       various aspects of LMI that may have an effect on your future 
       employment decisions. Information on why jobs change over time, 
       where the jobs are by sector, emerging occupations and industries, 
       and educational and skill requirements for today’s jobs are all factors 
       you need to consider in making your employment decisions. 
       This may be a page that you will want to print to review and reflect on as    
       you go through the decision-making process.

You will also want to know where to look for the job you are seeking – now 
or in the not-too-distant future. Your personal network – family, friends, and 
colleagues – can be a useful source of job opportunities. Local, regional and national newspapers and journals 
are often a source of job leads. There are also local programs and services to support you in your job search. 
These programs can be found on the Employment Ontario website at http://www.edu.gov.on.ca. 

There are many websites that provide job postings, and some allow you to put your resume and information 
online for employers to search. It is important to be aware before you post your resume that anyone with 
Internet access may see your resume. Carefully read the information on the website before you submit your 
personal information.

One of the best known and most used job posting sites is the federal government “Job Bank.” Activity 6 will 
give you an opportunity to browse the Job Bank.

LMI seems to have its 
own jargon. Should 
I add some of these 
terms to my glossary?
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Activity 6: Job Postings on the Internet

1.   Type http://www.jobbank.gc.ca into the browser address bar and click on “English.”
      Note: You can advertise your job profile on this site. Both employment seekers and employers are required         
      to set up an account in order to use this feature. Both parties must use a log-in and password to access the   
      service once the account is set up.

2.   Click on the hyperlink “Job Search,” then click on Ontario. You will see several criteria that you can use to   
      narrow your search. 

3.   Choose criteria in each section. Conduct a search from this page, or click “Advanced Search” to further       
      narrow your search with additional criteria. Complete this search page by selecting criteria that match 
      your previous job. 

4.   Click “Advanced Search” and complete the search.

Other job posting websites worth visiting include

•    http://www.workopolis.com
•    http://www.jobpostcanada.com
•    http://jobport.ca
•    http://www.gojobs.gov.on.ca (Ontario government job postings)
•    http://jobs-emplois.gc.ca (Canadian government job postings)
•    http://www.nicejob.ca

These are just a few of the many job posting sites available. Do an Internet search to find more.
Remember to protect your personal information. Check privacy statements carefully before you post 
information.

This section introduced you to some sources and types of Labour Market Information to help you make 
decisions about your next steps. There are many sources and types of information that you may be interested 
in following up on that are too numerous to include here. To find and browse other Labour Market Information 
websites, conduct an Internet search using the term “Labour Market Information” and “Jobs.” Also remember 
that staying up-to-date with current events in your community is a form of LMI.

There was a lot of 
information here that I 
may want to find later…..
hmm…that’s one of the 
Thinking Skills – Finding 
Information!
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Essential Skills Profiles

In Module One, nine Essential Skills used in all Canadian occupations 
were identified and defined. Essential Skills Profiles describe how each 
of these skills is used in a particular occupational family. In Canada, 
occupations are catalogued using the National Occupational Classification 
(NOC), and every occupation is given a NOC code. Essential Skills 
Profiles are also catalogued using the NOC system and codes.

All Profiles are presented using the same structure. 
The components of a Profile include:

1.    NOC Code
2.    Occupational Title
3.    Occupation Description
4.    List of Most Important Essential Skills
5.    List of Task Examples
6.    Complexity Ratings for Task Examples

 7.    Skills Summary Profile
8.    Other Information
9.    Related Links

Open the Internet and enter http://srv108.services.gc.ca in the address bar of your Internet browser. 

Employers are becoming 
more and more interested 
in the actual skills that are 
required to do a particular 
job, so they are paying 
more attention to Essential 
skills.

Bookmark this page and name it ES Profiles. You will be visiting this page several times.

Activity 7: Essential Skills Profiles

1.   Click on English. This will take you to the Essential Skills home page. There is a sidebar on the left-hand   
      side of this page, with several topics listed.

2.   Click on Essential Skills Profiles. Use the scroll bar on the right-hand side of your screen to scroll to the   
      bottom of the page.

3.   Under For more information, follow the links below, and click on Search the Profiles. You will see a new   
      page, which lists six ways the profiles can be searched – by Occupation, Keyword, Most Important Skills, 
      Skill Levels, NOC, and Advanced Search.

4.   Click on National Occupational Classification (NOC). You will move to a new page titled 
Search by Occupation.
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5.   The cursor will be blinking in a box that requires a NOC code. In order to view a Profile using the National         
      Occupational Classification (NOC), a four-digit NOC code is required. Enter the NOC code of your last   
      employment and click “next.” Now you will see a page that lists the number of records that match the 
      code you entered, the occupational title that matches the NOC code and a choice to view the entire Profile. 
      If the search did not retrieve the Profile you wanted, you can start a new search by clicking on 
      “To search again, click here.” 

6.   Open the Profile by clicking on “View Entire Profile.”
      Notice that the Profile begins with the NOC occupational title and code. The code is in blue font and     
      underlined which means it is a hyperlink. Profiles contain lots of hyperlinks to background information. 
      For example, the NOC code is in blue font and underlined. 

7.   Click on the NOC code. This will take you to the NOC description for the NOC code you entered. Notice   
      that you have moved to a new website – the website for the National Occupational Classification. 
      The paragraph under the NOC code and the occupational description describes the occupational family. 
      This paragraph is always the Introduction to an Essential Skills Profile.

8.   Scroll down the page as a reminder of what you learned about NOC in the   
      section on Labour Market Information. Under the heading Example Titles is a   
      list of titles within the occupational family. Usually, there are too many titles 
      to list them on one page, so there is a hyperlink to view the full list of titles.   
      The NOC title is used to identify the occupational family in general, 
      and the Example Titles list includes titles commonly used within the group. 
      This list is not exhaustive. There may be other titles used in specific businesses 
      or regions of the country.

9.   Continue scrolling down the page and note the information provided about the 
      occupations – Main duties, Employment requirements, Additional information and Classified

 elsewhere. These sections provide more information and background about the occupation. 
      This information helps you to describe the work you have done and compare your work experience to other 
      job opportunities.

Main duties describe the most significant duties of the occupations in the group. Employment requirements 
describe prerequisites generally needed to enter the occupations in the group (e.g., level of education, specific 
training, licenses or other credentials).

Additional information provides information that may clarify the occupational description, including 
progression in the occupation, mobility, and trends.

Classified elsewhere identifies similar groups or occupations classified under a different NOC code. These 
occupations are usually identified and can be viewed by clicking on the hyperlinked NOC code.

Reading Text

Information and 
instruction is mixed 
together.
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The information in Occupational Descriptions can be used to confirm the 
right Essential Skills Profile. Occupational titles may not have provided 
enough information to determine whether the occupation is one you have been 
employed in or that you wish to find more information about. If you are unsure, 
click on some of the occupations in “Classified Elsewhere.” By connecting 
to other occupational descriptions that may have similarities, you may find 
the occupation you are looking for. Occupational descriptions help you to 
understand the work performed in the occupation and to determine the normal 
requirements for entry to the occupation.

10.    Use the back arrow to return to the Essential Skills Profile. Note that you  
         have returned to the Essential Skills website. Use the scroll bar on the 
         right-hand side of the window to move through the components described 
         below.

The next component in a Profile is most important Essential Skills. The most important Essential Skills are 
presented in a short list below this hyperlink. Although all Essential Skills are used in virtually all occupations, 
this list identifies the skills that are the most defining for the occupation. This information is useful when 
comparing occupations. The most important Essential Skills hyperlink also helps you identify skill areas you 
may want or need to acquire or strengthen.

Sections on each of the Essential Skills follow this component. Each skill section uses the same structure, with 
the headings Essential Skill Name, Tasks, Complexity and Examples.

Tasks are described as Typical – tasks that are required by all workers in the occupation, and as Most Complex 
– tasks identified by workers as the most difficult but not necessarily performed frequently.

Complexity describes the level of difficulty at which the specific skill is applied. Complexity levels were not 
applied to all skills when ES profiling began, but for those that were initially measured using complexity levels, 
a scale of 1 to 4 or 5 is used. Complexity scales have been developed for Critical Thinking, Working with 
Others and Continuous Learning and are included in more recently developed Profiles. The Complexity column 
provides the range (e.g., 1 to 3, or 2 to 3) of complexity levels at which the skill is applied in this occupation. 
Complexity levels can be used to compare occupations and to compare an individual’s skills against occupational 
requirements.

Reading Text
If you are interested in 
learning more about 
NOC, take the NOC 
tutorial on the website. 
An online training 
manual with quizzes is 
available. You can even 
get a certificate for taking 
the training!

Essential Skills complexity levels are a new way to think about levels. They are not 
the same as grade levels. Complexity levels are used to rate the level of difficulty of a 
particular task, with Level 1 being the least difficult and Level 5 being the most difficult.
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The list of Examples describes how that skill is applied to tasks performed by 
workers in that occupation. Each example includes the complexity level of the 
task in brackets at the end of the description. Examples are ordered from the 
lowest to highest complexity level. The examples help to understand the work 
that is performed by workers in the occupation and can be used to determine 
interest or gain further understanding of the occupation. These examples 
are also useful to identify tasks you have experience with, think you could 
perform or would need to learn more about before performing the task.

A Skills Summary component is provided for six of the nine skills – Reading 
Text, Document Use, Writing, Numeracy, Oral Communication and Computer 
Use. The Skills Summary uses standardized descriptions of applications, skill 
foundations or purpose for applying the skill (e.g., writing a short reminder 
note for yourself, reading to locate information or constructing a chart). This 
section of the Profile can be used to understand the transferability of skills 
from one occupation to another. For instance, in your most recent job you may 
have been required to read the full text to understand or learn - using manuals, 
specifications or regulations. Another occupation you are interested in also 
requires this skill. Reading Text (to understand or learn) and using manuals, 
specifications or regulations “transfers” from one occupation to the other. 
You should incorporate transferable skills into your resume or into an 
interview to demonstrate your skills.

The Other Information component of the Profile includes sections about 
Physical Aspect, Attitudes and Future Trends Affecting Essential Skills specific 
to the occupation.

Related Links connects you to the Job Futures website, using a hyperlink.

Spend some time exploring this Profile. You will become familiar with the content and the type of background 
information available by clicking on hyperlinks. Use the back arrow to return to the first page of the Profile.

  Reading Text

When reading to 
learn or understand, 
remember to pause to 
think about what you’ve 
read.

•   Read difficult       
    paragraphs one   
    sentence at a time 
    and reread 
    sentences that are 
    not clear.

Are my Essential Skills 
scores where I’d like 
them to be? Should 
I consider training to 
refresh or upgrade 
them?



Employment Track Express

139Module Five            Computer Use: Finding Information

Activity 8: 
Essential Skills Profiles and Your Essential Skills Scores

1.   Use the back arrow until you return to a page with a sidebar on the left-hand side or click on “Home” in the   
      bar at the top of the page. Click on “Essential Skills Profiles.” 

2.   Once the page opens, scroll to the bottom and scan for “List of all profiles” and click on it. You will see the   
      list of all completed Essential Skills Profiles, presented as a list of occupational titles, arranged 
      alphabetically and followed by the NOC code. Profiles can be opened and viewed by clicking on 

 “View Entire Profile.” 

3.   Scroll down the list of Profiles to find the Profile for your most recent employment. Open the Profile and   
      confirm that it represents your last position.

4.   Print the Profile of your last employment position and put it in your binder. If you are unable to find the   
      Profile for your most recent employment, ask your instructor for assistance. Compare the complexity levels 
      for Reading Text, Document Use and Numeracy on the Profile to your Essential Skills assessment results.

Do your Essential Skills scores match those on the profile? Are your scores higher or lower? Look at the 
examples for each of these skills in the printed Profile. Did your previous job require you to perform the 
tasks identified at the highest level? Not all positions will perform all tasks identified in the Profile. In some 
organizations, these tasks might not have been required or they may have been performed by someone in 
another occupation. They may also have been accomplished as a team, with no one person being expected to 
complete the task in its entirety. A skill level score below the Profile level does not mean you cannot perform 
the task at all. It is an indication that you could strengthen or improve the skill so you can use it accurately and 
efficiently more often – at work, in learning and in life.

Document Use is usually the lowest score. This is because we tend to only learn to use those documents we see 
on a regular basis. The structure of documents is not a topic often taught in school, and the type and number of 
documents we are faced with grows daily. Once you are familiar with the structure of documents, using them 
becomes much easier. You will also be able to figure out how to use new documents you may be faced with.

Highlight or underline the task examples in Reading Text, Document Use and Numeracy that are at a 
complexity level higher than your Essential Skills assessment score. Put a star (*) at the end of any underlined 
or highlighted task examples that you were not required to perform on your last job. As you continue to work 
with Profiles and consider Labour Market Information, this information can be useful in deciding whether or not 
you want to work on these skills.
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Activity 9: Searching Profiles 

Profiles can be searched in six ways: by Occupation, Keyword, Most Important Skills, Skill Levels, NOC, and 
Advanced Search. 

1.   Return to the Essential Skills Profiles page either by using the back arrows or by clicking on “Essential   
     Skills Profiles” in the left-hand sidebar. 

2.   Scroll to the bottom of the page and scan for “Search the profiles” and click on it. Try searching the Profiles  
      using an Occupation search and a Keyword search.

The Advanced Search can be used to search Profiles using criteria from components of the Essential Skills 
Profiles such as most important Essential Skills, Essential Skills Levels and Skill Summaries. In this exercise, 
you will use information from the Profile of your last position, which you printed out earlier.

3.   Return to the Essential Skills Profile page by using the back arrow or   
      clicking on “Essential Skills Profiles” in the left-hand sidebar.

4.   Scroll down the page, scan for “Search the profiles” and click on it. 
      Click on “Advanced Search.”

5.   Click the box beside “Most Important Skills,” and scroll down and click 
      the “Next” box.

6.   Using the Profile from your last position, identify and click the boxes that  
      match the most important skills on the printed profile. Scroll down 
      and click the “Next” box.

This should present you with a list of Profiles that will include one or more of 
the most important skills you identified. Scroll down the list of occupational 
titles and write down the title and/or NOC code of Profiles you might be 
interested in knowing more about. This is a list you will add to as you do other 
searches and collect more information. There will be an opportunity to review and 
consider these Profiles later on.

7. Return to the Advanced Search page using the back arrow. Click the boxes for the three Essential Skills you 
completed an assessment of: Reading Text, Document Use and Numeracy (Math), and click “Next.”

8. The next page presents the Reading Text skill levels, purpose of reading and text types for searching. Only 
the level will be used in this search. Click on the Reading Text level that matches your score and click “Next.”

9. The next page presents the Document Use skill levels and purpose for searching. Only the level will be used 
in this search. Click on the Document Use level that matches your score and click “Next.”

  Finding Information

is one of the Thinking 
Skills. Finding ES 
Profiles to review 
occupations and ES 
levels is useful for 
many applications: to 
find out more about an 
occupation, to prepare 
for an interview, to 
identify skills gaps you 
may want to address, or 
to understand how ES 
are used in particular 
jobs.
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10.   The next page presents the Numeracy skill levels for each of the types of math applications. Click the   
        circle for B under each application, indicating “Search by complexity level,” and click “Next.”

11.   On the next page click the level identified on your score for each math application, and click “Next.”
        You should now see a list of Profiles. If you don’t see a list of Profiles, let your instructor know right away.   
        The Profiles will include task examples for each skill and level you requested. You can choose to view each  
        Profile individually or view only task examples for the requested skills and levels. The Profiles may 
        include task examples both at lower and higher levels than your search request. 

12.   Scroll down the list of occupational titles and add the title and/or NOC 
        code of Profiles you might be interested in knowing more about to the list  
        you started in the previous activity. (Add these to the list you started 
        in the previous activity.)

13.   From the list of Profiles on the computer screen, you are able to view   
        example tasks in the Essential Skills identified in the search by clicking  
        on “View Examples.” Try it.

14.   Use the back arrow to return to the list of Profiles. Now click the box   
        in front of 2 or 3 Profiles on the list, or click the box “Select all profiles,”  

and click “View Example(s).” This will show you example tasks from
        Essential Skills Profiles listed in your search results.

15.   Open each of the Profiles you are interested in, one at a time, by clicking on “View Entire Profile” in   
        the list. Click on the blue, underlined NOC code. This will take you to the occupational description. Scroll   
        down and read the Main Duties and Employment Requirements. After reading this information, does the 
        occupation still have your interest? Do you have the employment requirements? Are you interested in 
        acquiring the requirements? Use the back arrow to return to the Profile for this occupation. If you 
        decided after reading the NOC information that you are no longer interested in this occupation, use the 
        back arrow again to return to the list and select another occupation, and stroke this occupation off the 
        hand-written list you created. If you are still interested in this occupation, read the task examples for each 
        of the Essential Skills. They will provide more detailed information about the work that is performed by 
        people in this occupation. If after reading this information you are still interested in the occupation, 
        put a check mark beside it on your hand-written list. If you are no longer interested based on the 
        information you have read, cross this occupation off your list. Repeat this process for each of the 
        occupations on your list. By using your back arrow, you can continue to return to the list you created 
        using your Essential Skills assessment score.

After completing a review of the Profiles matching your Essential Skills assessment score, you will have 
other Profiles you listed as a result of a search using the most important skills from the Profile of your last 
employment position. At this point, if you haven’t left the website since conducting that search, you can return 
to the list by using the back arrow several times. You can also choose to conduct the search again. The other 
alternative is to search the Profiles using the individual NOC codes from your hand-written list. Before you 
make the decision to use a particular method, consider some of the reasons why you might choose one over the 
other.

  Writing

Document the profiles 
you are interested in 
to help you remember 
which ones to read more 
fully.
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Consider:

Returning to the original list will save time and the list will be presented in a format you will recognize. 
You will be able to choose task examples from more than one profile and read all of them by scrolling down 
the page or choosing them individually. Choosing Profiles individually from the search list will allow you to 
link to the NOC to review the Main Duties and Entry Requirements of the 
occupation. You will be able to choose between reviewing example tasks from 
individual Profiles or reviewing all tasks using Essential Skills identified in the 
original search from all of the occupations you checked.

Conducting the search again will provide the above benefits and will add to 
your experience and comfort in conducting an advanced search. It will also 
add some time to completing the exercise.

Choosing to search for the Profiles by NOC code will increase your 
experience and comfort in searching Profiles by NOC code. You will be able 
to link to the NOC description to review the Main Duties and Entry 
Requirements and read the sample tasks associated with each skill to 
determine whether you are interested in the occupation. Conducting 
individual searches will take considerably more time than the above two 
options.

Choosing among the options above is a Decision Making task. Once you 
have arrived at a decision as to how you will read and review the Profiles 
listed in the first search, review the Profiles and stroke off those that are 
no longer of interest to you, or put a check mark beside those that are still 
of interest.

You should now have a list of ES Profiles describing occupations that you are interested in. If the list contains 
10 or more Profiles, rank the top five Profiles of interest to you, and the top five may be in addition to the Profile 
for your most recent employment. (The process can be completed again with other or new occupations, but 
working with more than five Profiles makes it difficult to compare and contrast information.)

The Profiles, NOC Main Duties and Employment Requirements provide you with information that will help you 
identify your next steps. However, you will need more information in order to make informed decisions about 
the path you choose. You may also consider the following variables:

●    wage/salary associated with the occupation
 ●    employment prospects in the occupation
 ●    skills and education or certification required for the occupation
 ●    training or education to meet entry requirements
 ●    methods to acquire the training or certification required
 ●    length of time to acquire the entry requirements
 ●    local employment opportunities in the occupation

  Decision Making

requires making a 
choice from among 
options.

  Critical Thinking
involves evaluating 
information and referring 
to objective criteria 
to reach a judgement 
about value, or to 
identify strengths and 
weaknesses.
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Assignment:
Using Labour Market and Essential Skills Information

(Complete the assignment as a group with the help of your instructor so that information can be shared and 
discussed.)

On the following page is a chart to complete so that you can compare jobs by using occupational criteria. 
Occupations should be ranked from 1 – 6, depending on the number of occupations you are considering (if you 
are only thinking of five occupations, you would rank them 1 - 5). Repeat this process if the occupations you 
identified don’t meet your interests, wage requirements, employment prospects, etc.

In order to complete the chart, you will need to return to websites introduced earlier in this module, including 
both LMI websites and the Essential Skills website. Return to the appropriate sections of your manual for 
addresses and instructions. If you have difficulty completing the chart, ask your instructor for help.

The first occupation in the Occupational Title column should be the most 
recent job you were employed in. Use the Occupational Title and NOC 
code from the National Occupational Classification or Essential Skills 
Profile (they are the same). For your most recent occupation only, divide 
the Reading Text, Document Use and Numeracy boxes in half using a /. 
In the upper half, enter your ES assessment level, and in the lower half 
enter the level from the Profile. Use your earnings from your last position 
to complete the Wage/Salary column. Complete the Essential Skills 
requirements for the occupation from the Essential Skills Profile. (You 
printed out the NOC Occupational Description and Essential Skills Profile 
and put them in your manual earlier.) Remember that the ES level for each 
skill is the highest level in the “Typical” range. Circle or highlight the most important Essential Skills. Enter 
“NR” if a skill level is not reported on the Profile. Return to LMI sites to complete the additional columns. 
Leave the ranking column blank.

  Document Use

Documents may be used 
to locate and interpret 
information or to input or 
collect information.
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Repeat these steps for each of the top five occupations you identified during various searches. Go to the Job 
Futures website and complete the Wage/Salary, Entrance Requirements and Employment Requirements. 
Additional information you may want to keep track of should be entered under “Additional Info” on the chart. 
Be sure to enter this information on the line numbered to correspond with the position of the occupation in the 
chart. Rank the occupations 1 through 6, based on criteria that is important to you – entry requirements, wages, 
your Essential Skills levels matching those of other occupations, etc. 

Now that you have ranked occupations of interest to you, additional local LMI information may be available to 
help you make decisions. Another set of web pages that will be of interest includes the top five occupations by 
the top five industries. 

This information can be searched by community from
http://www1.servicecanada.gc.ca/en/on/lmi/llmi.shtml

1.   Once logged on to this page, choose the community that best represents where you live and/or want to work. 
      This will show you information about the labour force by largest number of workers in the 
     top 5 occupations by top 5 Industries, using data from the 2001 census. This is good information,   
      but does not include all occupations with good employment prospects, good wages and stable employment   
      opportunties. 

2.   Use your back arrow from this page and then choose Wages by Occupation. The date of the data collection       
      is also noted. How does this information compare to the information you found on the Job Futures 
      pages?  Which information is more current? 

3.   Use your back arrow from this page and choose Labour Market Bulletin. Labour Market Bulletins provide   
      more local information about new businesses, hirings and lay-offs in and around your local community, by   
     “quarter” (3-month periods). The first page is an overview, and you must choose the hyperlink Labour 
      Market Bulletin again at the bottom of the page to read the entire document. What information is of 
      particular interest or value to you? Does the information in the Bulletin contradict (is significantly 
      different than) information you previously found? Are you aware of newer information that may 
      impact the information you’ve found? If you found additional information relevant to the occupations 
      on your list, be sure to add it your ES and LMI chart.

4.   Check the current local job opportunities for these occupations by conducting searches by occupational title   
      on the Job Bank: http://www.jobbank.gc.ca. Make a note of the number of job opportunities for 
      each occupation in Additional Info.

The completed chart can now be reviewed to compare ES and LMI information across occupations. Participate 
in the group discussion using the information on your chart to consider some of the comparisons below:

•    ES levels across occupations
•    your Reading Text, Document Use and Numeracy skills against   
     occupations
•    wages
•    entry requirements
•    employment prospects

  Critical Thinking 

involves referring to 
objective criteria
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Similarities in some of these criteria will support developing a goal that may include more than one 
occupational target. Review the ranking of the occupations based on the group discussion. The next step is to 
narrow the occupational choices to one or two and to determine the next steps you need to take in order to move 
towards the occupational goal. You will need to apply Thinking Skills – Problem Solving, Critical Thinking and 
Decision Making – in this process.

You may require help or support to

•    further define your goal (career counselling)
•    locate sources of full-time, part-time or online education or training
•    develop job search skills, prepare a cover letter and resume, or develop interviews skills.

The Employment Ontario website is a source for all these services in your local community:

http://www.edu.gov.on.ca (click on “English,” then on “Employment Ontario” in the main heading text 
box).

Complete the Action Plan on the next page, based on your goal 
occupation(s). Describe what steps you will take and set a target date. This 
will help you focus on what you need to do, by when, and help you move 
towards your goal. This is also an application of Thinking Skills – Job Task 
Planning and Organizing.

In the next module, you will learn how to use a computer to create 
documents such as cover letters and resumes, and you will learn how to 
attach them to an email to send them to an employer.

There’s a lot to think 
about in developing an 
Action Plan.
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1.   Meet ES Levels

� No action required  � Locate ES training  � Register in ES training
__________________________________________________________________________________________
__________________________________________________________________________________________

2.   Meet Entry Requirements

� No action required  � Locate appropriate training  � Register in training

    
__________________________________________________________________________________________
__________________________________________________________________________________________

3.   Cover Letter and Resume Prepared

� No action required  � Able to prepare without  � Locate and register
        help or support      with support service
__________________________________________________________________________________________
__________________________________________________________________________________________

i.e., full-time, part-time, online,
upgrading, technical or vocational

Action Plan

This form is designed to help you identify next steps and set target dates to achieve them. Check the appropriate 
boxes. In the space provided, write a brief statement to describe what you will do and the date by which you 
will have done it.

 Place a � or  to indicate et er you meet t e criteria  
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4.   Have Interview Skills

� No action required  � Locate and register with support service
__________________________________________________________________________________________
__________________________________________________________________________________________

5.   Identified Job Opportunities

� No action required  � Register with online job  � Locate and register
         posting service        with support program or
                         service (e.g., Job Finding
              Club)
__________________________________________________________________________________________
__________________________________________________________________________________________

Visit the Employment Ontario website at http://www.edu.gov.on.ca to find programs and services to help 
you. Talk to your instructor about a referral.

______________________________ __________________________________  ________________________
 Name     Signature                                                            Date
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Module Overview

So far, you have been introduced to the basic application software you need to communicate with your 
instructor. Now, you will learn about four of the main software applications used regularly in the workplace.
When you have finished this module, you will have the basic skills to produce a document in a word processing 
application. However, many features and tools in the word processor will not be addressed here as they are 
beyond the scope of this course.

This module will address the following topics:

 1.    Introduction to Creating Documents
 2.    Word Processing

Learning Objectives

During this module, you will

 •    review information from previous modules;
 •    review information on software applications;
 •    be introduced to word processing;
 •    learn how to create, format, edit, save, and print a document.

Overview of Contents

The following table outlines all the activities that you are expected to complete for Module Six. Your instructor 
will provide due dates for you to complete the chart. 

  Employment Track Express 

Module 6 Creating Documents 
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Module Overview 

So far, you have been introduced to the basic application software you need to communicate 
with your instructor. Now, you will learn about four of the main software applications used 
regularly in the workplace. 

When you have finished this module, you will have the basic skills to produce a document in 
a word processing application. However, many features and tools in the word processor will 
not be addressed here as they are beyond the scope of this course. 

This module will address the following topics: 

1. Introduction to Creating Documents 

2. Word Processing 

Learning Objectives 

During this module, you will 

review information from previous modules; 
review information on software applications; 
be introduced to word processing; 
Learn how to create, format, edit, save, and print a document. 

Overview of Contents

The following table outlines all the activities that you are expected to complete for Module 
Six. Your instructor will provide due dates for you to complete the chart.  

Section Content Due 
Day

Point 
Value 

Section One 
Lecture 

Document Generation    

Section Two 
Lecture 

Word Processing   

Word 
Processing 
Assignment 

Word Processing Module Six 
Assignment  

Module Test Module Six Test 
Resources    
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Section One: Creating Documents

Introduction to Creating Documents

This module starts by addressing the difficulty of getting application software you need but you may not be able 
to afford. Free software is available on the Internet and, in some cases, you are encouraged to use and share it. 
For example, OpenOffice is a free office suite software package. You can download the complete package or its 
individual parts from its website or by ordering a CD-ROM from its website. You can get the software by going 
to http://www.openoffice.org and following the directions on the website. Remember that download times will 
range, depending on your OS and the speed of your Internet connection.

On the website, you will notice that there are four separate office suite 
products available to download and use:

Writer – word processing software
Calc – spreadsheet software
Impress – presentation software
Base – database software

Use the Help menu when necessary to locate and learn about new features. The Help menu will help you find 
any topic we discuss in this module.

Software Applications Revisited

Below is a refresher on the types of software applications used regularly in 
business. Common elements such as icons, menus, toolbars, rulers, scroll bars, 
check boxes, spin boxes, and many others make software very user friendly. For 
most applications, regardless of who makes them, there are common commands 
and toolbars that help you to move from one application to another.

Word Processing Software can be used to create, format, edit, save, and print 
documents. Documents can include text, graphics, charts, and many other types 
of media. The most commonly used word processing software packages are 
Microsoft Word and Corel WordPerfect. Microsoft Works Word Processor and 
OpenOffice Write are used less frequently. Word processors all have the same 
basic capabilities along with standard tools and commands.

Spreadsheet Software can be used for calculations and other mathematical 
tasks. This type of software uses workbooks and worksheets that are arranged in 
columns and rows. Spreadsheets allow you to use formulas, which you can then 
use to recalculate data without having to re-enter all the numbers again. The most 
commonly used spreadsheets are Microsoft Excel, IBM Lotus and Corel Quattro 
Pro. Microsoft Works Spreadsheet and OpenOffice Calc are also used. They all 
have the same basic capabilities and some offer more tools and options.

I think I know what all these 
words mean. I’ll check the 
glossary or ask just to make 
sure.

  Reading Text

Refresher = reading 
to remember. The 
heading and opening 
sentence of each 
section introduces the 
topic. Pause at the 
end of each section 
to think about what 
you’ve just read. 
Did you remember 
this information? If 
not, make notes or 
highlight important 
information. Read 
the information again 
later.
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Presentation Software has almost replaced flip charts, slide projectors, and overhead transparencies. This 
software creates presentations known as slideshows that can be shown to large audiences. These presentations 
can be very simple or they can be complex. The most commonly known presentation software packages are 
Microsoft PowerPoint and IBM Freelance Graphics, but others such as OpenOffice Impress are available.

Database Software is used to organize, manage, and store data. You can enter data in tables, create forms, 
perform sorts, use filters, perform queries, and create meaningful reports for printing and storage. The most 
commonly known database packages are Microsoft Access, Lotus Approach, and Corel Paradox. Microsoft 
Works Database and OpenOffice Base are also in use. All database software share basic features, with minor 
differences in the options they offer.

Before we begin to learn how to use office software, let’s review a number of Helpful Hints: 

•    Toolbars can be customized in many applications. You may also see the default toolbars on one row or two,   
     depending on the program. To make changes in Microsoft Word, Excel, PowerPoint, or Access, 
     go to the View menu, click Toolbars, Customize, the Toolbars tab, and then make your choices from the   
     available options.

•    When toolbars are located together on one row, additional buttons for a toolbar may be indicated by double   
      right-pointing arrows, or downward pointing arrows. When you see these arrows, it means that there are 

more options or buttons available. Click the arrows to show additional buttons, and then click the option 
      you want.

•    To find missing toolbars, go to the View menu, click Toolbars, and then click on the toolbar you need.

•    Use Screentips to help you identify icons and commands. Move your mouse pointer over the item you wish   
      to know more about.

•    Scroll bars, scroll arrows, and scroll boxes only show up on your screen when the document is larger than   
     the screen window. Don’t be alarmed if you can’t see these features all the time.

•    Help is available to you through the Help menu on the menu bar or by clicking the ? icon on most programs.

•    Saving files, page setup, and printing options can all be done through the File menu on the menu bar. Some   
     of these actions can also be done using command buttons on toolbars.

•    Some applications (or versions of them) have task panes that appear on the side of a document. Task panes   
     are designed to help you with common tasks.

•    Context-sensitive menus are available on most buttons or commands. Try right-clicking any element to   
      activate a shortcut menu.

•    Wizards and Templates are available to help you design and format new documents. Try clicking the File     
     menu, then click New and choose a pre-set template or use a Wizard to set up a document. You can also 
     create your own templates once you get to know the program and its features.
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Section Two: Word Processing

Introduction to Word Processing

Word processing will be familiar to you because of your previous introduction to 
a text editor. A word processor does a lot more than a text editor, but the basics 
are the same. For this module, Microsoft Word and Microsoft Works Word 
Processor will be used.

Activity 1:
Activate your Word Processing Application

Open up your word processing application by clicking on the Start menu. Click 
All Programs, find your application, and then click the program to activate it in 
Windows XP. You could also find your program using your specific OS.

A default document appears when you open the program. At this point, 
you could just start typing because the document is based on a template 
with pre-set margins, tab stops, font type and size, and many additional 
settings for standard use.

Get to know the menus and toolbars available in your program by clicking 
on each of the menus and moving your mouse pointer over each of the 
buttons on the toolbar to activate screentips.

Take a look at the images of open word processing documents that follow:

  Writing

Writing pertains 
to tasks involving 
the completion of 
documents such as 
forms, and writing text.

• Writing text includes  
  using a computer to 
  write or type text. 

  Document Use
Document Use refers to 
tasks that involve a variety 
of information displays 
including graphs, lists, 
forms, tables, blueprints 
and schematics.

• Document Use includes      
  creating information   
  displays as described   
 above.
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  Document Use
This document “mimics” 
the appearance of an 
open word processing 
document. This type of 
document is known as 
a mimetic document. 
It provides information 
about the appearance 
of the screen and the 
meaning of labels and 
icons. Mimetic documents 
include drawings, diagrams, 
schematics, blueprints and 
photographs. They are used 
to communicate information 
more effectively than text.

Two Examples of Word Processor Application Windows

Example One: Microsoft Word

Example Two: Microsoft Works Word Processor
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Notice that the windows have the same basic elements. Another program may differ slightly from both of these 
examples. You may need to use research skills to accomplish tasks if you are using a different word processing 
application.

Most word processors will have common features across all platforms and 
software providers. To get an idea of the basic elements of a word processor and 
their functions, take a look at the following table:

I’ve learned a lot of 
computer jargon! I’m 
glad I asked questions 
and used the glossary.

Common Features of Basic 
Word Processors

Helpful Hints:

•    To locate missing rulers, go to the View menu, and then click Ruler.

•    To change the Ruler measurement scale, go to the Tools menu, click Options, and change where    
     appropriate.

Feature Basic Description 

Title Bar 
Displays program icon, name of document, and name 
of program, in addition to the Minimize, 
Maximize/Restore Down, and Close buttons. 

Menu Bar Shows menu names that contain commands and may 
contain additional submenus, or even sub-submenus. 

Standard Toolbar Shows available buttons for most of the common 
commands. 

Formatting Toolbar Contains available buttons used for most common 
formatting options.  

Rulers
Shows margins, indents, columns, and tabs. 
(Measurement can be changed by clicking Tools, then 
Options, and locating desired measurement) 

Vertical Scroll Bar Scroll box or arrows with the scroll bar can be moved 
up and down in a document to display hidden text. 

Horizontal Scroll Bar Scroll box or arrows with the scroll bar can be moved 
left and right in a document to display hidden text. 

Toolbar Options arrows Display a list of additional available buttons and 
options for the toolbar, if available. 

Document Window Displays active document window. 

Insertion Point Blinking vertical line indicating the location where text, 
graphics, or objects will be inserted. 

Taskbar Holds Start button, name of open programs, shortcut 
buttons, and notification area. 

Status Bar Displays page and section number along with other 
settings. 
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Differences Between Word Processors

When you looked at the two different word processor document screens, you may have noticed that Word 
had a few additional items that were not in the Works Word Processor. These are the specific types of options 
available that may not be the same in the program you are using. We won’t use these options while learning 
the basic skills, as they are not present in all word processors. Re-examine the Two Examples of Word 
Processor Application Windows and look for the following differences:

•    Each program shows its specific Program Icon and Program Name on the Title Bar.

•    The default document names on Title Bar are different before you change and save as your choice.

•    Standard and Formatting toolbars are shown on one row in Word 
     and separately in Works, which is why there are no toolbar options 
     arrows available. You can display them on different rows in Word if  
     you wish to show all available options or customize the toolbar; 
     also, you may notice slight differences in the icons available.

•    Previous page, Browse, and Next page icons on the Vertical Scroll 
     Bar are available in Word but are not in Works.

•    View icons are available directly to the left of the Horizontal Scroll  
      bar in Word, but are not offered in Works. These icons allow you to  
      change to different views onscreen for various purposes.

•    Word shows additional information and buttons on the Status Bar. You can open a new or existing   
      document in different ways. If your word processor is a later version, you can also use the Task Pane. 
      The following activity will work on all word processors installed on your system that have menus available 
      in addition to toolbar icons.

Document Use

This information could also 
be displayed as a combined 
list. You can practice creating 
documents by developing a 
3-column chart and inputting 
relevant information from the 
text on the left.
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Word Processing Activities

Activity 2: Opening a New Document

1.    Make your word processor the active window. Reopen your word 
       processor if you accidentally closed it.

2.    Click File, New, Blank Document, OK.

 A) Notice if options for templates and wizards are   
  available.

 B) Also, notice that your default file name has changed if you are using Word because you nowhave  
  two new documents open. However, this is not the case with all word processors, so remember 
  to close any unnecessary documents you have opened. You can see which programs are open by 
  looking on your Taskbar.

C) Remember that documents have to be saved to permanent storage because they are only in RAM   
  and will disappear once the computer is turned off.

3.    Click the New Blank Document icon on the standard toolbar.
4.    Under Open, click Create new document from the Getting Started Task pane, if available to you.
5.    Under New, click Blank Document from the New Document Task pane, if available to you.

Helpful Hints:
You can always open a new document by finding that type of file (for example, a word processing file) in the file 
system hierarchy, double-clicking it, and then opening a new document from within the program.

Group icon buttons for documents appear on the Taskbar when there is not enough room to house all open 
documents. For example, if three documents were open and named Doc 1, Doc 2 and Doc 3, you would see 
them on the Taskbar at the bottom of your screen. Clicking on the document name in the Taskbar displays it on 
your screen.

At this point, you will have a number of open documents available on your Taskbar, depending on which word 
processor you are using. Close all documents, except one. You will use it in a later activity.

  Reading Text

Notice information in this 
activity is provided separately 
from the instructions as points 
2. A, B and C, and in Helpful 
Hints following the instructions.
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Activity 3: Closing Documents Without Saving

There are four ways to close a document:

1.    Click the File menu, then click Close (for an active document).
2.    Click X on the title bar (quickest way to close an active document).
3.    Click the down arrow on the group of documents for the program on the Taskbar, and then right-click to   
       show the shortcut menu, then click Close.
4.    Right-click Taskbar button and click Close Group.

Helpful Hint:

If you have made any changes to a document and you try to close it, a dialog box will appear, asking if you wish 
to save changes. Click the appropriate response and then the dialog box and the document will close.

After practicing how to close down documents, you should now have only one word processing document open.

Activity 4: Typing a Document

For this activity, be sure that your word processing document is active and press Ctrl + Home keys in sequence 
on your keyboard to make sure that your cursor is at the top of the page. You can also click at the top of the page 
to move your cursor to the top.

1.    Type the text below – Formatting Document - and press the Enter key
       twice where a blank line is shown between paragraphs. The Word Wrap 
       feature is included with word processors. Word Wrap automatically 
       moves text to the next line when you reach the end of a line. You don’t  
       have to press Enter until you want to start a new paragraph or 
       until you need to skip lines.

Formatting Document

This document will be used as an example of the many features and formatting abilities of word processing 
applications. Formatting features such as bolding, italicizing, underlining, font types, font sizes, font colours, 
various alignment options for text, and indents will be covered.

Additional formatting offered in Word on the Formatting toolbar will also be used, if available. These include 
font style, using numbering, bullets, borders, and highlighting.

For more advanced formatting features, you can always click on the Format menu on the menu bar to activate 
dialog boxes with options to allow formatting on any items available with your program.

  Writing

Writing text includes using 
a computer to write or 
type text.
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2.    Click the Save button on the Standard toolbar. The Save As: dialog box will appear.

3.    Click the down arrow beside the Save in: box to locate and select your Desktop.

4.    Double-click your Name folder that you created to hold your files.

5.    Click the Create a New Folder icon to the right of the Save in: box. Hold your mouse over the icons, if   
       necessary, to show screentips.

6.    Type the name “Word Processor” and press Enter to finish the command. You will save any word    
       processing documents to this folder during these activities.

7.    Double-click on the newly created folder to open it. Now you will be in the correct location when you save   
       your file.

8.    Click in the File Name: box and type in the name “Formatting Document.” Do not change the File Type,   
       but notice that there are several options.

9.    Click the Save button. The dialog box will disappear.

10.  Click the X button on the Title Bar to close your document.

Important Note: The Save As: dialog appears only the first time you save a file. You will not get this dialog 
box again if you press the Save button; it will automatically save to the last location you saved to or, in some 
cases, to the default location of My Documents folder. If you are ever unsure of where your document is being 
saved, use Save As: from the File menu. Then you can tell the computer where to save your document.

Helpful Hints:

There are two typing modes you can use:

1. Edit mode is the default mode. It moves existing text to the right of   
       the insertion point as you type.

2.  Overtype mode replaces existing text with new text as you type. To   
       change to overtype mode, press the Insert key located near the 
       Home key on your keyboard. You will notice that the OVR button on   
       your status bar is now bold. Insert is a toggle switch, so you must 
       press it again when you want to go back to the default Edit mode.

Word processors do not see a paragraph the same way we do. These 
programs think you’re starting a new paragraph each time you press Enter.

The Show/Hide (Show All) button on the standard toolbar is used to 
show all formatting marks including characters for paragraphs, tabs, 
spacebars, and Enter. If you press this button, you can often find solutions 
to document formatting problems. You can turn it off by clicking it again.

  Document Use

In this activity, both the 
drop-down menu and 
dialog box are documents. 
You are required to locate 
and click on the Open 
command, which results in 
a dialog box. You are then 
required to locate the file 
name and double-click on 
it. Remember that using 
documents requires you to 
locate a required piece of 
information or data.
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Activity 5: Opening an Existing Document

1.    Open your word processing program again.

2.    Click the File menu, Open, locate the document called Formatting Document, select the file and click   
Open, or double-click the file. You can also click the Open button on the standard toolbar to 

       find the file.

Your document should look like one of the following images. If it doesn’t, talk to your instructor.

Now, we’ll look at formatting and editing.
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Formatting a Document 

Introduction to Formatting Documents

Before we learn how to format a document, preview these format toolbar images of Microsoft Word and 
Microsoft Works. These images explain many of the formatting features that the programs offer. 

Word

Works

Style 

Font 
Size 

Font Bold 
Und
erli

Italic Align 
Left Align 

Right

Center Justify 

Numbering Increase 
Indent

Highlight 
Font 
Colour

Bullets Decrease 
Indent

Outside 
Border

More
Buttons

Underline 

Font 
Font 
Size 

Font 
Color

Bold 
Underline 

Center Justify Decrease
Indent

Format 
Gallery

Italic Align
Left

Align
Right

Bullets Numbering Increase 
Indent 
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The table below, Formatting Features, tells you what each of the formatting features can do.

  Document Use
Combined list

Option Description 
Style Type of font to emphasi e text   
Font Set of characters with same shape and design  
Font Size easured in points  The higher the point si e, the larger the 

font  
Font Color Selected text be changed to arious colours  
Bold Selected text is bolded to draw attention  
Italic Selected text is italici ed to draw attention  
Underline Selected text is underlined to draw attention  
Align Left Aligns selected text to the left in line with left margin  
Center Aligns selected text in the center of left and right margins  
Align Right Aligns selected text to the right in line with right margin  
Justify Adds additional space throughout selected text to align text 

in line with both left and right margins  
Numbering Used for lists of items where the order is of importance  
Bullets Used for lists of items where the order is not important  
Decrease Indent Decreases indentation of selected text  
Increase Indent Creates indentation or increases indentation of selected text
Outside Border Puts a border around selected text  
Highlight Highlights selected text with a background colour  The 

default is yellow but you can choose from different colours  
More Buttons Indicates further options a ailable for the toolbar  
Format Gallery Additional formatting options a ailable that are not on the 

toolbar  

Formatting Features:

Now that you have reviewed formatting features, open your document and complete the following tasks.

Activity 6: Formatting a Document

A.     Select and Format Title Text

1.    Click at the beginning of the title text “Formatting Document” by dragging the 
       mouse slowly so that the title is highlighted as in the Formatting Document   
       image you looked at previously. Or, move the mouse pointer into the left 
       margin so the pointing arrow is visible to the left of the title text and click once   
       to highlight it.

More than one 
option is provided 
in the first two 
instructions.
Decide which
option you will 
use, or try them 
all.
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2.    Click the Center alignment button on the formatting toolbar to center the title on the page. Or, you 
       can click before, after, or anywhere in the title text and click Center alignment to end up with the 
       same result.

3.    Make sure that your title text is still selected, then click the down arrow beside the Font box to   
       change the font to Arial (Sans Serif).

4.    Click the down arrow beside the Font Size box to change the font size to 14 pt.

5.    Click the Bold button to emphasize the title.

6.    Go to File, Save As, to save the changes you have made to your document. Be sure to leave the file   
       name the same. Check the Save in: box to ensure you are saving to the Word Processor folder you 
       created earlier in your name folder on the Desktop.

7.    Click the Save button in the Save as: dialog box. A dialog box may appear, asking if you want to   
       replace the existing file. Click Yes and the dialog box will close.

Activity 7: Formatting a Document

B. Select and Emphasize Text

1.    Highlight the word “bold” in the second sentence of the first paragraph. Click the Bold button on the 
       formatting toolbar to bold the text.

2.    Highlight the word “italic” in the same sentence. Click the Italic button to italicize the text.

3.    Highlight the word “underline.” Click the Underline button to underline the text.

4.    Highlight the words “font type.” Click the down arrow beside the Font box to choose another   
       font type, and then click Font to change the font type.

5.    Highlight the words “font size,” then click the down arrow beside Font Size to show available   
       options. Click 8 to change the font size to 8 points.

6.    Highlight the words “font colour,” then click the down arrow beside Font Color to show available 
       options. Click your choice of colour to change the font colour.

7.    Click the Save button in the Save as: dialog box. A dialog box may appear asking if you want to   
       replace the existing file. Click Yes and the dialog box will close.
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Activity 8: Formatting a Document
Select and Format Text

1.   Click anywhere in the first paragraph of text. Your insertion point will  
      be blinking. Click the Increase Indent button so that your first 
      paragraph of text is indented.

2.   Click at the beginning of the second paragraph of text starting   
      “Additional formatting…” Click the Justify button. The text spacing 
      will become justified.

3.   Click at the end of the first sentence, after the period, so your insertion  
      point is just before the words: “These include…” Press the Enter key
      on your keyboard twice to create a new paragraph with a blank line in 
      between paragraphs. Press the Delete key twice to eliminate the 
      two extra spaces at the beginning of the new paragraph then click 
      the Align Left button on the formatting toolbar so that the new 
      paragraph is now left-aligned.

4.   Click directly in front of the text “font style…” in the newly 
      created paragraph and press the Enter key once. Then, click in 
      front of the text “using numbering…” and press Enter once. 
      Continue with the other three units of text starting “using bullets…, 
      borders…, and highlighting…” You should now have a list of items  
      to perform additional formatting on.

5.   Click the File menu and then click Save As: to save your file to the  
      appropriate location again.

Please see the following formatting document to make sure that you have accomplished the tasks so far          
      before continuing with the next exercise. Your document may look slightly different depending on which 
      word processor you are using.

  Reading Text

The text to the left contains 
many instructions with 
several steps. Read 
the first step of the first 
numbered instruction and 
perform the task. Then 
read the next step and 
perform that task. And so 
on. Notice that information 
is provided at the end of 
each numbered instruction 
describing the result of 
following the instructions. 
Use this information to 
self-check your successful 
completion of the steps.
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Screen Shot Heading – Formatting Example

Highlight the comma after the words “font style” and press the Delete key on your keyboard to delete the 
comma. Or click after the comma following the words “font style” and press the Backspace key on your 
keyboard to delete the comma.

Use the above methods to delete the commas and the period for the text “using numbering, using bullets, 
borders, and highlighting.”

Click at the beginning of the text “and highlighting” and press the Delete key as many times as necessary 
to delete the word “and.” Alternatively, select the text “and”, and press the Delete key. If you make an 
error in deleting, click the Undo button on the standard toolbar to undo as many commands as necessary to 
correct your error. The Redo button can be used to reverse the Undo actions. Try it!

Highlight the following lines of text as a group by clicking at the beginning of “font style” and dragging the 
mouse slowly down to the end of “highlighting.” This will allow you to format more than one paragraph 
with a single command instead of having to do each paragraph individually.

Activity 8: Formatting a Document
Select and Format Text (continued)

6.

7.

8.

9.
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Click the Numbering button on the formatting toolbar to create a numbered list. A numbered list is used 
when the order of items is important.

Click the Copy button on the standard toolbar, then click at the end of the last paragraph of text in the 
document, press the Enter key on your keyboard twice, then click the Paste command on the standard 
toolbar. You should now have a copy of the numbered list available 
to you at the bottom of the document. Don’t worry about the 
numbering sequence at this point.

Highlight your newly created list at the bottom of the document 
again. Click the Bullets button on the formatting toolbar. A bulleted 
list is used when the order of items is not important.

Highlight your new bulleted list if it is not still selected. Click the 
Outside Border button on the formatting toolbar (if using Word) to 
create a border around the list. Alternatively, click the Format menu, 
Borders and Shading, Outline, or alternative, depending on which 
word processor you are using.

Click File, Save As, to save your file to the appropriate location again.

Helpful Hints:

Formatting text allows you to change the layout, emphasis, colour, shading, and font characteristics to 
make your document look better.

Remember to use the select and do method when formatting text, graphics, or objects.
If you click anywhere in a paragraph, and then click an alignment button, all text in the paragraph will 
be aligned as specified.

A set of characters with the same shape and design is considered a font.

The two basic types of fonts are Serif (have extensions on the end 
of characters, or “feet” and are easy to read) and Sans Serif (have 
no extensions, or “feet,” on characters - great for headings and 
titles).

Font size options vary depending on the type of font chosen.

Font size is expressed as point size with one pt. being equal to 1/72 
of an inch.

A default font size is apparent when a new document appears. Most 
users find that 10 or 12 pts. works well for the average document.

10.

11.

12.

13.

14.

  Document Use

Creating a list is a 
Document Use task.

  Document Use

Drop down menus are 
documents. Click on the 
down arrow beside the font 
box in the Tool Bar and 
scroll through the very long 
list of fonts available. Notice 
that the name of each font 
uses that font to illustrate 
the appearance.
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You can type a font size in the box directly as opposed to using the down arrow and then selecting the size.
Bold, Italic, and Underline are used to emphasize text.

At this point, your document may be larger than the screen window and you will have to use the scroll box, 
scroll arrows, or alternative scrolling options to view your document onscreen. However, word processors come 
with an option to observe how a document will look when printed called Print Preview. This feature can be 
accessed quickly at any time.

Activity 9 will show you how to use Print Preview. With your Formatting Document open, try this next 
activity.

Activity 9: Formatting a Document - Print Preview

1.    Click the Print Preview button on the standard toolbar to view your document. Notice that your mouse   
       pointer changes to a magnifying glass as you go over your document, enabling you to click and change 
       zoom percentages with each click. Or click the down arrow beside the Zoom box on the available toolbar 
       to change view options when you’re in Print Preview.

2.    Move your mouse pointer over each option available on the toolbar to see the screentips and become   
       familiar with the options.

3.    Click on the menus to see options available in this view. Remember that if options are greyed-out, they are   
       not available.

4.     Try clicking all options to view dialog boxes and then close them.

5.     Once you feel comfortable with Print Preview, click Close on the Toolbar to return to your document   
        window.

You may also want to learn some simple keyboard shortcut commands to help you select text and navigate 
through a document. Look at the following tables to see how certain key combinations select and move your 
cursor around in text.

Document Use

Notice the structure of the Selection of Text and Keyboard Shortcuts tables is 
the same (combined lists). The headings tell you what the content is about. 
The structure is the same, but the content is different.
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Selection Description 

Entire document 
Press the key combination Ctrl + A, or move mouse 
pointer into left margin until you see right-pointing arrow 
and triple-click. (Yes, I said triple-click) 

Consecutive 
paragraphs

Press Shift + Ctrl +up or down arrow to achieve the 
paragraph selection you want. 

Specific 
consecutive text 

Place insertion point at the beginning of the text you 
want, press Shift and then click at the end of the text 
you want. 

Consecutive 
lines of text Press the Shift key + up or down arrow.

Paragraph
Move the mouse pointer into the left margin beside the 
paragraph you want until you see a right-pointing arrow 
and double-click. 

Sentence Press Ctrl and click in-sentence. 

String of words Place insertion point at the left of the first word you 
want, the press Shift + right arrow or left arrow.

Line of text 
Place insertion point in the margin to the left of the line 
of text until you see a right-pointing arrow and then 
click. 

Word Double-click word. 

Characters one 
at a time 

Place insertion point at the left of the first character, 
press Shift + Ctrl + right or left arrow as many times 
as required. 

Selection of Text

Movement Keys Used 
Beginning of document Press Ctrl + Home 
Beginning of line of text Press Home 
Beginning of previous word Press Ctrl + Left arrow 
Beginning of the next word Press Ctrl + Right arrow  
Beginning of current word if the 
insertion point is anywhere else in the 
word 

Press Ctrl + Left arrow 

Beginning of the previous paragraph Press Ctrl + Up arrow 
Beginning of the next paragraph Press Ctrl + Down arrow 
Beginning of current paragraph if the 
insertion point is anywhere else in the 
paragraph

Press Ctrl + Up arrow 

Up one screen of text Press Page Up 
End of document Press Ctrl + End 
End of line of text Press End 
Down one screen of text Press Page Down 

Keyboard Shortcuts



Employment Track Express

170 Module Six Computer Use: Creating Documents

Now that you have seen more ways to select and move text through a document, try them in your 
Formatting Document before continuing with the next activity.

Editing a Document

We are now ready to look at editing a document. Please review the content on Spelling and Grammar Check 
before you begin to edit your document in the activities that follow.

Spelling and Grammar Check

Do not worry if you noticed any red (spelling) or green (grammar) 
wavy lines under the text you have typed so far because we will be 
addressing these lines in the next activity.

If you do not see these wavy lines, the automatic spelling and/or 
grammar checker may not be installed or it may be turned off on your 
system.

To turn on your spelling and/or grammar check, click the Tools menu,
Options, Spelling and Grammar tab, and activate the check. In other 
word processors, you can activate from Tools, Options.

To install spelling and/or grammar check, use your original program 
CD. Many word processors will ask you to put the CD in when trying 
to use the feature from Tools, Spelling and Grammar option.

When the Spelling and Grammar checker is turned on, your words 
are compared to a Word dictionary and your phrases and punctuation 
are compared to a Grammar Rules list.

If you use words the dictionary does not recognize or if you use grammar that doesn’t follow the Grammar 
Rules, red and green wavy lines will appear.

The Spelling and Grammar feature of most word processing programs should be used only as a guide. Also, 
word processors do not check for usage, so if you meant to say where instead of when, the program will not 
flag when as an error because it is a known word.

There are many ways to use these features. Right-click (if available to you) the word or sentence and then 
choose options as you type. Or you can start at the beginning of the document, click Tools, Spelling and 
Grammar and proceed, or start at the point you are working and then continue from the beginning again. You 
can also select the text you wish to check and choose Tools, Spelling and Grammar, and then proceed.

Please note that the dialog box options will change when checking grammar, which is why they have been 
added to the table below. You will note slight differences in options offered in Word, Works and other word 
processors. Don’t let these slight differences concern you; the basic concepts are the same.

Spelling and Grammar Check 
will be a useful tool when I am 
writing, even if it is just a guide. 
It will help me correct spelling 
and grammar before I send.
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Spelling and Grammar Check

The following table describes a typical dialog box that you will see when you click on your Spelling and 
Grammar check options. Notice the various buttons and how they will interact with the text.

Spelling and Grammar Dialog Box Features

Option What Happens? 

Check Grammar Check box Checks grammar and spelling if selected  
therwise, only spelling will be checked  

Ignore words in 
UPPERCASE, Ignore words 
with numbers, Ignore Internet 
and file addresses (check 
boxes) 

Self explanatory, if selected  therwise, these 
options will not be checked  

Options Button 
Displays the spelling and grammar options 
dialog box to acti ate or deacti ate more 
a ailable options  

Undo Button Allows you to undo your last editing action s  
Cancel Button Allows you to cancel your actions   
Close Button Closes the open dialog box  
Ignore/Ignore Once Button Ignores the identified word but flags additional 

occurrences and proceeds one at a time  
Ignore All Button Ignores all occurrences of the word and does 

not flag throughout the document  
Add Button Adds a word to the dictionary that will no 

longer be flagged as incorrect  
Change Button Changes the identified word to the selected 

word in suggestions box  

Change All Button 
Changes all instances of identified word in the 
document to the selected word in the 
suggestions box  

AutoCorrect
Adds the flagged word to the AutoCorrect list 
that will then correct the word automatically if 
misspelled in future documents  

Ignore Rule (Grammar) Ignores the specific rule used to determine a 
grammatical error and skips to next error  

Next Sentence (Grammar) o es to the next identified error in the 
document  

Explain (Grammar) ill display the rule it used to identify a 
grammatical error  
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Activity 10:
Editing a Document - Inserting Additional Text
With your Formatting Document open, try the following activity:

Move to the end of your document (after the bulleted list with a border around it) and click to get your cursor. 
Make sure you leave a blank line between the list and the next paragraph, and then type in the following text 
exactly, leaving the word editing spelled incorrectly:

“While edising the text in a document, you need to remember to use the 
select and do method to  make changes. You can be sure that your 
text is selected when it is highlighted on screen. You  can then 
attempt the desired changes which will inevitably affect all selected 
text. Inserting,   deleting, moving, and copying text can be 
accomplished quickly and easily once you have mastered selection 
and movement techniques. Spelling and Grammar features that come with word processors can be used along 
with Help to produce professional documents by all users.”

Click File, Save As, to save your file to the appropriate location again. Saving often can make it less likely that 
you will lose your work.

Activity 11:
Editing a Document - Spelling and Grammar Check
With your Formatting Document open, try the following activity:

1.    Press Ctrl + Home to go to the beginning of your document.

2.    Click Tools, Spelling and Grammar. The Spelling and Grammar dialog appears with the first perceived   
       error found in the document. Notice that it picked up the word colour as an error because the 
       United States dictionary is being used. This is a good example of why you might need to check 
       your own documents, change or use an additional dictionary, or add known words to your word processor’s   
       dictionary.

3.    Take a look at the Example Spelling and Grammar Dialog Box and then continue with the next step in   
       this activity.

4.    Click Ignore All.

5.    Click Ignore to changing the capitalization of the list items.

6.    Click to select the word “editing” from suggestions to replace the word “edising.” Click Change.

I recognize some of the 
errors – it is hard not 
to correct them in this 
exercise!
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7.    Click Change when presented with the error of the extra space   
       between the words “copying text.”

8.    Click Ignore if presented with a grammatical suggestion for the 
       sentences in the last paragraph.

9.    Click OK when the spelling and grammar check is complete dialog 
       box appears.

Please see the following examples of a Spelling and Grammar dialog 
box.

  Document Use

Mimetic documents include 
drawings, diagrams, 
schematics, blueprints and 
photographs. They are used 
to communicate information 
more effectively than text. 
Several mimetic documents 
have been used in the 
manual.

Microsoft Word

Microsoft Works

Make sure that your Formatting Document is still active and then proceed to the next activity.
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  Reading Text

Instruction #1 provides 
several clues and keywords 
to accomplish the task. 
First, locate the last 
paragraph and count the 
sentences to find the third 
sentence starting with “You 
can then attempt…” Scan 
to locate “which.” Finish the 
task.

Activity 12: 
Editing a Document - Deleting and 
Inserting Text

1.    Move to the third sentence in the last paragraph that starts with the 
       words “You can then attempt…” Highlight the word “which.”
       Then press Delete. You can use any method of selection you 
       wish to do this task.

2.    With your insertion point still positioned in the sentence, type the 
       word “that,” then press Enter (to put a space after the new inserted 
       word if necessary). Edit mode moves text to the right to   
       accommodate the new word.

3.    Click File, Save As, to save your changes to the appropriate   
       location.

With your document open, proceed to the next activity.

Activity 13:
Editing a Document - Moving Text to a New Location

1.    Highlight the last sentence (including the period) in the last   
       paragraph that starts with the words “Spelling and Grammar…”

2.    Click Cut on the standard toolbar. You can also click the Edit   
menu, and then click Cut. Don’t worry when your text disappears 

       because it has actually been moved to the Clipboard in RAM.
       Also, you can always use the Undo button to reverse the action
       if you make an error.

3.    Move to the beginning of the last paragraph and click to place the 
       insertion point just before the sentence starting with the words   
     “While editing the text…”

4.    Click the Paste button on the standard toolbar to insert the text. Or 
       you can click the Edit menu, and then click Paste. The last sentence of the last paragraph is now the first   
       sentence.

5.    Move to the end of the new first sentence starting with the words “Spelling and Grammar…” and click   
       after the period to place the insertion point at that location.

6.    Press Enter to create a new blank line after this sentence that will actually create a new paragraph.

  Reading Text

Task: Highlight the last 
sentence (including the 
period) in the last paragraph
Clue: in the last paragraph
Keywords: Spelling and 
Grammar
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Helpful Hints:

•   There are a number of ways to delete text using the Delete, Backspace, shortcut menus, menus, and the   
     toolbar. Use what works for you.

•   When moving (cutting) or copying text, you must complete the procedure by using the paste command.

Inserting Graphics

It’s time to have a little fun with your document by including visual content. You can insert graphics and objects 
from many sources. Images from the Internet, personal photos from digital cameras and scanners, predefined 
images included with programs, and objects from other programs can all be added to documents.

Activity 14: Editing a Document - Inserting Clip Art

1.    Click at the end of the last paragraph, and press Enter twice to leave a line between the paragraph and the   
       insertion location for your image.

2.    Click the Insert menu, Picture, Clip Art. The Insert Clip Art dialog box 
        will appear, allowing you to search for different types of images.

3.    View and find images using options available in your program, then select  
       an image that you like. The highlighted image will show a thick border 
       around it once you select it. You may have to choose a category by 
       clicking on it, depending on your clip art gallery.

4.    Click the Insert button in the lower right corner of the dialog box. The 
       image will appear in the document. If the image you chose is large, it may 
       appear on a separate page. Do not worry; you can resize the image so that  
       it will fit on one page with your document later.

5.    Click on any blank area of the page to complete the process.

6.    Click File, Save As, to save your document to the appropriate location.

With your document still open, do Activity 15 to resize your image to fit onto one page with the text.

Learning this means 
I can create mimetic 
documents, using 
pictures and diagrams.
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Activity 15: Editing a Document - Resizing Clip Art

1.    Scroll as necessary to locate your picture and then select it. Resizing handles (black squares) will appear   
       around the picture.

2.    Move your mouse pointer over each of these to view the bi-directional arrows. These are used to resize the   
       image.

3.    Click and drag the bottom-center resizing handle while bi-directional arrows are present upward until your   
       graphic appears to move to the previous page, then release the mouse button.

4.    Select the picture again, if necessary, and then click the Center button on the formatting toolbar. The   
       picture will now be centered on the page between the existing margins.

5.    Continue to use the additional resizing handles to adjust the picture until you are satisfied with it.

6.    Click on any blank area of the page to complete the process.

7.    Click File, Save As, to save your document to the appropriate location.

Helpful Hints:

•    Clip art images are predefined and are offered for use by your program.

•    Clip art choices and options are slightly different, depending on the program and version you are using, but   
     all clip art programs let you search to locate specific categories of images.

•    Graphics or objects will be inserted at the location of your insertion point.

•    There are many types of images available of various sizes.

•    Graphics or objects can be resized through the select and do method.

•    Resizing handles (black boxes) and/or bi-directional arrows are used to change the size of the graphic.

•    The mouse pointer changes to bi-directional arrows when it hovers over resize handles.

•    Graphics or objects can be moved, formatted, and edited to suit your needs.

•    If you have a problem with an additional page still being in existence, click at the bottom of your document   
     and press the Delete key as many times as necessary to delete the page.

Headers and Footers

Headers and footers contain information that identifies documents when the documents are printed. Adding 
headers and footers is a convenient way to include information that you want to appear on all pages of your 
document. The location of your insertion point is not an issue when creating Headers and Footers. Try the 
following activities with your Formatting Document active.
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Click the View menu, Header and Footer. You will notice that 
the document seems to fade, a box with dashed lines appears at 
the top of your document page, and a new Header and Footer
toolbar appears.

Move your mouse pointer over each of the available options on 
the Header and Footer toolbar to see the screentips.

Click the Switch Between Header and Footer option
button. You are now in the Footer area of your          
document.

Press the Tab key twice to move to the extreme right of the 
Footer area. Click the Insert Page Number option button on the 
Header and Footer toolbar. The footer should now contain the 
number 1 in the footer area.

Click the Switch Between Header and Footer option again to 
return to the Header area. Type: (Your Name) there.

Click the Close button on the Header and Footer toolbar. Don’t 
be alarmed if you cannot see the header or footer because some 
views do not show them.

Click Print Preview on the standard toolbar to view your document, as it will look when printed. Look 
for the header and the footer you just created.

Click the Close button on the toolbar to close Print Preview.

Click File, Save As, to save your changes in the document to the appropriate location.

  Reading Text

The text to the left 
contains many instructions 
with several steps. Read 
the first step of the first 
numbered instruction 
and perform the task. 
Then read the next step 
and perform that task. 
And so on. Notice that 
information is provided at 
the end of each numbered 
instruction, describing 
the result of following 
the instructions. Use 
this information to self-
check your successful 
completion of the steps.

1.

3.

.

6.

7.

9.

2.

4.

8.

5.

Activity 16:
Editing a Document -Inserting a Header and Footer
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Helpful Hints:
•   The location of the new Header and Footer toolbar depends on the specific program.

•   Toolbars can be docked (usually under the other existing toolbars or at the bottom of your screen) or floating   
    (floating toolbars can appear anywhere on your screen).

•   A floating toolbar can be moved anywhere on the screen by clicking its title bar and dragging it to another   
    location onscreen if it is blocking your view. It can also be reactivated if it disappears, via the View menu.

•   You can click directly in the Header or Footer areas and type any information you wish, or you can use the   
    toolbar and use predefined options.

•   The Tab key can be used to move through header and footer alignment options.

•   You should get to know all of the options on the Header and Footer toolbar.

Page Setup
Page Setup shows how your finished document will look on the page when it’s printed. It involves a lot of 
options that we won’t get into during this course. However, you should know that layout for printing options 
such as margins, headers and footers, landscape or portrait, and others exist here. With your Formatting
Document open, we will make one more change to your document before we look at printing. Please do the 
following activity to adjust the margins of your document.

Activity 17: Editing a Document

Changing Margins
1.    Click File, Page Setup. A Page Setup dialog box will appear with tabs and   
       options. Look at the options available to you here. Locate the spin boxes 
       regarding margins by clicking on the Margins tab, if available. A spin box looks 
       like a text box, but has up and down arrows beside it. You can type a number            
       directly in the box or click on the arrows directly beside to go up or 
       down numerically. Examples would be the Top:, Bottom:, Left:, Right:, 
       Gutter:, Header:, and Footer: spin boxes on the Margins tab of the Page 
       Setup dialog box. Also, the Width: and Height: spin boxes on the Paper 
       Size tab of the Page Setup dialog box. The Page Setup dialog box is 
       located from the File menu by clicking Page Setup.

2.    Use the spin boxes by clicking on the up or down arrows to change

A)    Top and Bottom margins from 1” to 1.2”.
B)    Left and Right margins from 1.5” to 1”.
C)    From Edge for Header and Footer to 1”.

3.    Click Print Preview to observe your finished document. Close Print Preview.

4.    Click File, Save As, to save your changes in the document to the appropriate location.

Jargon
(or context-specific 
vocabulary)
Unsure what spin 
box means? Check 
the glossary or ask 
your instructor.
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Helpful Hints:
•    Two orientation choices are available in Page Setup.
•    The default page orientation for printing is Portrait (8.5” wide x 11” high).
•    Page orientation for your printout can be changed to Landscape (11” wide x 8.5” high).
• Page Setup allows you to stop your header and/or footer from printing on the first page of your document.
•  Page Setup is extremely important when using printers with various size paper trays and other options.

Printing a Document

Printing a hard copy of your document will allow you to experiment with printing options and enable you to 
hold your work in your hands. Let’s try it.

Activity 18: Printing a Document

Print Your Finished Document

1.    Click File, Print. The Print dialog box will appear. Or click the Print button on the standard toolbar if you   
       wish to print the whole document. Note that you have no control options available to you if you use 
       the Print button on the standard toolbar.

2.    Click the All option, if it is not already activated.

3.    Click OK. The Print dialog box will disappear and your document will print. You have to have a printer   
       configured and attached to your system in order to complete this exercise.

4.    Look at your finished product.

5.    Close your Formatting Document by clicking the Close button on the title bar.

Helpful Hints:
•    Using the menus instead of using the toolbar to print presents the Print dialog box and gives you more   
     control.

•    Using the menu option should be the method of choice if decisions have to be made on how the printing will 
      occur and if additional copies are necessary.

•    Printer properties can be viewed via the Print dialog box.

•  Print Preview can be activated from the Print dialog box.

•    An option is available to Print to file. Other options are also be available to you, depending on your   
     program.

•    Look at the following sample of what your printout should look like, barring your personal choices that   
     make your document unique.
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You have completed the word processing section of this module, in addition to generating your first word 
processing document.

You will now be required to complete the Module Assignment called Word Processing Assignment and then 
complete the Module Test. Your instructor will provide you with both.

You have completed Employment Track Express. In this course you have learned many computer skills that 
you can use to research and apply for jobs, find programs and services to continue your learning path, or use 
the computer to learn! You have become more aware of Essential Skills and why employers value them, and 
acquired some tips and strategies to help you apply them. You know your ES levels in Reading Text, Document 
Use and Numeracy and are able to decide whether these skills should be strengthened. Your computer skills 
have helped you become an educated user of Labour Market Information. You can apply LMI to employment 
decision making. And now you have an Action Plan to guide you in your next steps. Congratulations – you have 
accomplished a lot in a few short weeks.



Employment Track Express

181            Glossary

Glossary
@   symbol known as the at sign. The @ (at symbol) separates the ID from the 
   domain name of the email server in an email address. 

0’s    numeric value representing one bit of data that tells the computer that an   
   electronic switch is off.

1’s   numeric value representing one bit of data that tells the computer that an   
   electronic switch is on.

absolute cell 
reference

  
accessories  a submenu accessed from All Programs via the Start menu that contains utilities, 
   accessory applications and system tools. 

acronym   a word formed from the initial letters (e.g., URL – Uniform Resource Locator) of 
   words. Acronyms are used to save time, space and repetition in both speech 
   and writing. 

activated   started

active window can be recognized by the dark colour of the title bar and means that it is the 
   current window and that any typing or task being performed will be done 
   in this window. 

address bar   an important toolbar that shows the active address path and the window’s   
   location within the file system hierarchy. Addresses can be typed directly into the 
   address bar (text box) in a browser so that you can go to a specific location on  
   the web if you know the correct URL.

address book electronic list of email addresses, usually held within the email software. The 
   address book makes email addresses much easier to access. Sometimes   
   additional information such as postal addresses and other personal information 
   about people can be stored.

advanced button this icon (button) is available in some dialog boxes to allow the user to see 
   additional advanced options that are available.

align   to position data (text, images) so that it lines up, either with other data (as in a 
   column or row), or relative to the margins of a page, or within a cell of a 
   worksheet. Alignment can be horizontal (left, center, right, full) or vertical (top, 
   center, bottom).

alphabetical a listing from A to Z.

absolute cell references in formulas are not altered when the formulas are   
moved or copied to a different location in the spreadsheet. See relative and 
mixed cell reference.

order
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alt key   key on the keyboard usually used in combination with other key(s) to perform a   
   task or command.

application  a computer program or set of programs designed to carry out specific tasks.
software

apply button an icon (button) appearing in a dialog box used to confirm changes to settings.

archive  an advanced attribute that is put on a file or folder; meaning to document or   
   store.

arithmetic logic one of the two main parts of the central processing unit (CPU) that performs all   
   the arithmetic and logic functions.

arrow keys  cursor movement keys located beside the numeric keypad on the standard   
   keyboard that can be used to move up, down, left, and right along the context   
   menu.

arrows   signifies that there are more options available in menus, submenus, toolbars etc.

attachment  a file (or files) attached to an email by the sender that can then be opened by the   
   recipient.

attributes  used on files and folders. Specific attributes affect the way a file or folder is dealt   
   with by the system.

audience  the person or people for whom the work is designed to address.

average  a function used in spreadsheets to find the average of a selected range of    
   numeric values.

back button   navigation button used to go back to previous web page(s), if you have followed   
   a link(s).

background  in regards to process activities, it means behind the scenes, not in the    
   foreground.

backup  a backup copy is a duplicate of a file, program or disk made on a separate   
   storage medium. A backup can be used for recovery if the original file is lost or   
   damaged. Backup files should be stored on secure media in a separate place 
   from the original files.

Base   the name of database software from OpenOffice.

(AL)
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bit   the smallest unit of data recognized. Represents either a 0 (off) or a 1 (on).

bold    a formatting icon (button) found on the formatting toolbar that is used to    
   emphasize text. 
   Text appears stronger and darker than other text (bold).

bookmark link to a web page that the user wants to be able to return to quickly and easily. 
   Bookmarks are stored on the user’s computer so that they are readily available.

bookmarking the act of intentionally saving website addresses in a list so you can visit them   
   with a click of a button.

borders  lines that can be displayed around a page, paragraph, a table, an image,    
   spreadsheet cells or a text box to create impact. The top, bottom, left and right 
   border lines can be individually manipulated or removed.

browse  to search for files on a disk by moving up and down within the directory structure   
   until a particular folder or file is located. To follow links on the Internet from one 
   website to another (also called surfing).

browser  an application software which allows a person to read hypertext markup    
   language (HTML), and to access, view and interact with web pages. Basically,   
   allows you to view web content. See web browser.

browsing history is a heading found on the General tab of the Internet Options dialog box    
   that gives you the opportunity to view settings or delete temporary files, history,   
   cookies, saved passwords, and web form information.

bullet   a dot or other mark used at the start of each line in a list to add emphasis. 

bulletin boards are places on the Internet used to post information for groups of users with   
   similar interests. Bulletin boards are also known as message forums and 
   discussion boards.

bullets button an icon (button) located on the formatting toolbar. A bulleted list is used when the   
   order is of no concern.

by date option a view option offered in the Favorites Center of Internet Explorer for viewing   
   bookmarked websites.

byte   is equal to eight bits which represents 1 character of data such as a key pressed   
   on the keyboard.
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Calc    spreadsheet software offered by OpenOffice.

calculator  an electronic calculator program, found under the Accessories submenu, which   
   can be used in Standard or Scientific mode.

cathode-ray tube a monitor named after the cathode-ray tube it uses to produce the picture 

center alignment 

central
processing

character map a system tool that selects special characters and copies them to your document.

chart   a graphical representation of numeric data, such as a pie chart or bar chart.

chat programs chat programs allow people to converse back and forth in private, and many 
   have options to create or join a private chat room that has many people talking in 
   it.

check box   check boxes are used to choose options and are activated (put check mark in) or 
   deactivated (take check mark out) by clicking in them. 

click    by default, the left mouse button is considered the primary button to use when   
   you wish to click—press gently once.

click and drag the click and drag action is accomplished by holding down the left mouse button   
   while dragging (moving) the mouse on a selected (highlighted) object or text. 

clip art pictures, often cartoons, which are provided with software or on the Internet and   
   can be used.

clipboard   a temporary storage area in RAM that stores up to 24 selections of text or    
   graphics to be copied or moved to another location using the paste command.

close   to end an application program using the close button on the title bar or by    
   choosing exit from the File menu. Alternatively, you can just close the document   
   window within the application program by clicking on the close button on the 
   Menu bar or choosing close from the File menu.

(CRT) onscreen. This monitor is made of glass and can be curved or flat. See CRT.

button
an icon (button) located on the formatting toolbar to center text, graphics and 
other items between the margins on a page.

a chip found on the motherboard that is the brain of the computer. It performs 
all the arithmetic and logic functions. The CPU performs mathematical or logical 
operations to process data it receives from random access memory (RAM). See 
CPU.

unit (CPU)
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cold boot  the initial starting up of your computer system. The act of turning on your system.

collapse button a small minus sign (-) to the left of a folder that you can click to hide the contents   
   of the folder.

column/row a line of single cells from top to bottom (column), or from side to side (row) in a   
   spreadsheet.

combination a media drive that combines the functions of more than one media such as a   
   DVD/CD-RW.

communication the hardware and software that enables communications between people and   
  stored data.

communication services provided for communications purposes, such as an Internet Service   
   Provider (ISP) that allow messages between two or more parties, such as 
   text messages or emails.

computer  a computer is a group of electronic devices that are used together to process   
   data into information. A computer has four basic functions: input, processing,   
   output, and storage.

confirm file   a dialog box that confirms a delete command.

confirm file   a dialog box that confirms replacing a file.

context-sensitive a shortcut menu of commands based on the current task, activated by right-  
   clicking.

control unit (CU) one of the two main parts of the central processing unit (CPU) that obtains   
   instructions from memory, interprets them, and then executes them. See CU.

copy    a command used to create a duplicate of existing text, object, or files etc.

copyright  legal protection claimed by the owner of a design (document, graphical image,   
   etc.) that prohibits others from copying and reproducing the protected material, 
   or passing it off as their own work.

Corel    word processing software.

drive

technology

services

delete

replace

menu

WordPerfect



Employment Track Express

186                                Glossary

CPU    a chip found on the motherboard that is the brain of the computer. It performs 
   all the arithmetic and logic functions. 

   

Ctrl + Home keys a keyboard combination that when used in sequence will put your cursor at the 
   beginning of the document.

Ctrl key   key on the keyboard usually used in combination with other key(s) to perform a 
   task or command.

CU (control unit) one of the two main parts of the central processing unit (CPU) that obtains 
   instructions from memory, interprets them, and then executes them. See control 
   unit.

cursor  flashing vertical line.

customize   to modify, adapt or tailor.

cut   to remove information (such as text, graphical image, or table) from a document. 
   The deleted material is placed on the system clipboard (a temporary storage 
   place in random access memory), from which it can be recovered by using the 
   paste command to insert it elsewhere.

data   anything that has been input into a computer. 

Data
Measurement
Table

data type  the type or kind of data contained in a cell or field (in a spreadsheet or   
   database). Different types of data are displayed in different formats, such as 
   alphabetical, numeric, currency, percentage, decimal places, date, time, and 
   others.

database   an application that is used to organize, manage, and store data. 

(central
processing
unit)

a table produced for this course that can be used to gauge the storage size 
of your Hard Drive or the capabilities of the RAM (Random Access Memory) 
installed in your system. Any time you are unsure of your data capabilities 
regarding bits and bytes, you can refer to this table.

software
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decrease indent an icon (button) located on the formatting toolbar that will decrease indent of   
   selected text, paragraphs etc. See increase indent.

default document the document that appears when you open the program that is based on a   
   template with pre-set margins, tab stops, font type and size, and many additional   
   settings for standard use. 

delete   to erase or remove.

delete all button an icon (button) usually appearing at the bottom of a dialog box that allows you to 
   delete all items at one time.

deleting files removing files from a specific location to the recycle bin by using the delete   
   command.

desktop  also called the desktop window.

details view  a specific view option activated from the Views icon (button) on the standard   
   buttons toolbar in My Computer that when activated will show all file or folder 
   information such as name, type, total size, free space and columns.

dialog box  a window onscreen which gives a message and requires a response from the   
   user. Contains buttons and/or fields for the user to make choices and alter 
   settings.

dial-up   a method of temporarily connecting to the Internet using a telephone line and   
   modem via an Internet Service Provider (ISP).

directory  a filing structure allowing the user to organize information (files) in a specific   
   location to make it easier for retrieval from a storage device at a later date. 

disk cleanup a system tool that scans the hard drive and enables you to clear the disk of 
   unnecessary files. These files include those in the recycle bin, temporary Internet  
   files, and other temporary files created by other programs.

disk    a system tool that defragments your hard drive so that your computer runs faster   
   and more efficiently. It repositions files so that they fit better on the hard drive 
   and speeds up response time.

display  what appears on a computer screen, monitor or visual display unit. In some 
   cases, ‘display’ is used as an alternative name for a monitor, screen, or visual   
   display unit (VDU).

connection

defragmenter
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display properties 
dialog box

domain name the domain name is part of the web address which may or may not include www.   
   The domain name includes the organization and domain type 
   (such as .com or .ca). See domain type.

domain type top-level domain types include .gov (government), .com (commercial), .net   
   (network), .mil (military), and .edu (education). Additionally, most countries have 
   their own domain type such as .ca (Canada), .us (United States), .uk (United   
   Kingdom), and .fr (France).

double-click  the action of pressing the left mouse button twice quickly in order to double-click   
   an item. This is usually used to open or activate an icon, program, or file. 

download  to copy a file from a location on the Internet down to a local machine.

drag and drop a method used for editing objects within a document or organizing files and   
   folders within the file system directory. This involves selecting an item and then 
   dragging (pulling) it to another location using the mouse.

drives   a permanent storage location. All drives are allocated a drive letter such as C: for 
   a local hard drive (usually).

drop-down menu a menu of options or commands which appears to drop down by clicking a menu   
   item such as File from the menu bar. Drop-down menus will show the most 
   commonly used commands first, and then show the rest of the menu options or 
   commands after a few seconds. Double down pointing arrows indicate more   
   options that will appear automatically in a few moments or can be clicked on to 
   appear immediately.

edit   to change (alter), update, delete, or rearrange information that is stored on a   
   computer.

edit mode   the default editing mode in word processing applications that moves existing text   
   to the right of the insertion point as you type. See overtype mode.

email   short form for electronic mail. 

email id   one of the three components of an email address. The email id is the username   
   such as jok.carr that identifies who is sending or receiving the message. 

empty recycle bin an option or command that can be accessed from the Recycle Bin which is   
   usually an icon available on your desktop. This option will delete all of the files, 
   and/or folders contained in the Recycle Bin. 

allows the user to make changes to various aspects of the display (screen). 
Themes, desktop, screen saver, appearance and settings tabs are available with 
many options available in each.
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end key  a key on the keyboard that takes you to the end of the document in word    
   processors and can be used in conjunction with the Ctrl key to take you to the 
   end of a spreadsheet.

enter key  a key on the keyboard (sometimes called the return key). Pressing the Enter key   
   performs different actions depending on what you are doing at the time. It will 
   put a line break into text at the position of the cursor in a document, or will 
   complete a command in dialog boxes etc.

esc key  a key located in the top upper left corner of the standard keyboard that will cancel 
   the current task.

expand button a small plus sign + to the left of a folder that you can click to show the contents of 
   the folder.

expansion slots located on the motherboard and used to hold expansion cards such as sound   
   cards, network cards, graphic cards, and internal modems.

favourites center 
button

file    permanent storage for data such as a document, graphical image, a spreadsheet 
   or database.

file management  the process and understanding of the organization of files and folders in the file   
   system hierarchy on a computer system or network.

file menu   a menu found on the menu bar that houses commonly used commands and   
   options used in application programs such as opening, closing, saving, 
   and printing.

file name  the name used to identify a file. The file name has an extension which may be   
   automatically created by the application. File extensions are identified in the file 
   name after the chosen name by a period and three letters, such a myfile.doc. 
   The file path name includes the drive, and all folders/subfolders leading to the 
   file, such as C:\My Documents\course\myfile.doc.

file transfer 
protocol (FTP) 

Firefox  web browser software.

an icon (button) on the toolbar that looks like a yellow star on the far left that will 
present a new frame window within Internet Explorer 7. The Favorites Center 
contains information regarding favourites (bookmarks), history and feeds.

a protocol (set of rules) used to transfer files electronically from a source to a 
destination. FTP sites are still in existence and are useful for larger files. See FTP.
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firewall  a software application that attempts to protect the computer from virus attacks   
   and other harmful elements, by monitoring the movement of data in and out 
   of the computer.

flash drive  a portable storage medium that uses flash memory, is extremely durable and fits   
   in your pocket. Also known as travel drive, thumb drive, jump drive, and universal 
   serial bus (USB) drive.

folder   part of the file system directory hierarchy used to hold other folders (subfolders   
   and/or files).

Folder Options 
dialog box

font    a particular design or typeface of characters used for displayed and printed text.   
   The two main types of typefaces are Serif and Sans Serif.

font box   an option located on the formatting toolbar that shows the existing font with a   
   down arrow beside it that gives additional options available to the user.

font colour an option available from the formatting toolbar that shows the current colour of   
   text and a down arrow which will show additional available options. 
   Click your choice of colour to change font colour.

font size  the size of the font that is displayed on a computer screen or printed as hard   
   copy. The font size is represented as points (the higher the point size, the 
   larger the font).

font size box a text box showing the current font size. You have the option to type in a different 
   font size here or use the spin box arrows (up or down) beside the text box to   
   choose the size of font you want.

font style  the appearance of the font. Font styles for text can include one or more font style   
   attributes such as bold, italic, and others.

footer   the predefined area at the bottom of each page that can contain information   
   which appears at the foot (bottom) of the printed page. 

formatting toolbar contains icons (buttons) for most formatting tasks performed. Can occupy an   
   entire row or share a row with the standard toolbar. 

forward button navigation button used to go forward to previously viewed links if back button has 
   been used.

free software software available at no cost to the consumer.

this dialog box allows various options to be performed on folders and files within 
folders and is activated by choosing My Computer and then clicking Folder 
options from the Tools menu. 
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FTP   a protocol (set of rules) used to transfer files electronically from a source to a   
   destination. FTP sites are still in existence and are useful for larger files. 
   See file transfer protocol.

grammar check a tool provided in word processing software which can be set to automatically   
   check for grammatical errors within the text of a document.

graph   an image created from a set of numbers to show a trend or relationship between   
   two variables such as a line graph. Some graphs may be referred to as charts,   
   such as a bar chart or pie chart.

graphical image a picture or image in electronic form such as photographs, scanned images,   
   pictures and graphs (charts).

graphical user 
interface (GUI)

hand with a 
pointing upward 
index finger  

hard copy  data or information retrieved from a computer and printed on paper. 

hard disk   (usually the c: drive but it may be another letter). See hard drive.

hard drive  (usually the c: drive but it may be another letter). See hard disk.

hardware  any of the physical components of a computer that can be touched or handled. 

header  the predefined area at the top of each page that can contain information which   
   appears at the head (top) of the printed page. 

help menu   located on the menu bar of application programs; designed to locate various help 
   options to assist users. You can also get help by clicking the ? icon in most 
   programs.

help options  a feature of an application software usually accessed from the Help menu that   
   gives descriptions and examples of how to use the software. 

Helpful Hints used in modules to assist users with additional information that may be of    
   assistance to them.

history icon   an icon (button) on the toolbar in the browser that looks like a green arrow    
   around a small clock; used to activate History options. 

(file transfer 
protocol)

an OS provides the graphical user interface (GUI) so that you can interact with   
the computer. Most current operating systems use the point and click format   
known as the GUI. GUI operating systems use rectangular boxes called windows 
to display information on the monitor. See GUI.

indicator that the onscreen pointer is hovering over a hot spot (link) that will take 
the user to another destination.
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history list contains a list of previously visited websites that the browser program   
   automatically tracks when you surf the web.

home button an icon (button) used in a web browser to return to your home page.

home key  moves you to the beginning of the document when pressed on the keyboard.

home page   a specified website address (URL) that the user can change. The default is  
   usually the home page of your browser company. The home page is sometimes 
   used as a starting point to other web pages, known as a portal.

horizontal scroll 
bar

hotmail  common email service used on the Internet. You can go to www.hotmail.com 
   and create an email account for free. Once you have this account, it can be 
   used from any computer where you have access to the Internet.

hotspot  an icon, part of a graphic or text within a web page that allows a jump from that 
   web page to another linked web page or website. A hand with a pointing finger  
   appears when the mouse pointer is over a hot link. Clicking the mouse button 
   results in a jump to the linked web page.

HTML 
(Hypertext
Markup
Language)

http    the protocol (set of rules) used by the Internet for transferring web pages over 
   the Internet.

hyperlink  also called a link, hypertext link and others which will lead (jump) to another 
   location on the page, or another location on a different web page or website 
   when clicked with the mouse.

HyperText 
Markup
Language
(HTML)

Increase Indent 
button

allows horizontal navigation on a screen/document or a web page via scroll box 
or arrows that can be moved left and right to display hidden text.

the programming language used to format web pages. See 
hypertext markup language.

the programming language used to format web pages. See HTML.
icon a small representative image such as a picture or symbol used to 
represent some object or function. Clicking on the icon may result in an 
application being opened or another action being carried out, depending on the 
icon.

an icon (button) located on the formatting toolbar that will indent selected text, 
paragraphs etc. See decrease indent.
indent to move text in from the margin.
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indent  to move text in from the margin.

information  data that has been processed and has meaning to the user.

input device hardware devices used to enter data into a computer such as a keyboard,    
   mouse, and many others.

inputting the process of entering data or information into a computer system.

Insert key   toggle key used to change modes in windows (overtype or edit).

interactive games communication service available online that allow users the opportunity to play   
   and communicate with other people all over the world.

interface a boundary across which two systems communicate. 

Internet  world wide network of computers reaching millions of users, allowing global   
   communication and information sharing on thousands of interconnected 
   networks. Includes the hardware, the computers, and the connections 
   between them. The most commonly used parts of the Internet are the 
   World Wide Web (WWW) and email.

Internet Explorer web browser software.

Internet options 
dialog box

Internet Service 
Provider (ISP) 

Intranet  any network which provides similar services within an organization to those   
   provided by the Internet outside it but is not necessarily connected to the 
   Internet.

ISP 
(Internet Service 
Provider)

jump drive  a portable storage medium that uses flash memory, is extremely durable and fits   
   in your pocket. Also known as flash drive, travel drive, thumb drive, and universal 
   serial bus (USB) drive.

contains various tabs relating to options available within the web browser such 
as general, security, privacy and others. You can change settings to suit your 
needs as required.

a company that provides its subscribers with access to the Internet by supplying 
a link between the subscriber’s computer and the Internet. Without an ISP, the 
user cannot connect to the Internet. See ISP.

a company that provides its subscribers with access to the Internet by supplying 
a link between the subscriber’s computer and the Internet. 
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keyboard  the keyboard is still considered the primary input device and the QWERTY   
   keyboard (based on the original typewriter) is still the style most people are 
   familiar with. 

keyboard
combinations

landscape   one of two orientations used to describe how material (text and/or images) is   
   printed on a page or appears on screen. The default, or normal orientation, 
   is portrait. Landscape orientation has a longer edge across the top.

laser printers a hardware output device that uses a drum, dry ink (toner), and a laser to    
   produce hard copies.

LCD (liquid 
crystal display)

left mouse button the button located on a mouse at the top left that can be pressed (clicked) to   
   select items.

link   also called a hyperlink or a hypertext link; will lead (jump) to another location on   
   the page, or another location on a different web page or website when clicked   
   with the mouse.

liquid crystal 
display (LCD)

local disk   the disk or hard drive in the system being used by a user. Also known as the C:   
   drive or hard disk.

log in   the process of signing on as a user to a computer system. Logging in may    
   involve entering a user identification code (User ID) and/or a Personal 
   Identification Number (PIN) and/or a password.

mailbox  the directory or folder location where incoming email messages are stored by an   
   Internet Service Provider (ISP).

main unit/system 
unit

margin  white space at the edge of a document.

the use of more than one key on the keyboard at a time to accomplish 
commands.

display screens also called flat panel monitors that are much thinner and lighter 
than CRT monitors. Notebook computers use liquid crystal display screens. See 
liquid crystal display.

display screens also called flat panel monitors that are much thinner and lighter 
than CRT monitors. Notebook computers use liquid crystal display screens. See 
LCD.

can also be referred to as the console, box, or tower. This houses essential 
components.
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maximize  to increase the size of a window to fill the computer screen, usually by clicking on  
   the middle of three icons (buttons) located at the top right hand corner of a 
   computer program or document.

media   a material on which data can be stored such as a hard disk, floppy disk, CD,   
   DVD, or tape drive.

media drives a location on which data can be stored such as a hard disk, floppy disk, CD,   
   DVD, or tape drive.

medium  singular of media. See: media.

memory slots located on the motherboard and are used to hold random access memory (RAM) 
   chips.

menu   a list of options available to perform functions or commands. Menus can contain   
   submenus and are usually found on the menu bar across the top of a window for 
   each specific application. Menus can be ‘pop up’ or ‘pull down.’ 

metacrawlers used to send information requests to several search engines at once. These are   
   best used to find obscure items or for detailed searches. 

metasearch
engines

Microsoft Access database software that is used to organize, manage, and store data. 

Microsoft Excel spreadsheet software used to perform calculations and other mathematical tasks.

Microsoft
PowerPoint

Microsoft Word word processing software.

Microsoft Works 
Database

Microsoft Works 
Spreadsheet

Microsoft Works 
Word Processor

used to send information requests to several search engines at once. These are 
best used to find obscure items or for detailed searches. 

presentation software. 

database software used to organize, manage, and store data. 

spreadsheet software used to perform calculations and other mathematical tasks. 

word processing software.
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minimize  used to reduce a window to an icon on the task bar (a way of closing the window   
   onscreen without closing the application). The minimize icon (button) is the 
   left-most of the three located at the top right-hand corner of a computer screen. 

monitor  is an output device that allows a user to see a visual soft copy. It is an essential   
   component of the computer system. 

motherboard is also called the system board or main board. All components connect to the   
   main circuit board. 

mouse  small hand held point and click device used to select onscreen information or   
   locations.

mouse pointer the arrow, I-beam, or other symbol that shows the location or position of the   
   mouse on the screen. 

multiple search 
criteria

my computer a program window that is used to access files and folders on the computer. See   
   Windows Explorer.

my documents  the default location specified for saving files. 

navigate  to move from one location to another using links. To find the way through a   
   website using menus and links. 

Netscape
Navigator

network  a group of computers and associated devices connected by communications   
   facilities (both hardware and software) to share information and peripheral 
   devices, such as printers, and modems and other hardware and software.

new folder   a folder not in existence previously. A new folder is created and named to house   
   other folders and files in the file system.

non-impact
printers

used to narrow down the volume of matches using a number of criteria.

a browsing software used to read hypertext markup language.

hardware devices used to produce hard copy that do not have any physical 
devices touch the page during printing. Two types of non-impact printers are 
inkjet and laser.
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Notepad a text editor application program with very basic word processing capabilities.

notification area  an area located on the far-right side of the taskbar. Notifications appear there   
   regarding background processes, such as network connections, 
   antivirus checking, the system clock, and many more. Some only appear    
   temporarily, while others remain in permanent view.

numbering button an icon (button) located on the formatting toolbar to create a numbered list. 
   Numbered lists are usually used when the order of the list is of importance.

OK button an icon (button) used to complete a command and close a dialog box. 

online banking is available from most banking institutions so that you can complete transactions   
   over the web. 

online shopping is available all over the world due to the capabilities of the Internet. You can go to 
   various websites for stores online and then search for items and make 
   purchases over the web.

open button  an icon (button) located on the standard toolbar used to locate an existing file.   
   You can also open a file by choosing the open command from the File menu.

OpenOffice  a free and completely functional office suite software package offered by    
   OpenOffice.

operating system 
(OS)

organize
bookmarks

organize favorites 
dialog box 

orientation  used to describe how material (text and/or images) is printed on a page or    
   appears on a screen when used with computers. See landscape and/or portrait.

OS
(operating
system)

system software that controls the way a computer functions. This software is 
necessary so that the hardware can communicate with the application software. 
The operating system is the heart of the computer and all computers need one in 
order to work. See OS. 

a function used in Internet Explorer to organize bookmarks into a logical order.

a dialog box used by the Organize Favorites function that is used in Internet 
Explorer to organize favourites into a logical order.

system software that controls the way a computer functions. This software is   
necessary so that the hardware can communicate with the application software. 
The operating system is the heart of the computer and all computers need one in 
order to work. See operating system. 



Employment Track Express

198                                Glossary

output production, productivity, amount produced. 

output devices devices that produce output such as soft copies (monitor) and hard copies 
   (printer).

outside border 
button

overtype mode an editing mode in word processing applications that replaces existing text with 
   new text as you type. See edit mode.

package  a group of programs that are bundled together.

page setup  deals with how your finished document will look on the page when printed.  
   Includes layout for printing options such as margins, headers and footers,   
   landscape or portrait and others.

page up and 
page down keys

Paint   software application program that is capable of creating and editing drawings 
   and can display and edit scanned items. 

paragraph  in word processing, this is a section of text ending in a carriage return (pressing 
   the Enter key inserts a carriage return). 

paste   the act of moving text or graphics from the clipboard into a new location. Paste 
   completes the cut or copy command procedure.

peripheral
devices

personal
identification 
number (PIN)

pixels   millions of dots (picture elements) on a monitor’s display are known as pixels. 
   A point of light measured in dots per square inch on a screen. Pixel density 
   determines a monitor’s resolution.

is located on formatting toolbar (if using Word) to create a border around 
existing text, paragraphs, lists, pages and others.

located on your keyboard and allows you to move a full page in either 
direction of a document.

a secret number used like a password known only to the user, to gain access to 
private information such as a bank account.

hardware devices that are connected to the computer but not inside the main 
unit/system unit.
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point and click 
device

portrait  one of two orientations used to describe how material (text and/or images) is 
   printed on a page or appears on a screen. Portrait orientation of images have 
   the shorter edge across the top; with printed matter, the lines of text are parallel 
   to the shorter side of the page.

ports and 
insertion slots

power supply hardware housed inside the main unit/system unit that supplies power and runs 
   a fan to help keep the inside of the main unit cool. This unit actually converts 
   and reduces electricity to a voltage your computer can handle.

presentation
software

print    a command that tells a computer system to produce a paper copy (hard copy) of 
   a document or graphical image.

print button   located on the standard toolbar; a quick way to print an entire document. 

print preview word processors and other applications come with an option to observe how a 
   document will look when printed called Print Preview.

print screen 
(Prt Scr) key

printers  hardware used to produce a hard copy of your information and are therefore 
   output devices. The two categories are impact and non-impact printers.

privacy   a tab located on the Internet Options dialog box in the web browser. 

properties
dialog box

protocol   set of rules. The same protocol has to be used by both communicating computer 
   systems in order for them to be able to talk to one another.

query   in a database, a formalized search for information meeting specific criteria.

a hardware device that controls a cursor to point to and click or drag onscreen 
objects to select and act on them, such as a mouse, a touch pad or roller ball.

located on the outside of the main unit/system unit; utilized to attach or insert 
other hardware or peripheral devices to your computer. Computer manufacturers 
have made it significantly easier for users to know where to connect which 
device by the use of colour coding or specific instructions on the main unit. 

an application used to create graphic presentations known as slideshows that 
can be presented to large audiences.

a key located on the keyboard that will, when pressed, take a snapshot of what 
is onscreen and place it on the clipboard in (RAM) for retrieval. 

a dialog box that contains various tabs and information relating 
to a specific file, folder, drive, or object.
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quick launch 
toolbar

RAM
(random access 
memory)

random access 
memory (RAM)

read-only
attribute

read-only
memory
(ROM)

recycle bin  a temporary storage area for deleted files. You can permanently delete or recover  
   items from here.

redo button   used to reverse previously used Undo actions as required.

removable
storage media

rename  to change or alter a name.

rename command used to change an existing name of a file or folder to a new name.
   resizing a window is accomplished by clicking when you are directly over your   
   choice of sizing pointer and then dragging outward or inward to resize the 
   window. The act of changing the dimensions of a window.

right-click  pressing the right mouse button is called a right-click action and will activate a   
   context-sensitive menu related to what you have selected (highlighted). 

right-pointing
arrows

ROM
(read only 
memory)

stored on chips on the motherboard. This is temporary/volatile memory, meaning 
it is not permanent, and the information on the screen will disappear when the 
system is shut down. See random access memory.

on the desktop window, it is located to the right of the Start button and 
may display commonly used program icons.

stored on chips on the motherboard. This is temporary/volatile memory, meaning 
it is not permanent, and the information on the screen will disappear when the 
system is shut down. See RAM.

this chip holds essential programmed instructions, which are initiated when 
you turn your computer on (cold boot). Its final job is to load the OS (operating 
system (OS), which is the heart of the computer. This is non-volatile memory 
because it retains its contents even when the computer is off. See ROM.

storage media such as CD’s, DVD’s, USB drives and others that are not fixed 
and are detachable from the system.

indicate submenu items when you have activated a menu.

this chip holds essential programmed instructions, which are initiated when you 
turn your computer on (cold boot). Its final job is to load the OS (operating system 
(OS), which is the heart of the computer. This is non-volatile memory because it 
retains its contents even when the computer is off. See read-only memory.

an attribute put on a file and/or folder so that the file cannot be modified.
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routine
maintenance

row   See column.

ruler   measurement scale which will present a ruler on screen. Measurement scale can 
   be changed from inches to other measurement choices.

Sans Serif one of the two main types of fonts available. These fonts have no extensions on   
   characters and are great for headings and titles. See Serif.

save   to store a file on a permanent storage device such as a disk or drive etc.

save as  to save a file to disk at a different location and/or with a different filename. This   
   can also be used to a save a file for the first time when it is being named.

scanner  an input hardware device used to convert hard copy into digital files on your   
   computer.

scheduled tasks a system tool that will run scheduled tasks automatically. This gives you the   
   opportunity to run tasks at convenient times and dates for you.

screen resolution the number of pixels that can be displayed on a screen expressed as (number of   
   horizontal pixels) X (number of vertical pixels). 

screentip  a small box that is activated by hovering over a screen item or object. It basically   
   gives you the name of the object and in many cases indicates what it is used for. 

scroll arrows used in the scroll bars to slowly move up and down or left to right to show    
   additional hidden text or objects.

scroll bars  See vertical scroll bar and/or horizontal scroll bar.

scroll box   the box located in the vertical and horizontal scroll bars that can be dragged with   
   the mouse pointer to scroll through a document onscreen. The size of the 
   scroll box indicates the relative size of the document and an indication of your 
   location in the document.

scroll wheel a feature available on some mice where rolling the wheel enables a user to   
   quickly move a page up or down on the screen.

search  a feature that allows the user to find matches within data in a document or on the  
   web, based on a given criteria. Criteria can be simple or complex, and single or   
   multiple, involving one or more logical expressions.

scheduled cleanup of your system by eliminating unnecessary items to free up 
disk space. This can include user created files and folders, old programs that are 
no longer in use, temporary Internet files, and many other items.
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search engine on the Internet, a tool used to find web pages containing information on specified  
   topics.

security   safety measure, protection, or precaution.

security center a system tool that allows you to view your current security status and access 
   important settings to protect your personal computer.

select (highlight) to highlight or choose. This is done by moving the mouse pointer to the   
   beginning of the text desired, then clicking and slowly dragging across the name 
   and releasing the mouse button when finished.

select and 
do method

Serif    one of the two main types of fonts available. These fonts have extensions on the 
   end of characters and are easy to read. See Sans Serif.

settings  persistent settings that configure a system to suit the user(s) such as date and  
   time on the system clock, words added to spell check dictionary and many 
   others.

shift key  key on the keyboard usually used in combination with other key(s) to perform a 
   task or command. Also used for changing to uppercase.
shortcut menu a list of context-sensitive commands that appear when you right-click a screen 
   element or object.

show hidden files 
and folders 

show/hide
(show all) button

shutdown  the process of closing down a computer during which program settings and files  
   are saved.

Simple Mail 
Transfer Protocol 
(SMTP)

sizing handles

sizing pointers double-ended pointing arrows for resizing. 

a technique, process, or routine, to remember that in order to make changes to 
anything, you first have to select anything you wish to make changes to.

an option available under the Hidden files and folders heading that will allow you 
to see previously hidden files and folders.

an icon (button) on the standard toolbar used to show all formatting marks 
including characters for paragraphs, tabs, spacebars, and Enter.

a set of rules to ship email messages from one address to another. See SMTP. 

small square black boxes around a selected object. These will be white circles 
when they are around the outer edge of a placeholder.
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SMTP 
(Simple Mail 
Transfer Protocol)

soft copy  data or information displayed on a monitor.

software programs that run on a computer system. There are two major types of software;   
   system and application.

sort   a feature that allows the user to arrange data items in a pre-determined order   
   such as alphabetical or numerical in ascending or descending order.

spell checker a software tool used to query unfamiliar spellings and detect repeated words,   
   giving the user the opportunity to correct or delete them. Words are 
   compared to a dictionary.

spelling and 
grammar
checker

spin box  a small box with upward and downward point arrows beside it. You can click the   
   arrows to quickly move through the values or you can type a value directly into 
   the box.

spreadsheet an electronic worksheet consisting of columns, rows, and cells, that uses    
   formulas for calculations. 

spreadsheet
software

standard buttons 
toolbar

standard toolbar located just below the menu bar and contains icons (buttons) for common    
   commands used in the program.

start menu button is located in the lower left-hand corner of your desktop and will activate the start   
   menu, giving you choices to other menu items, shortcuts and previously 
   used documents as well. 

status bar  the horizontal bar at the bottom of the window providing information about what   
   you are viewing in the main window.

a set of rules to ship email messages from one address to another. See Simple 
Mail Transfer Protocol.

when this feature is turned on, your words are compared to a Word dictionary and 
your phrases and punctuation to a Grammar Rules list.

applications used to perform calculations and other mathematical tasks. Helps 
the user to manage, analyze and present numerical and string (text) information. 
Graphs and charts are often used to represent numerical data for demonstration 
purposes.

a toolbar the shows the most commonly used command icons (buttons) in my 
computer.
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store   to retain for future use.

style   in text formatting, examples are bold, italic and underlined. In paragraph    
   formatting, applying styles to paragraphs gives consistency of layout throughout   
   a document such as line spacing, alignment and others.

submenu  a second level menu activated by selecting from a menu of commands.

suite   a collection of software bundled together that was developed by the same    
   manufacturer to be sold at a lower cost than buying the software individually.

system
information

system restore a system tool that restores system to chosen restore point. This allows you the   
   benefit of choosing a restore point, which records the settings for your system at   
   a specific time. If you have installed a program and it has caused problems, 
   you can go back to an earlier restore point when the system was working    
   correctly. 

system settings customized settings for the system.

system software the set of programs that enables the computer hardware and software to work   
   together. It includes the operating system and utility programs.

system tasks an options heading to deal with system tasks found on the left side of the My   
   Computer window. You can choose to view system information, add or remove 
   programs, and change a setting from here.

system tools are helpful system utility programs.

table   a rectangular array of cells. A table is used to display data in rows and columns   
   to make it easier to understand information. Tables may be created using 
   word processing, desktop publishing, spreadsheet, and database applications.

tabs (tabulation) a series of points that are marked across the page providing a method of    
   formatting a document so that the cursor moves to specified distances along the 
   width of the page. A word processing program will automatically set the tabs 
   across the page (the default settings) but the user can reset the tabs to the 
   distances required.

taskbar   the long, horizontal bar found at the bottom of the Windows desktop. It is used to   
   display the start button, the quick launch Toolbar, and names of any open 
   documents.

a system tool that displays current system information.
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templates   various types of pre-set documents available to assist users when creating new   
   documents. Templates provide a potentially finished product containing 
   fictitious information that you will replace with your own. 

text   wording or content.

text box  a rectangular area into which text can be typed.

text editors   application software that are useful for basic typing tasks such as writing a letter,   
   and drafting simple documents. See Notepad and/or WordPad.

text     
wrapping

thumb drive  a portable storage medium that uses flash memory, is extremely durable and fits   
   in your pocket. Also known as jump drive, flash drive, travel drive, and universal 
   serial bus (USB) drive.

title bar   the bar across the top of the open window that contains the icon for the program,   
   the name of the program or file, and the Minimize, Restore Down/Maximize, 
   and Close buttons.

toggle switch any feature that is turned on by clicking once and then turned off by clicking   
   again.

toolbar  an area of the screen, often at the top of a document, row, column, or block of   
   onscreen buttons or icons that, when clicked, activate certain functions 
   (commands) in an application.

tools menu located on the menu bar of application programs and houses available options   
   and tools available in the specific program.

touch screen a visual display unit that combines output on the screen with an input option. The 
   user makes choices by touching icons or graphical buttons on the screen; 
   the act of touching is sensed by special receptors on the screen surface.

travel drive  a portable storage medium that uses flash memory, is extremely durable and fits   
   in your pocket. Also known as jump drive, flash drive, thumb drive, and 
   universal serial bus (USB) drive.

undo   icon (button) located on the Standard toolbar used to undo the last action(s) or   
   command(s).

a feature that allows lines of text to flow round the edge of an image or onto 
another line before ending a paragraph. See word wrap.
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uniform resource 
locator (URL)

URL (uniform 
resource
location)

USB (universal 
serial bus) drive

user identification

utility programs typically small programs that come bundled with the OS as part of the system   
   software that are used to perform rountine maintenance or perform routine tasks.

vertical scroll bar allows vertical navigation on a screen/document or a web page via scroll box or   
   arrows that can be moved up and down to display hidden text.

video
conferencing

view menu located on the menu bar of application programs; houses available options and   
   tools available in the specific program in relation to viewing.

virus protection protecting your system by using anti-virus software to detect and remove    
   computer viruses. 

viruses  programs designed to corrupt data stored on a computer; often transmitted via   
   email attachments.

web address the name that identifies a specific web page address for a site on the web known   
   as a Uniform Resource Locator (URL). See website address.

web browser an application software which allows a person to read hypertext markup    
   language (HTML), and to access, view and interact with web pages. 
   Basically, allows you to view web content. See browser.

web page  document on the WWW that display images, associated links (hyperlinks),   
   frames, graphs, and just about any visual, or auditory media available. 

the unique address used to locate a website or web page. See URL.
universal serial bus (USB) drive a portable storage medium that uses flash 
memory, is extremely durable and fits in your pocket. Also known as jump drive, 
flash drive, thumb drive, travel drive, and USB drive.

the unique address used to locate a website or web page. See uniform resource 
locator.

a portable storage medium that uses flash memory, is extremely durable and fits 
in your pocket. Also known as jump drive, flash drive, thumb drive, travel drive, 
and universal serial bus drive.

a name or codename used during a login process to identify the user. The user 
id may then appear on screen as the salutation to the user.(user id)

a communication tool used by computer users around the world to communicate 
via a video capture device in real-time.
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website icons  used to view an actual web page you have viewed on that specific site before in   
   favourites or history in a web browser.

website   a collection or group of related web pages that are linked.

website address  a specific web address for a site on the web known as a Uniform Resource   
   Locator (URL). See web address.

window   a section of a computer screen through which the user views the display for a   
   particular application. Only one window is active at a time enabling the user to 
   interact with it.

Windows 
Explorer

Windows Task 
Manager dialog 
box

wizards   a wizard walks you through a step-by-step procedure to create a specific type of   
   document.

word processing the act of creating, formatting, editing, saving, and printing documents.

word processing 
software

word wrap   a feature included with some word processors to allow typing without pressing   
   enter until you have finished the paragraph. See text wrapping and wrap text.

WordPad a text editor application program with basic word processing and formatting   
   capabilities. This program has additional features that NotePad does not have.

World Wide Web See Internet.

wrap text  a feature that allows lines of text to flow round the edge of an image or onto   
   another line before ending a paragraph. See word wrap and text wrapping.

wrap to window 
option

is accessed by pressing Ctrl+Alt+Delete and can be used to fix a frozen screen 
safely without shutting the computer off. 

applications used to create, format, edit, save, and print documents. Allows the 
user to produce documents including letters, reports, manuals and newsletters.

a program window that is used to access files and folders on the computer. See  
My Computer.

(WWW)

a feature included with word processors to allow typing without pressing enter 
until you have finished the paragraph. See text wrapping and wrap text and word 
wrap.
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Writer   

WWW   See Internet.
(world wide web)

www.yahoo.com the website address (URL) for Yahoo.

yahoo mail  common email service used on the Internet. You can go to www.yahoo.com and   
  create an email account for free. Once you have this account, it can be used 
   from any computer where you have access to the Internet.

yes button   an icon (button) located in a dialog box to confirm a command.
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word processing software offered by OpenOffice.
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